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Introduction
Welcome to the world of MaxMotion™ from Solustan, Inc.
MaxMotion (maximum flexibility for motion control) and MaxMotion
Virtual Controller (Indexer) are very easy to use, general purpose
software engines developed for the PC/Windows computers. Generally
speaking, these software engines offer the following powerful but
unique capabilities:
■ It allows a complete job design capabilities for an engraver. He or
She can set up a job, select fonts including special engraving fonts or
TrueType printing fonts with size and positioning with or without any
variable text and graphics.
■ It accepts graphically designed templates as input to control the
motion of a device. It means the user does not need any specialized
skills for software programming to control the motion properly.
■ It can be easily customized to drive many different machines with
controllers that accept HPGL commands, M&G codes, and those
machines that are simply designed to accept lower level commands like
steps and directions for motors with no controllers.
■ The Virtual Controller can be customized to drive many different
step motor based machines (output devices) with no controllers.
MaxMotion can be defined as Software controller or a Virtual Controller. The software technology allows a PC/Windows computer to be the
controller and negate the need for a proprietary hardware controller.
The MaxMotion software creates its own design as well as accepts
output files from many of the popular application software packages
such as Corel Draw, Adobe Illustrator and Streamline, Canvas from
Deneba Systems, Arts & Letters from Computer Support Corporation,
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MicroGrafx Designer, Aldus Freehand and other graphic programs that
can generate PostScript files. MaxMotion also accepts DXF files from
popular CAD programs like AutoCAD, AutoCAD LT, DesignCAD,
Generic CAD and others.

MaxMotion supports the following Engraving machines:
Dahlgren Control Systems
System I and System II
System 100 - 500 SCU controllers
System 100 - 500Z SCU controllers
Wizzard XL series
Wizzard III series
Machine Automation’s
Multi-CAMM 22, 44, 48, 610, etc.
The new Multi-CAMM Plus series
Newing Hall Models
All Models with TLC controllers
All Models with Apex controllers
New Hermes
Model 810
Model 1219, 2000
Model 3000, 3000LT, 3400
Model 4000, 5000, 6000, Orbitor
Model 7000, 8000, 9000
Unica
Roland Digital’s
CAMM 2 PNC-2100, 2200, 2300, 2700, etc.

MaxMotion supports the following Routing Machines:
Computerized Cutters, Inc.
AccuCut 5050
AccuCut 50100
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Digital Tool, Inc.
DR902-S1, S2, L1, L2
DR903-S1, S2, L1, L2
DR-902-SAW
DR-903-SAW
META-STEP 1500-1, 1500-2
META-STEP 2000-1, 2000-2
META-STEP 3000-1, 3000-2
META-SERVO 6500-1, 6500-2
META-SERVO 7500-1, 7500-2
META-SERVO 8500-1, 8500-2
ESAB Machines
Gerber Dimension series routers
Machine Automation Technology
Multi-CAMM 22, 44, 48, 610, etc.
The new Multi-CAMM Plus series
Roland Digital Group
CAMM 2 PNC-2100, 2200, 2700
Techno DSG
Series II
Series III 3-axis tables
And many more devices that can accept commands in one of the
generally accepted formats like M&G Code, HPGL, DMPL, steps &
Directions, etc.

MaxMotion Virtual Controller (Indexer)
communicates successfully with many off-the-shelf drivers/amplifiers than can accept either steps & directions as the inputs or those
that can accept direct driving of step motor windings.
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A partial list of the companies that make such amplifiers is given
below:
Intelligent Motion Systems, Inc.
API, Inc.
Superior Electric
Semix, Inc.
General Controls, Inc.
Anaheim Automation
Compumotor and Digiplan
Pacific Scientific
PIC Design
Before you begin using MaxMotion, please take a moment to fill out
and send in your registration card. The registration card is prepared
such that the user needs to fill out minimum information. A toll-free
800 number for FAX is printed on the registration card. It will cost the
user nothing to send in the registration. This will allow us to keep you
informed about updates to MaxMotion as well as future releases of new
products from Solustan, Inc.
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Chapter 1:

Installing MaxMotion
Virtual Controller
It is really simple to install the MaxMotion software. This procedure
assumes that the user is familiar with the working ways of Windows
3.X, 95, and 98 to move around within Program Groups, to use a
mouse, and so on. If the user is not familiar with the operations of
Microsoft Windows or terminology, the user is strongly advised to refer
to the Windows User's Guide and other documentation Microsoft
provides with the purchase of the Windows operating system.
The installation procedures are slightly different for MaxMotion Virtual
Controller and MaxMotion HPGL software. Although, either of the
applications are very simple to install. The installation conforms to
generally acceptable ways of setting up applications in PC/Windows
3.X, 95, or 98. Even if you have never installed any Windows application, you will need only a few minutes to accomplish the task.
MaxMotion can create jobs from scratch, it can import previously
designed jobs from virtually any Microsoft Windows 3.X (or higher)
drawing software application programs, or it can import previously
designed jobs in a CAD programs like AutoCAD. If your application
program allows outlining or converting to either Bezier curves or
preparing DXF files, it will be more than likely to be compatible with
MaxMotion. Before engraving/routing, you must set up MaxMotion for
proper machine that you intend to use. This is accomplished the first
time you use the MaxMotion application by selecting proper engraving/
routing device and its settings. After the MaxMotion software application and the driver are installed, put the diskettes away in a safe place
for possible future use.
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Installing the MaxMotion VC (Virtual Controller)
application (PART NUMBER EW-401)
Use the following procedure to install under Windows 3.X
(a) Type or Enter WIN at the DOS prompt to load Windows 3.X, if it is
not loaded already.
(b) Insert the MaxMotion floppy disk into drive a: or b:
(c) From Program Manager, choose Run from the file menu.
Important: If you are using a desktop manager other than Program
Manager, you must run the Program Manager application
PROGRAM.EXE, before executing step c. Running the installer from a
desktop manager other than the Program Manager may produce
unexpected results.
(d) Type a:\setup or b:\setup (depending upon whether the
MaxMotion floppy is inserted in floppy drive A or B) and click OK.
The MaxMotion Installer dialog box appears.
(e) Accept the default target drive and directory displayed in the dialog
box, or select and type a new drive and directory.
(f) Follow the procedures and prompts on the screen and click OK as
prompted.
If MaxMotion was installed previously on the computer, it is possible
that a message might appear for a file named bwcc.dll for it being in
use. Simply, select the option of 'do not install' only for that file. When
installation is completed, a message appears indicating that the installation was successful.

Use the following procedure to install under Windows 95 and 98
(a) Type or Enter WIN at the DOS prompt to load Windows 95, if it is
not loaded already.
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(b) Insert the MaxMotion floppy disk into drive a: or b:
(c) Click the Start button and choose Run.

(d) Type a:\setup or b:\setup (depending upon whether the MaxMotion
floppy is inserted in floppy drive A or B) and click OK. The
MaxMotion Installer dialog box appears.
(e) Accept the default target drive and directory displayed in the dialog
box, or select and type a new drive and directory.
(f) Follow the procedures and prompts on the screen and click OK as
prompted.
If MaxMotion was installed previously on the computer, it is possible
that a message might appear for a file named bwcc.dll for it being in
use. Simply, select the option of 'do not install' for that file. When
installation is completed, a message appears indicating that the installation was successful.

Customize MaxMotion Virtual Controller for your machine
It is important to remember that if and when a change is made in
the configuration of MaxMotion, it is recommended that you
should quit the MaxMotion application and relaunch it for the
changes to become effective.
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Here is where you customize MaxMotion Virtual Controller to work
with your machine, step motors, and amplifiers. MaxMotion Virtual
Controller plays the role of job design and preparation program as well
as the role of a controller. Configure the software properly and you will
get excellent performance. Make sure you have the Windows 3.X, 95 or
98 program Manager displayed on your computer monitor. The
automatic installation procedure of MaxMotion will create a
MaxMotion folder in the Windows Program Manager.
Double click on the MaxMotion icon to launch the application.
Move the mouse pointer over the File menu. A single click will pull
down the File menu.

MACHINE SETUP
Select Machine setup in the File menu and single click of a mouse will
bring up Machine Setup dialog box.

In the Machine Setup Dialog Box, note the check mark at the top left
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for enabling the Pause/Resume/Kill capability during output. When the
Virtual Controller concept was conceived back in 1995, the fastest
computers had Intel 486 chips. Some of the slower chips could not
manage Pause/Resume/Kill capability while sending out timely output
for smooth motor operation. Disabling the capability made the machine
run smooth. No need to worry about disabling it with today's fast
Pentium chip based computers.
Port Selection
The MaxMotion ID key will be connected to the parallel port that came
with your PC computer. While the machine will be connected to the
second parallel port . The address of the board where the machine is
connected to the PC should be selected in the Port Selection.
If the machine is to be connected to a parallel port, it is required that
the computer be configured with two parallel port. Attach the ID key to
one parallel port while connecting the machine to the second parallel
port.
Click on the Port selection box to see all the possible choices.
MaxMotion Virtual Controller takes advantage of the parallel port
technology on the PC to drive the drivers/amplifiers and your machine.
As a rule, MaxMotion Virtual Controller does not require any special
hardware. In case of certain drivers/amplifier designs, you may need
special low cost boards that provide additional flexibility not available
from standard parallel port. Contact Solustan for more information.
Select the LPT (Parallel port) number to which you have connected
your machine. If you do not know the LPT number, check your
documentation for the PC computer that you own. If you decide to
purchase a parallel port board from Solustan, it will be an ISA bus
based card, it will always have the address of 278 and will as a result,
carry the lowest LPT address number.

Machine Name Selection
Machine name should be showing "My Machine". Click on the arrow
to the right of the machine name. Notice that there is a long list of
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machines supported by MaxMotion. Generally, these machines can be
categorized into two broad categories:
(1) Machines that can be upgraded to take advantage of the latest
features of MaxMotion and Windows environment. These are older
Dahlgren, Meistergram, Newing Hall, New Hermes, and other engraving machines. Detailed machine setup is already done for you ahead of
time. All you need to do is to make proper selection of the engraving
machine from the list. Although, it would still be a good idea to go
through the setup to become familiar with options available to you.
(2) You have developed your own machine and you are taking advantage of MaxMotion as the controller. You do not need to develop a
hardware controller. However, you do need to spend time fine tuning
MaxMotion to get the best performance possible. Select My Machine
for Setup and go through Machine Setup options.
General Setup
General setup is divided into various sections. Select one at a time and
change the default numbers to proper numbers appropriate for your
system. The standard configuration of the parallel port for MaxMotion
Virtual Controller is defined in Appendix C. If any of the values are
changed in these SECTIONS, the values shall be SAVED. It is advisable to quit the MaxMotion application and launch again to be
absolutely sure that the new values have become effective.
Item 'ShowMachineSetup' is added in 'Global Values' section of .INI
file. If ShowMachineSetup=1 then machine setup shows all the
sections as usual, but if ShowMachineSetup=0, then all the sections
except Section III are made invisible to prevent a user from fooling
around with machine settings.

Section I
The resolution of each of the axis is defined in this section. The
resolutions are defined as either steps per inch or steps per millimeters.
The pin numbers for the axis corresponds to the pin numbers on the
parallel port. Even if you need to swap pins numbers to match your
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physical connections for the axis, always keep the sets together. The
sets are pins (2,3), (4,5), and (6,7). Also make sure that any one set is
used only once in the configuration.

The above picture shows pins of axis per standard setup. Generally, it is
not required to change Z axis. However, a user may want to swap X
and Y axis for his convenience. Swap pins 2 and 3 for pins 4 and 5. The
values for the resolution is predefined for the upgrades of many
engraving machines. The manufacturer of machines who plans to use
MaxMotion as their virtual controller should set up its own values that
is appropriate.
The driver/amplifier module takes a step on either rising or falling edge
of the signal. We preset these values for the upgrade products. If you
are building your own machines and plan to use drivers/amplifiers of
your own choice and if you do not know the trigger point, consult your
driver/amplifier manufacturer. Save the configuration after you make
necessary changes.
The last part of the Section I is very useful. Once a machine is set up, a
user can get to the Control Pad and use the directional keys to move the
machine. If you find that the directional keys move the tool in the
machine in the wrong direction, the direction can be corrected easily by
changing the value from High to Low or Low to High for the axis that
is improper.

16

MaxMotion for Machines

Section II
General setup section II will allow you to setup limit switches and the
distance you desire from the limit switches, once you reach home.

If you have a machine (e.g. Newing Hall engraving machine with TLC
controller) with no limit switches, the Section II will be set up with
Limit Switches "Not Present" in all three axis. The limit switch part of
the logic will not be activated in the application.
However, if you do have a machine with limit switches (e.g. New
Hermes 3000), notice the setup of the limit switches by simply selecting the machine name to be New Hermes 3000. For a new machine, set
up
Pin 12 for the X axis
Pin 13 for the Y axis
Pin 10 for the Z axis
It is important to find out whether the limit switch position will provide
a logic 1 or a logic 0 when the limit switch is not tripped. The axis shall
be set to that high or low value in section II. It is important to note that
it is not a good idea to position the starting position right at the limit
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switch. Once the machine reaches the limit switch, it should back off
by the value selected in the Offset Home value in the section II. It is
preferred that the minimum value is 0.05 inches. The starting position
can be changed to any other position on the table other than the upper
left corner by taking one of the three following steps:
1. Change the values of X and Y offsets for the Home in the Section II.
2. Select one of the other starting positions in the section III.
3. Change the starting offsets for the X and Y axis in the Section III.
In fact, with proper offsets, one can set up the center of the table or
either center or upper left of a temporary jig can be set up as a starting
position.
X-axis limit switch and the Y-axis limit switch are either present or not
present together. The Z-axis limit switch can be present alone. There
are three possible choices:
X and Y axis limit switches
Z axis limit switch
X, Y, and Z axis limit switches
When any of the combinations are present, there will be one more
choice available:
Normally, at the end of any job, the tool will travel back to the starting
position from where the job started. If the last box is checked, the tool
will seek the Home position at the end of the job instead of going back
to the starting position.
Always remember to save the changes, quit the application, and
relaunch the MaxMotion for the changes to be effective.

Section III
This general set up menu is expanded quite a bit. You can select
between X or Y axis and the cylindrical axis. Notice the selection of
cylindrical axis in place of either X-axis or Y-axis is radio buttons.
When you select one, the other will be deselected automatically. Both
cannot be selected at the same time. If you select cylindrical axis and if
it is a valid selection for the machine selected, a new setup button will
show up next to the cylindrical radio button. Click the setup button to
get at the additional cylindrical set up values. About the only thing a
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user needs to do is to provide the diameter of the object where the
engraving takes place.

Spindle Delay: Spindle delay was always available in MaxMotion
Virtual Controller and it was preset at 1 second in the Initialization file
(MaxMotion.INI). This control of the delay is now brought to the
application interface in order to make it easy for the user to change or
set the delay for values other than 1 second.
Spindle delay activation takes place as follows:
A job is ready to be sent to the machine for engraving or cutting. As
soon as the user clicks "OK" to send the job, MaxMotion checks to see
if the spindle motor is checked in the Section III of the Machine Setup.
If it is, a command is sent to turn the spindle motor on. Next, the
MaxMotion checks for the delay time for the spindle motor in the same
section. MaxMotion will simply wait for the seconds called out in the
delay time before moving the X, Y, and Z axis to proceed to execute the
job. This delay allows the spindle motor to come to the necessary
spindle speed before plunging into the material.
The spindle motor delay time shall be declared in seconds. Please,
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familiarize with the section III of the Machine Setup. You can get to
Machine Setup by pulling down the File menu in MaxMotion.
You can select left switch or right switch or both the switches. Left
and right are selection boxes and either or both can be selected at the
same time. Click on the box to select it and click again on the box to
deselect it. The left and right switches provide logic level change on
pins 1 and 14 of the parallel port when the tool goes to the starting
position of the job. Typical uses of these signals are Z axis down and up
movement for air actuated Z axis in the engraving machines and
turning on and off of the coolant in CNC machinery, etc. Spindle
motor signal controls pin 16 of the parallel port. If pin 16 is connected to the spindle motor actuation, it can turn on and off either at the
time the tool starts from or goes back to the home position or when the
tool goes to the starting position of the job. A value of one second is
declared in the initialization file for the spindle motor to come to
desired speed before penetrating the material. This value can be
changed.
It is real easy to declare your working area of your machine for your
model and it will remember the value. The declaration is simply in
inches or millimeters. You can declare different sizes for the different
machines you might have in your facility and MaxMotion will remember all the sizes. Select any other machine in the machine selection area
and you will notice that the table area will change, if indeed it is
different. The table set up does not require periodic changing. However,
if you are using a different plate size, you can easily change the plate
size without changing the table size.
Users like flexibility in selecting a starting point for the job. Now, you
can start the job from any of the six positions:
Upper left
Lower left
Upper right
Lower right
Center
Top center
Click on the down arrow next to Start from box and select your
required position.
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Start offset values can be set up for all three axis. This is different from
the offset values in limit switch set up. Here is an example of the use of
the start offset:
Dahlgren System 1 table and some of the Scripta tables have bottom
loading chucks for the tools. The tables require upper left as the starting
position. However, the Z axis need to travel away on Y axis to get away
from the table surface in order to load and unload the tools. The tool
will go home (upper left) at the end of a job and then move away from
the table with the prescribed offset value in the Y axis. However, it will
automatically move back to the starting position and then execute the
next job. This allows the user to position the material flush to the upper
left and execute the job without making any adjustments. The whole
process speeds up significantly. There are other uses of this offset when
the Center or Top Center is selected as the starting point. More on that
later.
The lift values for the Z axis
There are three different possibilities for the lift values for the Z axis.
First, there is no need to set any value for the machines that use air
pressure controlled Z axis. There are two different settings for the Z
axis lift for the machines that have motorized control for the up and
down movement of the axis. The different values depend upon whether
there is a limit switch in the Z axis. Let us understand the two possibilities:
(1) MaxMotion is controlling a machine that has no limit switch in
the Z axis or the limit switch in the Z axis is declared to be Not
Present in the Section II of the Machine setup.
In this case, the user is responsible for setting two different values for
the Z axis tool lift. One is the Start Offset value for the Z axis in the
section III of the Machine Setup. This value shall be less than the total
available stroke of the Z axis. The tool is brought over to the material to
be worked on. The user will move the tool down until it touches the top
surface of the material. When the user clicks the Surface key on the
Control Pad, the Z axis will rise to the value declared in the Start Offset
value in the Z axis of the Section III of the Machine Setup. Next Home
the tool and the machine is ready to engrave.
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Whenever the job starts, the tool will move from the Home position
over to where the material is with the Start Offset value of the Z axis
until it gets to the first shape. At this point, the tool will travel down to
the material and then penetrate to the depth declared in the material
selected in the Materials menu. When it finishes the first shape and is
moving over the to the next shape, the Z axis will move up only by the
Lift value declared in the Materials menu. This lift value is set separately as opposed to the start offset value. Typically, the start offset
value is higher in order to clear all the hurdles such a jigs and vises and
the material holding hardware. Typically, the lift values are lower to
save time in lifting and lowering the Z axis between the shapes of a job.
(2) MaxMotion is controlling a machine that has a limit switch in
the Z axis and the limit switch in the Z axis is declared to be
Present in the Section II of the Machine setup.
In this case, the user is responsible for setting only one value for the Z
axis tool lift. The Start Offset value for the Z axis in the section III of
the Machine Setup is the total available stroke of the Z axis. The tool is
brought over to the material to be worked on. The user will move the
tool down until it touches the top surface of the material. When the user
clicks the Surface key on the Control Pad, the Z axis will rise until it
engages the limit switch. It will then move back down by the offset
home value declared in the Section II for the Z limit switch. This value
will show up in the Start Offset value in the Z axis of the Section III of
the Machine Setup. However, the start offset value for the Z axis box
will be gray and the user will not be allowed to change the value. Next
Home the tool and the machine is ready to engrave.
Whenever the job starts, the tool will move from the Home position
over to where the material is with the Start Offset value of the Z axis
until it gets to the first shape. At this point, the tool will travel down to
the material and then penetrate to the depth declared in the material
selected in the Materials menu. When it finishes the first shape and is
moving over the to the next shape, the Z axis will move up only by the
Lift value declared in the Materials menu. This lift value is set separately as opposed to the start offset value. Typically, the start offset
value is higher in order to clear all the hurdles such a jigs and vises and
the material holding hardware. Typically, the lift values are lower to
save time in lifting and lowering the Z axis between the shapes of a job.
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Backlash
Backlash is a very important feature to take care of the mechanical
inconsistencies in machines. Every mechanical device is slightly
different. Also, its characteristics change as it ages. If there is a mechanical problem which creates backlash and as a result, the machine
does not come back to Home at the end of a job, the mechanical
problem should be fixed. It is possible to compensate the mechanical
backlash with electronic compensation in MaxMotion until the problem
is fixed. Due to the invention of anti-backlash nuts, this is much less of
a problem in today's times.
You can experiment with different numbers and observe the effects as
you repeat the same job. The backlash number will always be a whole
number and always a positive number.
For the users of MaxMotion Virtual Controller, it is easy to select
Control Pad in the File menu. This will bring up a Control Pad on
the screen and will allow control of the machine directly from the
10-key keypad portion on the keyboard.
Alternate set ups are available from the keyboard for the computers that
are not equipped with the 10-key keypads. Typically, these computers
are portable computers.
To understand the operation of the 10 key keypad, refer to the File
Menu section in Chapter 5.
Section IV
Section IV describes the capability that is unparalleled in the engraving
industry and essential for the CNC industry. MaxMotion offers sophisticated and built-in capability of S-curve acceleration and deceleration
for all the step motors. Most simple controllers offer only straight line
acceleration and deceleration. Not only this is hard for the mechanical
components, it is also easy to lose steps if high speeds were desired
from the machine. Controllers do not have enough processing power
and/or memory for intense calculations required for sophisticated
acceleration techniques. Today's inexpensive PC's with immense
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processing power makes it possible.

The first check box will guarantee that the machine will move at a
constant linear velocity along all the paths including straight lines,
angular lines, curves, etc.
It would be a good idea to stop the limit switches without decelerating
unless you plan to move to the home position at a very high speed.
Quite often users experience that it is time consuming when the user
tries to position the machine at a specific point for a starting position.
Either you have to jog the machine slowly or you need to go back and
forth to get to the point of choice. MaxMotion allows users to set a
number of steps that may be taken at a slow speed while jogging. This
will make it lot easier and lot less frustrating to position the tool at a
desired position.
The last three values for the set up in this section deals with the S-curve
acceleration and deceleration. Check with the MaxMotion technical
support group for proper settings for this section.

MaxMotion Identification Adapter
MaxMotion program comes with a special Identification Adapter.
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Before invoking MaxMotion, you must first insert the adapter in the
parallel port on your PC computer. Each Identification Adapter is
unique so your MaxMotion program can only execute with the ID
adapter supplied with it. If you wish to attach a printer or a plotter to
the same parallel port, simply plug the parallel cable into the ID
adapter. Once installed, the ID adapter is totally unobtrusive and will
not hinder any of the capabilities of the computer.
The ID adapter has arrows on the side that is connected to the computer. Along with arrows, it has the word computer between the arrows.
This side has a 25 pin male connector. Make sure that this connector
connects to the parallel (printer) port on the PC computer.
Laptop computers may not have the luxury of having more than one
parallel port. In this case, we are offering an ID key that will attach to
the USB port. Make sure you have a laptop computer that is equipped
with a USB port.
Solustan provides a necessary parallel port or a high current board with
its upgrade package. Typically, user can have more than one parallel
port on a desk top computer. The recommended connections in this
case would be to connect the ID key to the original parallel port while
the machine should be connected to the Solustan supplied port.
Installation of hardware for the upgrade of various machines
More and more machines are being retrofitted with MaxMotion
upgrades. As we learn, we add these machines to the list. Check the
Appendix D of this manual for information and procedures for
hardware upgrades of known machines at the time of this writing.
Please, check with the MaxMotion technical support group if you do
not find the specific machine that you plan to upgrade.
ONCE YOU HAVE EVERYTHING WORKING PROPERLY, IT IS
VERY IMPORTANT FOR YOU TO NOTE DOWN YOUR SELECTED SETTINGS ON THE PAGES 25 THROUGH 28 OF THIS
CHAPTER 1. THESE SETTINGS ARE IN THE MACHINE SETUP,
SECTION I, SECTION II, SECTION III, SECTION IV, AND ALL
MATERIALS MENU. YOU CAN REFER TO THESE SETTINGS IF
YOU EVER HAVE TO REINSTALL THE MAXMOTION.

After filling out proper information, make sure and store
these pages as part of your manual. You can use it in
the future if you have to install the MaxMotion application
again.

Now you are ready to engrave with MaxMotion.

Now launch the MaxMotion application. Make sure you
have selected the proper settings for your machine
in the Machine Setup, Section I, Section II, Section III,
Section IV and Edit Materials area. After you make any
changes you should save and get out of MaxMotion
application and relaunch the application in order for
these changes to be effective.

Next, you can follow normal installation procedures for
MaxMotion software. Do not have any applications
running while you install it on your hard drive.
Insert the floppy no.1 into your computer’s floppy drive.
Click the Start button and choose Run. Click on OK.
This will automatically install the software. It will ask
you for the second floppy. After inserting second floppy
it will finish the installation.

Before you re-install the latest version of MaxMotion
software, first you should write all your selections in
the Machine setup, Section I, Section II, Section III,
Section IV and Edit materials. Following pages have
all the necessary sections where you need to write it
down. This is very Impotant.

Re-Installation directions:

OK

Machine Name:

Section IV

Section I

General Setup:

Port Selection:

Section II

Enable Pause/Resume/Kill
capability during output.

Machine Setup

Machine Setup

Cancel

Section III

X
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Revert

Steps per in

Z Axis

Steps per in

Y Axis

Steps per in

X Axis

Save

Direction, set to

for Step, trigger on the

Direction, set to

for Step, trigger on the

Direction, set to

for Step, trigger on the

Port Setup Section I

Section I

High

Falling edge

Close

Low for positive move

Falling edge

Low for positive move

Rising

High

Falling edge

Low for positive move

Rising

High

Rising

X

in

in

High

Low when the switch is open

Save

Close

Low when the switch is open
from Z limit switch.

High

X
Low when the switch is open

from Y limit switch.

for for Z axis, set to

in

High

from X limit switch.

for for Y axis, set to

Revert

Offset Home

Offset Home

Offset Home

for for X axis, set to

Limit Switches

Port Setup Section II

Section II
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Normal

X:

Backlash

Revert

X:

Start Offsets:

Start from

in Wide

Table Setup

Spindle Motor Delay

Spindle Motor

Save

Y:

Y:

Left Switch

Automatic Auxillary Controls:

Axis Selection:

Table and Tool Setup

Section III

Z:

Z:

Steps

in

Close

in High

Sec.

Right Switch

Cylindrical

X

Revert

Save

Percentage at maximum acceleration

Acceleration time constant

Initial Speed

X

in

steps

Close

percentage
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in/sec

S Curve Parameters for Speed Ramp

Reduce tool-speed if Radius below

Initial slow movement when jogging

Immediately Stop When limit switch is closed

Maintain Uniform Speed during output

Acceleration Setup

Section IV
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X

28
MaxMotion for Machines

MaxMotion for Machines

Chapter 2-29

Chapter 2:

Installing MaxMotion
HPGL type controllers
It is really simple to install the MaxMotion software. This procedure
assumes that the user is familiar with the working ways of Windows
3.X, 95, and 98 to move around within Program Groups, to use a
mouse, and so on. If the user is not familiar with the operations of
Microsoft Windows or terminology, the user is strongly advised to refer
to the Windows User’s Guide and other documentation Microsoft
provides with the purchase of the Windows operating system.
The installation procedures are slightly different for MaxMotion Virtual
Controller and MaxMotion HPGL software. Although, either of the
application is very simple to install. The installation conforms to
generally acceptable ways of setting up applications in PC/Windows
3.X, 95, or 98. Even if you have never installed any Windows application, you will need only a few minutes to accomplish the task.
MaxMotion can create jobs from scratch, it can import previously
designed jobs from virtually any Microsoft Windows 3.X (or higher)
drawing software application programs, or it can import previously
designed jobs in a CAD programs like AutoCAD. If your application
program allows outlining or converting to either Bezier curves or
preparing DXF files, it will be more than likely to be compatible with
MaxMotion. Before engraving/routing, you must set up MaxMotion for
proper machine that you intend to use. This is accomplished the first
time you use the MaxMotion application by selecting proper engraving/
routing device and its settings. After the MaxMotion software application and the driver are installed, put the diskettes away in a safe place
for possible future use.
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Installing the MaxMotion HPGL application
(PART NUMBER EW-201)
Use the following procedure to install under Windows 3.X
(a) Type or Enter WIN at the DOS prompt to load Windows 3.X, if it
is not loaded already.
(b) Insert the MaxMotion floppy disk into drive a: or b:
(c) From the Program Manager, choose Run from the file menu.
Important: If you are using a desktop manager other than Program
Manager, you must run the Program Manager application
PROGMAN.EXE, before executing step c. Running the installer from a
desktop manger other than the Program Manager may produce unexpected results.
(d) Type a:\setup or b:\setup (depending upon whether the
MaxMotion floppy is inserted in floppy drive A or B) and click OK.
The MaxMotion Installer dialog box appears.
(e) Accept the default target drive and directory displayed in the
dialog box, or select and type a new drive and directory.
(f) Follow the procedures and prompts on the screen and click OK
as prompted.
If MaxMotion was installed previously on the computer, it is possible
that a message might appear for a file named bwcc.dll for it being in
use. Simply, select the option of ‘do not install’ only for that file. When
installation is completed, a message appears indicating that the
installation was successful.
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Install MaxMotion device driver for machines with HPGL type
controllers
This procedure requires you to install Microsoft provided Generic/
TEXT only driver. This driver is included with Windows 3.X version
of the software from Microsoft. You need to have original Windows
diskettes or CD ready before you proceed with this step. MaxMotion
uses this Microsoft provided driver to communicate to your controller.
(a) Start Windows, if you have not done so already. Go to the Main
program group and select Control Panel.

(b) From Control Panel, select Printers.
(c) Printers dialog box is displayed. If you already see Generic/Text
only driver as one of the installed printers, you can simply skip to the
point (f) below. If the driver is not installed, Note and Select the
Add>> button.
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(d) List of Printers should show up inside the Printers dialog box when
the Add>> button is clicked. The very second item should be Generic/
Text only. Select it by clicking on it.
Click Install button and one of the two following will happen.
(e) If the Generic/Text Only driver was ever installed on this windows
system and removed, the file may still be on the hard disk drive. In this
case, it will simply show up in the Installed Printers area of the dialog
box.
If the driver was never installed on this computer, Install Driver
Window will pop-up and the dialog box will instruct you to Insert a
specific Windows disk. Follow the instructions and the driver will be
loaded from the floppy to the Windows set up of your hard disk.
(f) Select the Set As Default Printer button in the Printers Group. The
driver has now been selected as your default (main) driver.
(g) The Generic/TEXT only driver needs to be connected to the proper
computer output port. Generally, a new driver will be installed in
Windows with LPT1: as a default port. If your machine is physically
connected to LPT1:, you do not need to go through the procedure to
Connect to a port. Simply Close the Printers dialog box shown in the
previous figure. However, click on the Connect button to select a port
of choice. Connect dialog box will be displayed as shown below.
Select LPT1:, LPT2:, or LPT3: if the machine is connected to one
of the parallel ports.
Select COM1:, COM2:, COM3:, or COM4: if the plotter is connected to one of the serial ports.
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(h) If one of the serial ports is selected, it is important to make sure that
the communication parameters are set properly. As soon as either serial
port is selected, the Settings button will become active. Click Settings
button to bring up the Settings dialog box as shown below:

Multi-CAM Routing machines require generally the following
communication parameters:
9600 baud, 8 data bits, no parity, 1 stop bits, and hardware handshake.
New Hermes EP controller module require generally the following
communication parameters:
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9600 baud, 8 data bits, no parity, 1 stop bit, and X-on/X-off handshake.
The controllers for other machines may require different setup.
Make sure that the settings in this dialog box matches the parameters set up on the machine. Click OK after making the necessary
changes in settings. Click OK in the Connect dialog box.
You will be now back to the Printers dialog box with the proper
selection of the machine and the port.
Click on Set As Default Printer box again, if the Default Printer
box shows the machine with a different communication port than
your latest selection.

There is one last simple setup procedure required. This is a setup for
the Generic/Text only driver. Make sure and check mark on the No
Page Break box by clicking on the box. Click OK to close the driver
box.
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Use the following procedure to install under Windows 95 or 98
(a) Type or Enter WIN at the DOS prompt to load Windows 95, if it
is not loaded already.
(b) Insert the MaxMotion floppy disk into drive a: or b:
(c) Click the Start button and choose Run.
(d) Type a:\setup or b:\setup (depending upon whether the
MaxMotion floppy is inserted in floppy drive A or B) and click OK.
The MaxMotion Installer dialog box appears.
(e) Accept the default target drive and directory displayed in the
dialog box, or select and type a new drive and directory.
(f) Follow the procedures and prompts on the screen and click OK as
prompted.
If MaxMotion was installed previously on the computer, it is possible
that a message might appear for a file named bwcc.dll for it being in
use. Simply, select the option of ‘do not install’ only for that file. When
installation is completed, a message appears indicating that the installation was successful.
Install MaxMotion device driver for machines with HPGL type
controllers
This procedure requires you to install Microsoft provided Generic/
TEXT only driver. This driver is included with Windows 95 or 98
version of the software from Microsoft. You need to have original
Windows diskettes or CD ready before you proceed with this step.
MaxMotion uses this Microsoft provided driver to communicate to
your controller.
(a) Start Windows, if you have not done so already. Click on the
START button and select Settings Group.
(b) Select Printers in the Settings Group and click on it.
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(c) Printers folder will be displayed. If you do not see Generic / Text
Only printer icon as one of the available printers, click on the Add
Printer icon. If you do see the driver present in the folder, go directly to
the point (f) below.

(d) Now, work through the Add Printer Wizzard. Select Generic as your
printer manufacturer, the only available printer Generic / Text Only will
be selected automatically.
Click Next and follow the Wizzard to install the printer driver.
(e) Now, you should be able to see the icon for the Generic / Text Only
printer driver in the printers folder.
(f) Select the Generic / Text Only with a single click.
Pull down the File menu and click select ‘Set as Default’.
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(g) Again, pull down File menu and select Properties. Properties box
will show up with various tabs.

Click select Details tab. Select the port to which your controller of
the machine is connected. There is not much you have to do besides
selecting the parallel port. However, if you have to select a serial port,
you should set the proper communication parameters to match
with the controller’s parameters in the Port Settings.
Multi-CAM Routing machines require generally the following
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communication parameters:
9600 baud, 8 data bits, no parity, 1 stop bits, and hardware handshake.
New Hermes EP controller module require generally the following
communication parameters:
9600 baud, 8 data bits, no parity, 1 stop bit, and X-on/X-off handshake.
New Hermes Unica machine require generally the following communication parameters:
9600 baud, 8 data bits, no parity, 1 stop bit, and hardware handshake.
It is connected to Com 1 or 2 Serial port of your computer.
The controllers for other machines may require different setup.
Set Spool Settings to your liking.
Within the same Properties box, click select Paper. Select Custom
as the paper size and paper source as Continuous - No Page Break.
MaxMotion Identification Adapter
MaxMotion program comes with a special Identification Adapter.
Before invoking MaxMotion, you must first insert the adapter in the
parallel port on your PC computer. Each Identification Adapter is
unique so your MaxMotion program can only execute with the ID
adapter supplied with it. If you wish to attach a printer or a plotter to
the same parallel port, simply plug the parallel cable into the ID
adapter. Once installed, the ID adapter is totally unobtrusive and will
not hinder any of the capabilities of the computer.
The ID adapter has arrows on the side that is connected to the computer. Along with arrows, it has the word computer between the arrows.
This side has a 25 pin male connector. Make sure that this connector
connects to the parallel (printer) port on the PC computer.
Laptop computers may not have the luxury of having more than one
parallel port. In this case, we are offering an ID key that will attach to
the USB port. Make sure you have a laptop computer that is equipped
with a USB port.
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Machine Setup:
( 1) Set MaxMotion software for your particular XYZ table
(Virtual Controller only)
Step 1. Open MaxMotion program under Windows 3.X, 95, or 98.
Step 2. Click on the File menu and Select ‘Machine Setup’.

Step 3. Select the port address that is used to connect the table.
Step 4. Select the name of the machine that is connected to the port.
Step 5. Familiarize yourself with the sections of the General Setup.
Check Machine Setup section of Chapter 1. Contact your
dealer or technical support at Solustan if you need to make any
changes to General Setup.
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(2) Use Control Pad (Virtual Controller Only)
Step 1. Click on the File menu and Select ‘Control Pad’ (short cut
Ctrl + p key combination).
Control Pad for the
Laptop Computer
0

p

;
8

7
u

9
o

i

j

k
m

l

.

Step 2. Observe the layout of the Control Pad and notice that it is
similar to the 10 key keypad of your standard PC keyboard.
Notice the design of the alternate Control Pad for the key
boards with no keypad such as Laptop computers. Both
Control Pads are active for the keyboards with the 10 key
keypad.
Step 3. The arrow keys will move the engraving tool with respect to
the table. Note that only the keys on the keyboard will
function for the Control Pad. Mouse cannot be used in place
of keys. In fact, you should first click the mouse a few times
for it to lock up on the screen. Only after the locking of the
mouse, the keypad will be active. If you depress the FAST
key while any arrow key is held down, the table will move at a
higher speed. Always release the FAST key first before the
directional arrow key.
Step 4. If you have a step motor for your Z-axis, the Z-up and Zdown keys will move the Z-axis up and down.
If you have a solenoid control with air pressure for your Zaxis, Z-down key will move the tool down. Z-up key will be
inoperative.
Step 5. ‘Surface’ key will define the top surface of the material to
be engraved for a step-motor based Z-axis. The Z-axis tool
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Step 6.

Step 7.

Step 8.
Step 9.
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will travel up and down from the surface point while
engraving.
‘Home’ key will move the table to home position if the
table is equipped with limit switches and if the limit
switches are engaged in the Section II of the Machine setup.
Pause and Space bar are very important keys. All other
keys operate only when the Control Pad is visible on the
screen. Pause and Space bar key operate while the job is
being processed.
Depressing the Pause key, while a job is being processed,
will halt the engraving operation, the tool will be retracted
from the material and the system will await the next move.
There are three possibilities:
1. Depress the Space Bar key and the operation will
resume from where it paused previously.
2. Depress ‘ESC’ key, the rest of the job will be aborted
and the tool will travel back to a starting position.
3. Depress ‘A’ key the job will be aborted and the tool will
not move at all.
Use ‘ESC’ key to close Control Pad. This is the only way to
remove thee Control Pad from the screen.
Test the spindle motor and check that it is working.
Open Control Pad.
Depress “T” key to test the spindle motor.
The spindle motor, if properly connected, and if it is properly
selected in the Section III of the Machine Setup.., it should
turn on and stay on as long as the key is depressed.
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( 3) Adjust the setting for the surface and get ready for the job
(Virtual Controller & Motorized Z-axis only)
Step 1. Go to the starting position of the job in one of the following
ways:
A. Set the material anywhere on the table and move the tool
to the defined starting position (One of the six in Section III,
Machine Setup) of the material as your temporary home by
using the control pad.
B. If the machine has limit switches, MaxMotion is
configured with limit switches and proper offsets.
(1) If you start your jobs from upper left position, and you
position the material to the upper left position, simply Go
Home from the Control Pad and you are at the starting
position.
(2) If you have a machine with vice in the center of the table,
you start your jobs from center or top center position, and you
position the material in the vice, simply Go Home from the
Control Pad and you are at the starting position.
Step 2. Depress ‘S’ key for starting and release it.
Step 3. Move the tool to the surface area of the material with the help
of Control Pad.
Step 4. Move the Z-axis with Control Pad.
Step 5. When the lower tip of the tool touches the surface of the
material, depress the ‘Surface’ key on the Control Pad.
Step 6. The Z-axis will move up to the value of the lift declared in the
material menu.
Step 7. Either depress ‘ESC’ or ‘H’ key for home.
Step 8. The tool (Z-axis) will move back to the temporary or
permanent home.
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( 4) Set limit switches and set Home position
(Virtual Controller Only)
Step 1. There are four basic settings possible based on the type of
machine in use.
A. Machine with no limit switches.
Examples are, Newing Hall TLC, Dahlgren System One, etc.
There are no limit switch settings required here. The ‘Home’
position is wherever you start the job from. The operator
should be able to go to the Section III of the Machine Setup
and select any of the starting positions. Additionally, the
operator should be able to enter values for the starting offsets
from the start position. Once this is taken care of, it is the
responsibility of the operator to physically bring the tool to the
proper starting position with the help of the ControlPad.
Starting offsets are to be entered as follows:
X axis - Positive value if the initial offset is to move to the
right before getting to the actual starting point.
X axis - Negative value if the initial offset is to move to the
left before getting to the actual starting point.
Y axis - Negative value if the initial offset is to move away
from the operator before getting to the actual starting point.
Y axis - Positive value if the initial offset is to move toward
the operator before getting to the actual starting point.
Z axis - Positive value and the initial offset move can only
be going down toward the material.
B. Machine with limit switch only in the Z axis
Example is New Hermes 810
Only Z axis limit switch setting is required in the section II
of the Machine Setup. The ‘Home’ position is wherever you
start the job from in the X and Y axis. The operator should
be able to go to the Section III of the Machine Setup and
select any of the starting positions. Additionally, the operator
should be able to enter values for the starting offsets from the
start position. Once this is taken care of, it is the responsibility of the operator to physically bring the tool to the proper
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starting position with the help of the ControlPad.

Step 2. Starting offsets are to be entered as follows:
X axis - Positive value if the initial offset is to move to the
right before getting to the actual starting point.
X axis - Negative value if the initial offset is to move to the
left before getting to the actual starting point.
Y axis - Negative value if the initial offset is to move away
from the operator before getting to the actual starting point.
Y axis - Positive value if the initial offset is to move toward
the operator before getting to the actual starting point.
Z axis - The value cannot be declared if the limit switch is
set in the section II. The Z axis will move up and actuate the
limit switch to get to the Z axis Home position. The
application will be responsible for inserting the Z axis
maximum stroke value in the Starting offset area for the Z
axis. (You should still be declaring the lift value in the
Materials Menu for the short lifts between shapes while
machining.)
C. Machine with limit switches in the X and Y axis
Examples are Dahlgren Wizzard series, Dahlgren System II,
etc.
The X and Y axis limit switch settings are required in the
section II of the Machine Setup. The ‘Home’ position is where
the limit switches will take the machine upon clicking ‘Home’
key in the ControlPad. The operator should to go to the
Section III of the Machine Setup and select the appropriate
starting position. (Quite often this is the upper left or lower
left of the allowable machining area.) Additionally, the
operator should be able to enter values for the starting offsets
from the start position if he is interested in starting from a
point other than the position that the limit switch brings the
machine to.
Starting offsets are to be entered as follows:
X axis - Positive value if the initial offset is to move to the
right before getting to the actual starting point.
X axis - Negative value if the initial offset is to move to the
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left before getting to the actual starting point.
Y axis - Negative value if the initial offset is to move away
from the operator before getting to the actual starting point.
Y axis - Positive value if the initial offset is to move toward
the operator before getting to the actual starting point.
Z axis - Positive value and the initial offset move can only
be going down toward the material.
D. Machine with limit switches in all three axis
Examples are Dahlgren System 100 - 500Z, Most New
Hermes machines like 1219, 3000, 3000LT, 5000, 6000, etc.
The X, Y, and Z axis limit switch settings are required in the
section II of the Machine Setup. The ‘Home’ position is where
the limit switches will take the machine upon clicking ‘Home’
key in the ControlPad. The operator should to go to the
Section III of the Machine Setup and select the appropriate
starting position. (Quite often this is the upper left or lower
left of the allowable machining area.) Additionally, the
operator should be able to enter values for the starting offsets
from the start position if he is interested in starting from a
point other than the position that the limit switch brings the
machine to. The offset value for the Z axis will be grayed out
and will not be available to the operator for entering any
value.
Starting offsets are to be entered as follows:
X axis - Positive value if the initial offset is to move to the
right before getting to the actual starting point.
X axis - Negative value if the initial offset is to move to the
left before getting to the actual starting point.
Y axis - Negative value if the initial offset is to move away
from the operator before getting to the actual starting point.
Y axis - Positive value if the initial offset is to move toward
the operator before getting to the actual starting point.
Z axis - The value cannot be declared if the limit switch is
set in the section II. The Z axis will move up and actuate the
limit switch to get to the Z axis Home position. The
application will be responsible for inserting the Z axis
maximum stroke value in the Starting offset area for the Z
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axis. (You should still be declaring the lift value in the
Materials Menu for the short lifts between shapes while
machining.) OR DECLARED VALUE
IT IS IMPORTANT FOR THE OPERATOR TO UNDER
STAND THE TWO DIFFERENT Z AXIS SETTINGS:
1. MAXIMUM STROKE VALUE IN CASE THE LIMIT
SWITCH IS PRESENT OR DECLARED VALUE OF
THE MAXIMUM STROKE IN SECTION III OF THE
MACHINE SETUP... IF THE LIMIT SWITCH IS NOT
PRESENT. THIS VALUE WILL BE USED FOR THE Z
AXIS TO GO FROM THE ‘HOME’ POSITION TO THE
BEGINNING OF THE JOB AS WELL AS TO RETURN
BACK FROM FINISHING THE JOB TO THE ‘HOME’
POSITION.
2. TOOL LIFT VALUE IN THE MATERIALS MENU.
THIS LIFT VALUE WILL BE USED TO LIFT THE
TOOL BETWEEN THE SHAPES WHILE MACHINING.
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Layout and Design:
( 5) Layout a simple job with or without auto layout
(Virtual Controller and HPGL)
System initialization sets up a default font name and size. You can
change this later to the most common font you use day in and day out.
Step1. Click on the Job Design menu and Select ‘Auto Layout’.
Make a number of easy but obvious choices,
■ Plate size 4 in. high X 6 in. wide
■ Select number of lines 0 for a free layout or Select
number of lines for auto layout.
■ Default selection for height of lines to be inches/mm. If
preferred, change to percent.
■ Default height is the same as default height in the font menu
■ Select the height to 0.25 in., enter the height for the first line
and click “Set All Sizes” as a short cut.
■ Leave the rest of the selections as default values for now.
■ Click ‘create’ to create a layout with a number of lines. If
you click ‘set’, you will only change the size of the plate to
your new selection.
Step 2. If you clicked ‘create’, you will have a number of
boxes on the screen equal to the number of lines you selected
with the text cursor blinking in the first line. You can start
entering the text line by line. Click ‘enter’ or ‘return’ key at
the end of a line and the cursor will move to the next line.
If there is no more lines and if you are entering the last line,
clicking the ‘enter’ key will automatically create a new line.
The new line may be too close to the bottom off the plate or
even outside the plate. To bring the new line into the plate,
click F3 button to bring up the AutoLayout dialog box.
Next click the ‘enter’ key and MaxMotion will recalculate
the layout with the new line.
If you clicked ‘set’, you will simply update the size of the
plate. Next, simply click the text cursor somewhere toward
the top of the plate. Start entering the text line by line.
Observethat it is automatically centered. Enter the
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following:
MaxMotion!
The best product
To come along
Since the introduction
of
computerized
Engraving machines.

Step 3. You should see a job design ready to go to engraving machine.
Suddenly, you decided that you want to add another line to the
layout.

Stop 4. Click the text cursor anywhere inside the last line. Use the
right arrow key to move the cursor to the end of the line.
Step 5. Click ‘Enter’ or ‘Return’ key. It will create a new line.
Enter text - Thank You, Solustan.
Step 6. Simply, open the ‘Auto Layout’ menu and click ‘CREATE’ to
re-layout the plate.
Step 7. Before clicking the ‘CREATE’ in step 6, the user can change
any of the parameters including heights of lines and positions
of lines by dragging the lines around. Practice various
possibilities.
Step 8. Click on the Job Design menu and Select ‘Edit Layout’.
The Edit Job Layout dialog box will give you information line
by line. You can make changes line by line in the Edit
Layout Menu. This is self explanatory. Please, practice.
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Step 9. The job is still in the text mode. You can save it, open it,
edit it, change it, and engrave it easily. However, you want
to see what lines it will engrave. Click ‘View Paths’ in Job
Design menu. Observe all the lines engraving tool will follow.
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( 6) Create a multi line badge in Auto Layout
(Virtual Controller and HPGL)
Step 1. Click on the Material menu and Select the Engraving
Material you wish to use.
You can edit materials to set up proper speeds, depth, lift,
and dwell, if necessary.

Step 2. Click on the Job Design menu and Select ‘Auto Layout’.
Select the plate size. Enter 3 for the number of lines. Auto job
layout has default selection of inches for the line height. You
can choose percentage instead if you are used to selecting
relative heights for each line. If you want all lines to be same
height, click “Set All Sizes”. Select line alignment, margins
and line space distribution. Engravable area needs to be
selected only if you are selecting line heights in percentage.

Set margins to 0.15in. for both left and right. Set Top and
Bottom margins to 0.15in. Click ‘create’ and you will see
boxes in the plate representing lines.
Step 3. Select text cursor and click inside the top box on the screen
unless the text cursor is already blinking in the first box. Start
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typing the lines as follows:
MaxMotion
The
Controller Killer
Note that all the lines have the same font.

Explore the possibility of changing your design with the help
of Font, Auto Layout, and Edit Layout in Job Design.
Step 4. You can select any line or many lines with the arrow pointer.
You can also select any or many characters with the text
cursor. Now you can go into Font menu to change fonts and
sizes.

Step 5. You can add or subtract lines or move lines around. After
making changes, simply go into Auto Layout and click
Create again to realign the job.
Step 6. If you changed heights of lines, you can layout the job again
by going into Job Design. Select Auto Layout, and Click
Create to adjust the line spacing again for the new heights.
Step 7. You are ready to engrave this badge.
Note:

You can select a line of text or a graphic and move it anywhere
you want it in the layout. Just click on it with the arrow cursor
and keeping the left mouse button depressed, drag the text or
graphic where you want it and release the left mouse button.
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(7) Create and use a Variable List (Virtual Controller and HPGL)
Variable list can be entered as a simple ASCII file while in MaxMotion.
It can be imported into MaxMotion from any word processed file. Save
the file in the word processor as a text file with line breaks. Give a file
extension of *.txt.
Step 1. Click on the File menu and Select ‘Open’.
Step 2. Change Files of Types to Template Files in the Open Job
dialog box.
Step 3. Select and open badge.tpl. Click on OK.

Step 4. Note the plate size to be 2 x 3.5 in. with a 4 line template.
Lines 3 and 4 will be fixed lines, the name of the company
and logo. Line 1 and 2 are variable lines.
Step 5. Click on the Job Design menu and Select ‘Import List’. A
list management dialog box will show up. You have three
possibilities:

A. Click ‘new’ and create your own list in the Note Pad.
Clicking ‘Enter’ or ‘Return’ key on the keyboard will define
the end of a line. The text cursor will move to the beginning of
the next line.
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Step 6.

Step 7.

Step 8.
Step 9.
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B. Click ‘Get Name’ and open a previously stored file with
a list.
C. Click ‘Get Name’ and open a file provided by your
customer.
Click ‘Get Name’ and select and open list.txt. The selected
file name with its path will show up in the List Management
dialog box. Click on OK.
Click ‘Open’ in the List Management dialog box. Note that
the file is organized with names and titles in alternate lines.
The file can be edited at this point to make additions and
corrections like any word processor.
Click on the File menu and Select ‘Exit’ to close the Note
Pad.
It is time to select the variable locations on the design
plate. Hold down the shift key and click on ‘Name’ first. A
blue box should show up around ‘Name’. Next, click ‘Title’
while continuing to hold down the shift key. Both ‘Name’
and ‘Title’ should have blue boxes around them. Remember
that ‘Name’ was selected first.

Step10. Click ‘First’ in the List Management dialog box. Observe
the Name and Title changing to the first two lines of the
list.txt file. Use next and previous buttons to change the
jobs.
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Step11. Explore the power and the capabilities of this function .
Change the fonts for Name and Title. Change height. Change
the order by selecting Title first and Name second. These jobs
are ready to go to the engraving table.
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(8) Create and use Batch/Matrix operations with a Variable List
(Virtual Controller and HPGL)
This is a continuation to the previous feature of the Quick Start Variable List.
Step 1. Set up your plate, job, and Variable List per your file in
the List Management (see feature 7).
Step 2. Click on the Job Design Menu and Select ‘Matrix
Settings’.

Step 3. Declare the size of the material. It must be larger than the
plate size or job size for the operator to perform matrix
operations.
Step 4. Select column or row as a preference for the machine to
engrave.
Step 5. Select text condense preference: condense width only or
condense height and width proportionally, if and when
necessary.
Step 6. Select None if you want no scoring. Select length of partial
score if you want partial scoring. Select depth of complete
score if you want complete scoring.
Step 7. Click ‘Save’.
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Step 8. Click on the Job Design menu and Select ‘Batch/Matrix
output’. Batch/Matrix Output dialog box shows up. It will
show you the material size you entered in the Matrix settings
dialog box. It will also show you your plate size. It will
declare the total number of plates in this job. It will show all
of the selections that you just made in the Matrix settings
dialog box. The From Plate... to Plate... numbers will tell you
how many of the total number of plates will fit on your
declared material size.
Step 9. Click ‘Send’ to start engraving.
Step10. The ‘send’ button will change to ‘score’ button and wait
for your command before scoring. This pause will give you
a chance to change the tool or adjust the depth for scoring.
Step11. If you plan to use precut stock and engrave in a batch fashion
instead of a large material size and engrave in a matrix
fashion, click Same as Plate box in the Batch/Matrix Output
dialog box. Now, MaxMotion will send out one plate at a time
and will pause and wait for the operator to exchange the
material on the table and click ‘send’ again.
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( 9) Create and use Batch/Matrix operations without a Variable
List (Virtual Controller and HPGL)
This can be a useful procedure when you need to step and repeat
multiple copies of the same job.
Step 1. Go to JobDesign menu and create your job with plate size,
graphics, and text for multiple copies.
Step 2. Click on the Job Design Menu and Select ‘Matrix
Settings’.

Step 3. Declare the size of the material. It must be larger than the
plate size or job size for the operator to perform matrix
operations.
Step 4. Select column or row as a preference for the machine to
engrave.
Step 5. Select text condense preference: condense width only or
condense height and width proportionally, if and when
necessary.
Step 6. Select None if you want no scoring. Select length of partial
score if you want partial scoring. Select depth of complete
score if you want complete scoring.
Step 7. Click ‘Save’.
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Step 8. Click on the Job Design menu and Select ‘Batch/Matrix
output’. Batch/Matrix Output dialog box shows up. It will
show you the material size you entered in the Matrix settings
dialog box. It will also show you your plate size. It will
declare the total number of plates in this job. It will show all
of the selections that you just made in the Matrix settings
dialog box. The From Plate... to Plate... numbers will tell you
how many of the total number of plates will fit on your
declared material size.
Step 9. Observe the check mark in the upper right hand corner for
multiple copies with ‘No Variable List’. If the layout contains
no text or the variable list file is not loaded through import list
dialog, the batch/matrix dialog opens with ‘no variable list’
checked and unalterable. If there is text in the layout and if
the check box is alterable, check it for no variable list. Now,
the ‘Total Plates’ box becomes editable.
Step 10. Declare a number of copies that you need and you are
ready to engrave.

MaxMotion for Machines

Chapter 3-61

(10) Import clip art, logos, and designs from Corel Draw
(Virtual Controller and HPGL)
Step 1. Design jobs in Corel Draw or you can Import clipart into
Corel Draw.
Step 2. Select all and select the thinnest line from the tool box for
the artwork.
Step 3. Select all and unfill all the graphics and fonts.
Step 4. Export files as Illustrator *.EPS or *.AI files. Select
Illustrator 88 or 1.1 and ‘curves’ for your output.
Step 5. After exporting note where this file has been saved and then
Import these files into MaxMotion as *.EPS or *.AI files.
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(11) Continue the previous job to fill large TrueType fonts
(Virtual Controller and HPGL)
Step 1. Use feature (5) to layout the job again.
Step 2. Select arrow cursor on the Tool Pad and click anywhere
outside to deselect all the line. If any or all are selected you
will see blue boxes around the selected lines.
Step 3. Click arrow on the last line of text to select it. Select a
proper tool to fill these characters.

Step 4. Click on the Job Design menu and Select ‘Convert to
Paths’. This line is not a text line anymore. It is converted to
curves or graphics. Now it can be filled like any logo or clip
art.

Step 5. Drag a box around the last line and make sure all the
characters are selected with inside and outside shapes.
Avoid selecting with individual clicks. A mistake can be made
of not selecting all the shapes by clicking individually. For
example, if you select just the outside circle of a character ‘O’
instead of selecting both the parts of the character, it will fill
differently. Experiment to understand the difference.
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Step 6. Select magnifying glass from the Tool Pad and click on the
‘U’ character of the word ‘You.’ You will only see the
outline of the character and all proper blue dot positions.

Step 7. Click on the Settings menu and Select 0.010 inch fill tool.
Step 8. Remember that the sensitive part of the offset and the fill tools
is the lower most point of the tool. Make sure that the lower
tip of the tool is inside one of the selected shapes. For best
results, always apply offsets before filling the shapes. If it is
it will fill all the selected shapes. If not, everything will be
deselected. Now you will need to select them again.

Step 9. Enlarge with the magnifying glass to see the tool paths (fill
patterns) within the characters.
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(12) Create mirror image and rotate graphic files:
(Virtual Controller and HPGL)
Step 1. Click on the Job Design menu and Select ‘AutoLayout’.
Enter 2 for high and 3.5 for wide in Plate size. Click Create.
Step 2. Click on the File menu and Select ‘Import’. Select
PostScript files in the files of types, if it is not already. Double
click Example2.AI file. IBM logo shows up on the screen.

Step 3. Click on the Graphics menu and Select ‘Scale Shapes’.
Scale proportionally. Change the width value to 3.25in.
Height value will change proportionally. Click OK.
Step 4. Click on the Graphics menu and Select ‘Flip’. Observe the
two choices, mirror image along either X-axis or Y-axis. Click
either one and observe the effect.
Step 5. Click on the Edit menu and Select ‘Undo’.

Step 6. Try all the Flip and Rotate possibilities.
Step 7. If you Inserted graphics from Job design menu instead of
Importing, it will be a grouped object. Graphic operations will
not be applied until the object is converted to paths.
Step 8. If you have a line of text, it is a grouped object. Graphic
operations will not be applied until the object is converted to
paths.
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(13) Select text for kerning and editing:
(Virtual Controller and HPGL)
Step 1. Type in some text with a text tool from the tool pad.
Step 2. Position the text cursor on the left edge of the first
character but inside the character that you intend to select.
Step 3. Drag across while holding down the mouse button to select
the text.

Step 4. Hold down the CTRL key and depress the up arrow key to
increase the space between characters. The down arrow key
will reduce the space between selected characters.
Step 5. If you select the whole line and if you increase or decrease the
character spacing, you will be able to see the percentage
increase or decrease in the Extra Space box in the Font menu.
The extra space information will be saved along with the job
for the line.
Step 6. Place the cursor between a pair of characters to kern the
pair. Again, a combination of CTRL key and up or down key
will change the spacing between the pair.
Step 7. Standard editing functions are applicable such as, type over,
back space, delete, change font, change height, etc.
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(14) Move lines, objects only in the horizontal or vertical
directions: (Virtual Controller and HPGL)
Step 1. Hold down the shift key while click selecting lines and/or
objects to be moved.
Step 2. After you select the last object, make a small move with the
left mouse key held down. This action will lock the
movement only in the direction it senses first (horizontal or
vertical). Even if you move the mouse in the other direction,
the objects will move only in the direction that was sensed
first.
Step 3. After moving the text/or object, mouse key should be
released when it is placed in the desired position.
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(15) How can you change default settings?
(Virtual Controller and HPGL)
Step 1. Click on the Settings menu and Select ‘Default Settings’.

Step 2. Make all the necessary changes and Save.
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(16) What are the short cuts for magnifying glass?
(Virtual Controller and HPGL)
Step 1. Select Magnifying glass from the tool pad and bring it over
to the design plate.
Step 2. Left mouse button will enlarge the view. Right mouse
button will contract the view.
Step 3. Wherever you click to magnify, that point will move to the
center of the next magnified screen.
Step 4. No matter what level of magnification you are at, holding
down the CTRL key and clicking left mouse button will
bring the complete design plate in view and it will be
centered on the screen.
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(17) Lowdown on the Materials menu
(Virtual Controller and HPGL)
Step 1. Click on the Material menu and select any material.

Step 2. If you want to create your own material settings then click
on the Material menu and Select ‘Edit materials’.

Step 3. Now, you can enter all the different engraving values to meet
your needs.
Step 4. Click Save to make the changes permanent.
For more details refer to chapter 9 of the manual.
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(18) Positive or negative Engraving:
(Virtual Controller and HPGL)
Say we have a 2 in. x 3.5 in. plate. Let us design a badge and reverse
engrave it.
Step 1. Click on the Job Design menu and Select ‘Auto Layout’.
Select plate size to be 2 in. high and 3.5 in. wide. Enter zero
for number of lines. Click Create.
Step 2. Click on the File menu and Select ‘Import’. Select and OK
on example1.ai file. You should see a AAA logo centered in
the plate.

(Observe Import . . . in the File menu and Insert Graphics . . .
in the Job Design menu. Import filter, imports the graphics
ungrouped and is centered in the plate. Insert filter brings the
graphics as grouped and it is scaled to height of the lines
where the graphics are to be inserted.)

Step 3. To fill and engrave click on the Edit menu and Select ‘Select
All’. Observe blue dots on every shape.
Step 4. Enlarge the logo by selecting and clicking the magnifying
glass on the logo. Note the blue dots are on the inside of the
outside shaped and on the outside of the inside shapes. If
you fill the job with a tool size, it will fill only the area where
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the blue dots are located.
Step 5. Click on the Setting menu and Select ‘Fill’ with 0.060 in.
Observe that the cursor changed to a paint-brush.

Step 6. Drag the paint brush inside the logo and click anywhere.
Step 7. MaxMotion is smart enough to fill only the appropriate area.
Step 8. Click on the Edit menu and Select ‘Select All’. Go to the
Settings menu and select Fill with another size and click
inside the logo.
Step 9. Note the warning for redoing the fill, click OK to fill again.
Step10. Click on the Edit menu and Select ‘Select All’. Then Select
Paint-brush tool, if it is not already selected. Hold down the
shift key and watch the Paint-Brush tool turn empty
instead of filled.
Step11. Continue to hold down the shift key and click the empty
paint-brush inside the logo. The fill will be removed.
Step12. Now let us do Negative Engraving. Instead of filling the
logo, we want to fill all the other area on the plate. So far the
design plate is a reference plate and the plate rectangle is not
sent to the engraving table.
Step13. Click on the Graphics menu and Select ‘Cut Design
Window’. Observe that the shadow around the plate is gone.
Now the design window rectangle will be sent to the table.
Step14. Click on the Edit menu and Select ‘Select All’. We need to
change the path directions of all shapes to fill the back
ground area.
Step15. Click on the Edit menu and Select ‘Reverse Path’. Observe
the change in the position of the blue dots.

72

MaxMotion for Machines

Step16. Click on the Settings menu and Select fill with 0.060 in. tool.

Step17. Click the Paint-Brush anywhere inside the plate.
Step18. Viola! Only the background (negative) is engraved!
Always do tool offset first & fill afterwards.
Step19. Click on the File menu and Select ‘Machine’. Now you will
see the final screen for engraving. Verify the size of Plate and
Material. You can make last minute changes for the position of
the job, cutter speed, depth, lift and dwell. Now Click OK and
the job will be sent to the engraver.
Step20. Click on the File Menu and Select ‘Save As’. At this point
Enter the File name and Save the Job if you wish to keep it.

MaxMotion for Machines

Chapter 3-73

(19) Positive and negative arc creation
(Virtual Controller and HPGL)
Step 1. Type a line of text in a plate with the help of the text cursor.
Step 2. Select the arrow cursor and click on the line. The text line
should have a blue lined box around it.
Step 3. Slowly, move your arrow cursor toward the top horizontal
blue line that is part of the text box. Notice that the arrow
cursor will become a two headed cursor as it comes close to
the line.

Step 4. Click the mouse button and hold it down when you see the
two headed cursor.

Step 5. Drag the mouse up and see the arc forming in front of your
eyes. The justification of the arc will depend upon the
justification of the line.
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Step 6. Take the steps 3, 4, and 5 again except bring the cursor
toward the bottom horizontal line of the text box. Drag the
mouse down and watch the negative arc form in front of
your eyes.
Step 7. If you created positive arc and you wanted to change to the
negative arc, bring the positive arc down and flatten the line
before changing in the opposite direction.
Step 8. Experiment the following:
A. Change the line height.
B. Change the character spacing .
C. Bring the arrow to the side vertical lines and either squeeze
or expand the box to change the arc.
D. Bring in a circle, change the radius of the circle to your
liking and try to fit the arc to your radius.
Step 9. Once you have an arc on the screen, select the text cursor and
click inside the arc. An edit box will show up on top of the arc
with the text inside. Edit the text to your liking and click
OK. Note that the arc is updated with the new text. This
feature can be quite useful to open a saved job, update the arc
with new text and engrave a new job to match with the old
one. And, you do not need to remember any of the
specifications for the arc creation.
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(20) Create a text line at an angle
(Virtual Controller and HPGL)
Step 1. Type a line of text in a plate with the help of the text cursor.
Step 2. Click select the line with the arrow cursor. Click on the
JobDesign menu and select Font..

Step 3. Edit the Line Angle box to 15 from 0.
Step 4. Click OK. Notice the line rotate to 15 degrees angle.

Step 5. Pick the line with the arrow cursor and drag it to wherever you
want.
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Engraving:
(21) Engrave a job (Virtual Controller and HPGL)
Step 1. Prepare a job following instructions from the features (5), (6),
(10) or any other procedures in layout and design.

Step 2. Click on the File Menu and Select ‘Save As’. At this point
Enter the job name and Save the Job if you wish to keep it.
Step 3. Click on the File menu and Select ‘Machine’ in case of a
Virtual Controller implementation and select ‘Plot’ in case
of a HPGL machine. Now you will see the final screen just
before engraving. Verify the size of Plate and Material. You
can make last minute changes for the position of the job, cutter
speed, depth, lift and dwell. Now Click OK and the job will
be sent to the machine.
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(22) How to engrave any part of a job:
(Virtual Controller and HPGL)
This is a revolutionary power of graphically selecting and engraving
any part of a job.
Step 1. Select your plate size to be 8 in. x 8 in.
Step 2. Click on the File menu and Select ‘Import’.
Step 3. Double click on Example1.ai file. The AAA Logo will show
up on the screen.
Step 4. Click on the Graphics menu and Select ‘Scale Shapes’.

Step 5. Scale proportionally. Change the value of width to 7.5 inches.
The value of height will change automatically. Click OK.
Step 6. Do not select any part of the job. Click on the File menu and
Simply Select ‘Machine’. The complete job will show up in
the final screen area.

78

MaxMotion for Machines

Step 7. Click Cancel. Select Arrow key and click into any one of the
shapes of the logo. Blue dots will show up for the shape.

Step 8. Click on the File menu and Select ‘Machine’. The selected
part will be blue and the rest of the job will be black. Only
the Blue part will be sent to the table to be engraved in its
respective position.
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(23) Pause the machine while in operation and continue or quit
(Virtual Controller only)
Step 1. While engraving is taking place, the computer screen shows
an hour glass.
Step 2. Depressing the Zero key on the 10-key keypad anytime will
pause the process of the job. The tool will be retracted and
the machine will wait for the next command.

HOME

Step 3. The operator has three choices:
A. Depress the Space Bar again and the operation will
resume.
B. Depress the ESC key and the job will be terminated.
The tool will travel back to the starting position for the
job.
C. Depress the A key and the job will be aborted. The tool
will not move at all.
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(24) How to use SmartPlate™:
(Virtual Controller Only)
Step 1. Position the material to be engraved on the table. Define
approximate rectangular area in your mind that bounds
the area to be engraved.
Step 2. Click on the File menu and Select Control Pad. Control Pad
will show up on the screen. Click the mouse a few times until
it locks up.
Step 3. Use arrow keys to move the engraving tool to one of the
corners of the rectangular area. Now depress the “S” key
to start the SmartPlate operation.
Step 4. Move the engraving tool to the diagonally opposite corner
of the rectangular area. Depress “E” key to end the
SmartPlate operation.
Step 5. The tool will move immediately to the pre defined starting
position for the job.
Step 6. The computer screen will display the exact rectangle that
you just defined.
Step 7. Now you can design your job by entering text or bringing any
graphics into this rectangle. This will allow you to engrave
right then and there without moving the tool.
This procedure does not require any settings and
measurements.
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Chapter 4:

System Requirements
The hardware requirements for MaxMotion are very simple and straight
forward. MaxMotion works under Microsoft Windows environment.
This means that if the PC is capable of handling Windows, it is also
capable of handling MaxMotion. Specifically,
Hardware:
The requirements specifically for MaxMotion are very little. However,
we are suggesting a reasonable system configuration that is adequate.
(1) For MaxMotion working with output capabilities for HPGL or
M&G code type controller, suggested configuration is Intel or compatible 80486 processor based PC with 8 MB RAM memory (16 MB
RAM if scanning is required) under Windows 3.X. We recommend any
Pentium series processor with 16 MB RAM memory (32 MB RAM if
scanning is required) under Windows 95 or 98.
(2) For MaxMotion Virtual Controller working with a machine with
NO controller, suggested configuration is Intel or compatible 80486
processor based PC with 8 MB RAM memory (16 MB RAM if
scanning is required) under Windows 3.X. We recommend any Pentium
series processor with 16 MB RAM memory (32 MB RAM if scanning
is required) under Windows 95 or 98.
(3) The creation of ARC in the real time on the screen require significant processing power. A minimum 150 MHz Intel Pentium type
processor or equivalent processing power is recommended as a
minimum.
100 MB hard disk drive or higher (MaxMotion and engraving fonts
requires only about 10 MB hard disk space)
VGA monitor and mouse
Serial and two parallel (printer) ports
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CD-ROM drive desirable but not necessary
Software:
Microsoft Windows version 3.X, 95, or 98.
AutoCAD, AutoCAD LT, DesignCAD, Generic CAD and other CAD
programs that can generate DXF files, only if you plan to import DXF
files.
Corel Draw 3.0 or higher or equivalent design programs such as Adobe
Illustrator, Aldus Freehand, Deneba Canvas, Arts & Letters, Micrografx
Designer, etc., only if you plan to import graphic files.
Fonts and clip arts as necessary.
Adobe Streamline version 4.0 vectorizing software if scanning is
required.
(You are likely to get a software product like Adobe Photoshop with
your scanner. This is an excellent program for scanning.)
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Chapter 5:

MaxMotion Basics
This chapter provides an explanation of how to use basic MaxMotion
commands, icons, and techniques to get started. You should have an
understanding of MaxMotion Basics first before continuing on in the
program.
Double-click on the MaxMotion icon

Once you install the MaxMotion program, create a shortcut for the
application and place it right on your desktop. This will allow you to
launch the program easily and save time. When you double-click on the
MaxMotion icon on the desktop, a screen similar to the one above will
appear. Click OK. This will launch the application and the main screen
of MaxMotion will be displayed.
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Main window of MaxMotion application

Menu Bar

Tool Box

Working Area

Title Bar

Status Line

Slide Bars

Title Bar
Displays the name of the program, MaxMotion in this case, and file
name you are currently working on. It will simply show MaxMotion, if
no files are open.
Menu Bar
Displays titles of various pull down menus. Upon clicking any of the
highlighted title, a menu with a list of commands will be pulled down.
Any highlighted command can be acted upon by selecting with a mouse
or with appropriate keyboard strokes. To be consistent with Windows
end user interface, MaxMotion grays out commands that are not
applicable at that particular time in operation. Any grayed out command cannot be executed until it becomes active. MaxMotion automatically activates the commands when applicable.
Tool Box
Tool Box is a combination of various tools, such as selecting, measuring, text tool, zooming, calculating tool offsets, applying fills, etc., that
are available for preparing the job. It is also a source of information.
For more detailed information, see Tools Menu in the chapter #8.
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Working Area
Also known as Edit screen or Layout screen where the job is composed.
Status Line
Information about currently selected command or action to be taken is
displayed here.
Slide Bars
Standard Windows type slide bars (right and bottom) used to position
view of screen. Either clicking on the bar or holding down the mouse
on the arrows on either side of the bar will pan the screen.
Using the Mouse
Left Mouse Button
Is generally the main mouse button. Please, notice that the words
shapes, contours, lines, vectors, outlines are used interchangeably in the
discussion for the selection of different elements in a job with the help
of a mouse. The mouse is used for,
Selecting - clicking or double clicking on an icon or menu option.
Grouping - clicking, shift-clicking, or dragging a box around shape(s)
Moving - click select an object or group of objects and drag.
Zoom in - without resizing with magnifying glass selected.
Zoom out - hold down the shift key while clicking.
De-select - clicking outside any selected objects.
Right Mouse Button
Zoom out - Click with magnifying glass selected.
Zooming
Zoom in - Click select the zoom tool icon (magnifying glass). Notice
the magnifying glass icon with a + sign in the working area. Clicking in
the working area now will zoom in without resizing the objects. It is
important to note that wherever you click will become the center of the
new screen.
Zoom out - Click select the zoom tool icon (magnifying glass). Notice
the magnifying glass icon with a + sign in the working area. Clicking in
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the working area now while holding down the shift key (note that the
magnifying glass icon changes to a - sign) will zoom out without
resizing the objects. It is important to note that wherever you click will
become the center of the new screen.
Right mouse button also provides zoom out capability.
Selecting, Grouping, Resizing/Moving
Selecting
Is simply clicking on an icon, menu command, or a shape in the work
are with an arrow.
Grouping
Hold down the left mouse button, drag the mouse and a rectangle will
show. This rectangle is the grouping box. Cover all the shapes that are
to be grouped by continuing to drag the mouse, then release. The entire
shape or contour must be within the group rectangle to be selected and
grouped.
Alternately, click inside a shape or contour. Hold down the shift key
and continue to click additional shapes to group them.
All the selected shapes will show blue dots either on the inside or
outside of the shapes. These blue dots represent the cutter and the side
of the shape to which you can apply a tool offset and/or fill.
File
New
This command will open a new blank file. Now you can start your job
design.
Open
Open... command will allow you to open a previously saved job
(*.max) files or previously created templates (*.tpl).
Merge
Merge job command will allow you to insert a previously saved job file
(*.max or *.tpl files) into your current design that is already on the
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screen. The primary use of merge for an engraver is to create jobs with
multiple columns.
Save
This command will save the file. Make sure to understand where it
saved it.
Save As
This option allows you to make a new copy of the current file, saved
with a new name.
Import
MaxMotion can import three types of files, referred to as
PostScript(*.AI, *.PS, or *.EPS), CAD Files (*.DXF), and old
MaxMotion files. If you have files created by older versions of
MaxMotion (*.MAX),
Write Comments
Clicking on the Write Comments command, while a job is open, allows
you to view a previously saved comments for the open job or write new
comments for the new job.
Scan
Scan command allows the user to invoke the connected scanning and
vectorizing software like Adobe Streamline
Machine Setup
When clicked on the machine setup/plotter setup box, a list will be
displayed with the model numbers of all the machines supported. Select
the machine of your choice to which you will be working with. Virtual
Controller version will require for you to set more settings in each
sections.
Control Pad (Virtual Controller Only)
The standard 10-Key key-pad (Control Pad) on the keyboard is
functionally made available to control the X,Y,Z table.
Machine
This command will send the file to the machine for the output of
engraving/routing.
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Print
This command will print the job to the printer you have connected.
Exit
Selecting Exit will close the program and remove it from the RAM
memory.

Edit
Undo
Allows you to undo last action taken on the screen.
Cut
The Cut command will cut or remove selected text or contours and will
paste them to the Windows clipboard.
Copy
The copy command will copy to Windows clipboard without removing
selected text or contours from the screen.
Paste
The copy will be pasted into the exact location of the original. It will be
selected when it is pasted in, so you can immediately move the copy to
a new location.
Clear
The Clear command will delete selected text or contours/shapes from
the screen without appending to the Windows clipboard.
Select All
Selects all the text or contours on the active screen.
Reverse Paths
Graphics or shapes that are grouped have blue dots. These blue dots can
be moved from inside the shapes to outside or vice versa using the
reverse path option. For details see reverse paths in Edit menu.
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Job Design
For detailed information see Job Design in Chapter 8.
Font
Allows you to choose font, type, size, width spacing, character width,
and line angles. The capability of controlling the character width allows
the creation of many fonts out of a single font.
Auto Layout
Gives you an easiest way to set up a job with selections for a number of
lines, height of lines, factored or even spacing, and percentage coverage.
Edit Layout
Gives you complete control over every line for position and content.
Text Editor
Microsoft Windows is made available with a simple text editor called
NotePad. NotePad is extremely simple to use. MaxMotion also can be
set up to work with a specialty editor called NoteTabPro. NotePad can
only edit the text. However, the NoteTabPro can edit the text, check
spelling, change case of a character, word, or entire text, can count the
number of characters including the space characters as well as other
operations.
Read Text File
If there was a file named MAX.TXT was created and if it is residing in
the same folder where the MaxMotion application is residing, the
MAX.TXT file can be imported into the MaxMotion design screen.
Convert to Braille
The Convert To Braille command will convert standard English phrases
and words to comply with Grade II Braille specification.
Insert Graphics
Allows you to insert graphics while in the text mode. The graphic will
be inserted as another line while designing the job.
View Paths
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Allows you to view the entered text as curves without converting to
curves. (View Curves can take place either as block or text)
Convert to Paths
Select the text as a block and not as a text. Now the text can be converted to curves. (Convert to Curves can take place only if it is selected
as a graphic block)
Import List
Allows you to import variable text in the form of ASCII text into your
job design.
Matrix Settings
Allows you to select various parameters for either batch engraving on
precut material or Matrix engraving on large material sizes.
Batch / Matrix Output
Allows you to make final selections and controls the machine while
sending the job.
Serialization Setup
This is a very rich and flexible feature for serializing parts for automation. It can be done with variations of numeric, alphabetic or combined
values.
Refresh Screen
Allows you to update the screen at will.
Arc Engraving
Any text line can be simply stretched from the top or from the bottom
of the boundary of the line to create a positive or a negative arc.
Text lines at an angle
Any text line can be rotated to any angle desired by declaring the value
of the angle in degrees.

Material
For detailed information see Material Menu chapter.
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Choosing Material
By choosing a material from the material menu, cutting parameters like
tool speed, cutter depth, tool size, material size, etc. are automatically
set.
Edit Materials
Edit materials allows you to set the parameters mentioned in choosing
material. Custom material settings can also be created.

Settings
Offset
The outline command is used for creating tool offsets to compensate for
the cutter diameter.
Fill
The fill command is used for creating route path to remove material
from inside a shape or shapes. Any inserted graphics or TrueType or
PostScript fonts need to be converted to paths. Once they are converted
to paths, they are simply shapes or contours to the MaxMotion software. Tool offsets and fill commands can be applied to these shapes.
Default Settings
The default settings are used to set up the dimensional values (millimeters or inches), tool size values, and the time values (seconds or
minutes) for your work in MaxMotion.
Design Plate Size
Plate size can be easily changed in Auto Layout under job design menu.
However, you can change it from here too.
Bitmap Setting
This optional feature is used for scanned images of photographs.
Different settings are available to get proper output.
Graphics
Graphics operations like flip/rotate and scaling are possible only for the
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graphics. These graphics are typically the artwork imported from
graphic programs (*.ai, *.eps, or *.ps type files) or CAD programs
(*.DXF type files). If you need to flip/rotate or scale text or inserted
graphics, first convert them to paths and then treat them as graphics. It
is important to note that once the text is converted to paths it is no
longer text and cannot be edited as text.
Grid
Allows you to turn the grids off or on.
Ruler
Allows you to turn the horizontal and vertical ruler guides on or off.
Flip/Rotate
Allows you to create mirror image and/or rotate a job or any part of a
job in 90 degree increments. This is used for creating reverse engraving/routing.
Scale Shapes
Used when resizing a job or part of a job.
Change Depth
By changing the value at ‘Set Depth’, the depth of all the points of the
selected shape(s) can will be set. The value entered at ‘Move Deeper’,
however, bodily moves the entire shape(s) down (up if the value is
negative) by that amount.
Join Shapes
Many DXF Files may have separate shapes that may look like an
enclosed shape. Two separate but adjoining shapes can be shift selected
and joined.
Cut Design Window
The plate size design window is simply a reference plate. However Cut
Design Window command can activate the plate lines. Now, the design
window can be sent out for machine operation.
Change View Only
You can create your own stationery templates. Simply, import the
graphic and select the part that you would like to convert to a stationery
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piece. Pull down the Graphic menu in and select ‘Change View-Only’.
The selected part will turn green to signify that it has become stationery
or reference part of a design. Now, you cannot select, move, scale, or
send it to the engraving table.
If you do want to make it Non-Stationery, scale it and send it to
engrave, simply hold down the Ctrl key while selecting. The blue dots
will show up. Pull down the Graphic menu and select ‘Change ViewOnly’ again. This action will reverse the process.
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Chapter 6:

File Menu
Under the file menu are the commands for bringing PostScript or CAD
files into MaxMotion, starting new files and various other commands
including the command for machining or plotting. To access these
commands and more, click on “File” or use ALT + F key combination
and then click on the appropriate command.

FILE MENU (Alt+F)

New (Ctrl+N)
You may want to create a new document right within the MaxMotion
with its own capabilities. If you have a document already open on the
screen, you will be asked if you wish to save the current drawing. After
you respond you will be presented with a new screen to begin a new
layout.
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Open (Ctrl+O)

Open... command will allow you to open a previously saved job
(*.max) files or previously created templates (*.tpl).
Machine/Plot files (*.max) are created by MaxMotion. Before the job is
processed, MaxMotion must convert the design into the proper format.
This is done automatically whenever a Drawing file is opened. After
the first conversion, you should save the resulting Machine/Plot file for
future use.
When the Open dialog box first appears it will display the file types
selected in List Files of Type. You may wish to switch from Machine/
Plot files to Templates files that will be shown in the Open dialog box.
For example, you may be looking for a file which you have already
created and saved. In that case, you need only display Job files. You
are also allowed to navigate to different drives (hard disk or floppy)
and directories.
Merge (Ctrl+M)
The ‘Merge’ command is enhanced for many design and composition
capabilities. The primary use of merge for an engraver is to create jobs
with multiple columns. It is easy to create and update individual
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columns in separate files. Edit individual files and use merged files
mainly for viewing and sending it to the machine. Merge job command
will allow you to insert a previously saved job file (*.max or *.tpl files)
into your current design that is already on the screen. The merging will
take place in the following manner:
The top left points of the two saved files are matched while merging. If
the plate sizes of the two files are not the same, a larger of the two plate
sizes is created to hold and merge both the jobs. The condense mode of
the merged jobs is automatically set to single line, thus eliminating
chances of similar lines affecting each others. The width percent of
each line is set equal to its condense percent to prevent it to condense
differently in plates of different sizes. Lines having Fit justification are
changed to center justification to prevent the lines from stretching to
margin of a different plate size. The commands like Magnify or SaveOpen will not alter the layout.
Example of Column 1, 2, 3 and 4 are provided with the Maxmotion
software. Open Column 1 first and then merge column 2, 3 and 4
one after another to create this plaque as shown in the picture. looking
at each file of the different colums will give you an understanding of
how to create these files.
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Save (Ctrl+S)
The key combination of Ctrl+S is the short cut for the Save command.
At the time of new, open, or exit if the user chooses to save, it is ‘saved’
not ‘saved as’. Only at the time of saving a new file, ‘save’ acts as ‘save
as’. Unlike in save as where you click OK and know it is saved, in
‘save’ there is no way to know if it has actually saved. For this reason,
the action is acknowledged on the status line.
Save As
This option allows you to make a new copy of the current file, saved
with a new name. You could update your existing file by typing and
saving under the same file name. You could also create two similar
versions of the same plot file with this choice. You should always give
*.max extension to the files created by MaxMotion. If you do not, the
application will automatically append the max as the choice of extension. MaxMotion will read them as native files.

Import (Ctrl+I)
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Pull down the File menu and click select Import.... An Import dialog
box will be displayed. This is a standard Windows type dialog box that
allows you to select a file to be imported. If you click on the down
arrow of the List Files of Type:, you will see that MaxMotion reads
three types of files, referred to as PostScript(*.AI, *.PS, or *.EPS),
CAD Files (*.DXF), and old MaxMotion files. If you have files created
by older versions of MaxMotion (*.MAX), change the names of files to
*.OLD. Import these files and save them again as *.MAX files under
the newer version.
Drawing files (*.PS, *.AI, or *.EPS).
Drawings are Illustrator or encapsulated PostScript compatible files
from any drawing programs that is capable of creating such files.
MaxMotion imports two types of drawing files: PostScipt files which
are saved in Illustrator format and Text files which contain the same
type of information, but are saved in the format of an ordinary text
document. Text files may be imported and edited by any word processor. If you are not sure whether the files produced by your drawing
program can be opened by MaxMotion, please contact Solustan.
You may select an item from this “pop-up” menu just as you would
from any other menu. When you make your choice, the import dialog
box will display only files of the type selected. If you wish to see all
available files at once, simply select the option “All Files (*.*)”.
The screens shots illustrates the effect of selecting the choice of files.
CAD Files (*.DXF)
Most CAD programs export files under DXF format defined by
AutoDesk, creator of AutoCAD application program. If you are not
sure whether the files produced by your CAD program can be imported
by MaxMotion, please contact Solustan.
M&G-CODE Files
MaxMotion Virtual Controller software allows importation of M&Gcode based files. If you do not see your favorite import filter when you
check the M&G-code import filters, please, get in touch with us. We
will be pleased to set up a filter to import your file structure.
Generally, we use the following conventional codes:
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[FANUC G-Code]
XCode=X
YCode=Y
ZCode=Z
ArcCenterXCode=I
ArcCenterYCode=J
CenterIncremental=0
; Character(s) prefixed to line #, e.g. N170. Leave it blank if no line #
or digits-only line #.
LineNumber=N
Separater=,
Comment=;
MoveCommand=G00
LineCommand=G01
ArcCW=G02
ArcCCW=G03
; Set dwell in seconds
Dwell=G04
SetInch=G70
SetMatric=G71
DrillHole=G81
SetAbsolute=G90
SetIncremental=G91
Pause=M00
ToolDown=M10
ToolUp=M11
Go Home=M25
JobEnd=M02
[Techno G-Code]
XCode=X
YCode=Y
ZCode=Z
ArcCenterXCode=I
ArcCenterYCode=J
CenterIncremental=0
; Character(s) prefixed to line #, e.g. N170. Leave it blank if no line #
or digits-only line #.
LineNumber=N
Separater=,
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Comment=;
MoveCommand=G00
LineCommand=G01
ArcCW=G02
ArcCCW=G03
SetInch=G70
SetMatric=G71
DrillHole=G81
SetAbsolute=G90
SetIncremental=G91
ToolDown=M10
ToolUp=M11
JobEnd=M30
[Laser G-Code]
XCode=X
YCode=Y
ZCode=Z
ArcCenterXCode=I
ArcCenterYCode=J
CenterIncremental=0
LineNumber=
Separater=,
Comment=;
MoveCommand=G0
LineCommand=G1
ArcCW=G2
ArcCCW=G3
SetInch=G70
SetMatric=G71
DrillHole=G81
SetAbsolute=G90
SetIncremental=G91
Go Home=G07
ToolDown=M11
ToolUp=M21
JobEnd=M30
HPGL Files
MaxMotion Virtual Controller software allows importation of HPGL
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code based files. If you do not see your favorite import filter when you
check the HPGL code import filters, please, get in touch with us. We
will be pleased to set up a filter to import your file structure.
Generally, we use the following conventional codes:
[Hermes HPGL]
Delimit=;
Separater=,
Comment=
PenUp=PU
PenDown=PD
SetAbsolute=PA
SetRelative=PR
Circle=CI
ArcAbsolute=AA
ArcRelative=AR
ArcWedge=EW
RectAbsolute=EA
RectRelative=ER
StepsPerInch=1016
[Roland HPGL]
Delimit=;
Separater=,
Comment=
PenUp=PU
PenDown=PD
SetAbsolute=PA
SetRelative=PR
Circle=CI
ArcAbsolute=AA
ArcRelative=AR
ArcWedge=EW
RectAbsolute=EA
RectRelative=ER
StepsPerInch=2540

An entry named ‘MaximumShapes’ in section ‘GlobalValues’ of
MaxMotion.INI file is available, where you can specify this limit to

MaxMotion for Machines

Chapter 6-103

whatever you want. This is only the upper limit of number of shapes to
be imported from a single file. This, however, does not prevent number
of shapes in layout overshooting this limit by either importing another
file or creating shapes within MaxMotion.

All different format files.
Only one document may be open at one time. However, Merge and
Import command allows you the flexibility of opening and importing
additional files and merging them easily.
Bitmap Files
Windows has four types of bitmap files. 1 bit (monochrome), 4 bit (16
colors), 8 bit (256 colors) and 24 bit bitmap. MaxMotion can import all
of them. 1 bit bitmap files are best suited for 2D output. PhotoGrav
type of software creates and saves 1 bit bitmap files most suited for 2D
pictures.
Select Import from the file menu and then select BMP type file. Now
you should be able to import bitmap files. It is important to keep in
mind that bitmap files can consume a lot of memory and as a result it
can take a very long time to process and output the file. Once the file is
imported into MaxMotion, it can be selected, moved, nudged or deleted
just like any other graphic shape. MaxMotion displays it to its actual
size in inches or mm according to its resolution.
In 1 bit or 2D bitmap area with black dot engraves at assigned depth
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and white dot means pen up. In 3D or colored bitmap white dot means
pen up. We take an average of red, green and blue color intensities and
determine the depth in 256 levels for colored jobs. Black will be
engraved at the maximum depth. This gradation of the level takes place
only in 3D output and 3D output has to be checked. The depth of the
bitmap can also be changed from the ‘Change Depth’ dialog under
graphics menu.

There are more settings available under the settings menu
for ‘Bitmap Settings’. Please refer to Chapter 11 for detailed explanation on the Bitmap Settings.
Write Comments (Ctrl+W)
Clicking on the Write Comments command, while a job is open, allows
you to view a previously saved comments for the open job. If there
were no comments or if the job is a newly created one, the accompanied editor will start a new comment field. If the job has a name ABC.Max, the name of the comment file will be ABC.cmt. MaxMotion
will link the two together. You can save or edit the comments for future
reference.
Scan
Scan command allows the user to invoke the connected scanning and
vectorizing software like Adobe Streamline This program needs to be
specified by name (with path if required) in item ‘ScannerPath’ in
GlobalValues section of you .INI file. This mechanism is identical to
TextEditorPath, that specifies editor.
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Machine Setup/Plotter Setup

When selected, the machine/plotter setup dialog box will appear. When
clicked on the machine/plotter box, a list will be displayed with the
model numbers of all the machines supported. Select the machine of
your choice to which you will be working with.
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Control Pad (Ctrl+P)
Control Pad for the
Laptop Computer
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The standard 10-Key key-pad (Control Pad) on the keyboard is
functionally made available to control the X,Y,Z table. Most of the
functions offered in the control Pad are off-line. The machine is
controlled from the keypad. It is positioned properly before a job is
sent from the computer. The arrow keys and FAST key move the table
in the X, Y direction at either regular speed or high speed. Z control
keys move the tool up or down. SURFACE key defines the assigned Z
= 0 position for the job. HOME key moves the tool to the X = Y = Z =
0 position, if the machine is equipped with limit switches.
Note the 10 key keypad that allows you to jog the machine anywhere
you want. However, the Z-up and Z-down were designed to drive a
stepper motor in Z axis just like for X and Y axis. The Z controls on
the 10 key keypad can additionally be useful for machines using
solenoids type devices controlling the air pressure to move the Z axis.
In case of a Z axis controlled by a solenoid, the Z-down key will allow
you to move the axis down to adjust the depth movement of the
engraving tool. Releasing the Z-down key will result in retracting of the
engraving tool.
The only two keys that are active during an execution of a job is
PAUSE and SPACE BAR. While the machine is in the middle of
performing a job, depressing the PAUSE key will halt the operation. At
this point, depressing the SPACE BAR key will resume the operation or
depressing the ESC key will terminate the job.
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If the PC/Windows computer used is not Intel 486 DX2/66 MHz or
faster, it may be advisable to turn-off the PAUSE/RESUME capability.
This can be achieved in the Machine setup menu.
Spindle motor enable/disable and Spindle motor delay in millisecond is
set up here.
Control Pad for LapTop Computers:
The Maxmotion software capability is extended with the possibility of
driving the machine from laptop Computers in addition to desktop PC/
Windows computers.
Almost all desktop computer keyboards are designed with 10-key
keypad. Almost all laptop computers do not have space for the keypad.
MaxMotion is now fully functional with laptop computers by adding
the keypad capability on the main keyboard. Such an implementation
was found on Toshiba laptops and was implemented under Maxmotion.
Now, we have two active control pads. One is the 10 key keypad. The
other is as shown on page 7.
Note the following:
■ Control Pad will not work until you bring it up on the screen. Once
the Control Pad is on the screen, do not use the mouse to exercise the
Control Pad. Only the 10-Key keypad of the keyboard will activate the
functions of the Control Pad. While the Control Pad is active, mouse
will not work. Once you are done with the Control Pad, depressing the
ESC key on the keyboard will remove the Pad and the MaxMotion
application will revert back to the main design screen.
■ The software provides acceleration/deceleration capability. If your
driver and motor combination can handle acceleration, you can hold
down one of the directional keys on the Control Pad and depress the
FAST key while continue to hold down the directional key, the
machine will travel faster. The speeds will depend upon the values set
in the materials menu for jog speed and move speed.
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■ To setup the zero position for the Z-axis, move the tool up or down
until a desired point is reached. Depress the SURFACE key to inform
the software of your Z position. The Z-axis will move up immediately
by the Z-up value called out in the selected material in the materials
menu.
The system is ready to machine your design needs.

Machine/Plot (Ctrl+T)
Selecting machine/Plot from the File pull down menu will bring up the
machine/plot screen or final screen before sending the file out to the
machine.
Once a command is given to send the job to the engraving machine or
routing machine, the machining will start almost instantaneously. A job
with a graphic and six lines with different fonts in each of the lines took
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3 seconds to process on a 100 MHz Pentium computer before it started
engraving. This is the fastest engraving software on the market.
Normal sequence of engraving is as follows:
The job sorting routines are finely tuned. First the graphics are sorted
with the new sorting to minimize unnecessary travel while up in the air,
then append all text lines at the end. The new sorting of the graphics is
to sort the graphics and logos starting from the shape closest to top left
corner, then the shape nearest to it and so on. Depending upon the
complexity of the graphics, the time to engrave could be cut into half or
more. Text lines are treated as text lines unless they are converted to
paths. If converted to paths, they are treated as graphics and sorted
accordingly. Imported graphics are treated as graphics for sorting
purposes. However, inserted graphics are treated as text lines unless
converted to paths. If it is text, it will go line by line to reduce the travel
time by default. The user can override any default by selecting the
sequences. It will follow and engrave in the order that is selected. If any
part of a job is selected on the screen, the final screen will show the
selected part in blue and the unselected part in black, and it will
engrave the selected part only. Additionally, the Selection Only box
will be automatically checked to notify that a selection was made. The
selection only box can be unselected by checking on the box and
removing the check mark. In this case, the complete job will be
processed.
Normal sequence of routing is as follows:
If it is graphics, the software will sort the job from inside out by
default. If it is text, it will go line by line to reduce the travel time by
default. However, it will rout each character inside out. The user can
override any default by selecting the sequences. It will follow and rout
in the order that is selected. If any part of a job is selected on the
screen, the final screen will show the selected part in blue and the
unselected part in black, and it will rout the selected part only. The
selected shapes will be routed in their respective positions on the job
material.
All settings in the final screen are determined by the material selected
from the material menu. Defaults for each type of material are preset.
Each setting can be changed to suit your requirements. (See Edit
material under material menu). The settings in the final screen will be
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sent out to the machine and will override the settings at the machine.
Layout
The Layout parameters are used to position your job exactly where you
want it on your material. By using base line and left margin you can
place the lower left corner of your job anywhere within your material
dimensions.
Current job / Auto Centering
The current job parameters are used to automatically center your job to
the material size showing. You can center the job by clicking on the
boxes for Top/Bottom centering and Left/Right centering. Please, note
that as you click on the box for Top/Bottom, the baseline box in the
Layout menu will be grayed out. Also, the dimension value in the
baseline box may change to a value for centering the job. A grayed out
value cannot be edited. Similarly, the Left Margin box in the Layout
menu will be grayed out when you click on the box for Left/Right
centering.
Speed
The speed parameters for rout speed and Z feed will be picked up from
the Material menu and displayed. The values are in percentages and can
be changed at the last minute here in the final screen before sending the
file to the machine.
Cutter
All the parameters are picked up from the Material menu and displayed. Any of the values can be changed here.
Depth: Depth of cut. The routing head can be used as a floating head or
a fixed head. The depth of cut is set up physically on the head with the
micrometer setting in case of floating head. Calling out a value here
merely adds pressure to the head in order to make sure that the floating
head is firmly riding on the material. However, remove the floating
head and the routing head will act like a routing bit. The bit in this case
will try to travel down along the Z axis for the depth of cut that is
called out in the software set up.
Lift: Lift or amount the cutter in inches will move up between cuts.
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Dwell: Amount of time in seconds the cutter will stay at the same
position in the material before making X,Y moves to cut the material.
Material Size
Material size defaults to the dimensions set up in the Plate Setup
window.
Table
Shows the table that is selected in the Machine/Plotter Setup window.
Also, it displays the size of the table available for machine/plotter.
OK or Cancel
Clicking OK button will prepare the job to send it to the machine in
case of the Virtual Controller software.
Clicking Cancel button will bring you back to the main screen of the
application without sending the job to the machine/plotter.
Clicking OK button will prepare the job to send it to the machine in
case of the HPGL software. If you click OK, you will be presented with
the standard Generic/Text Only printer driver dialog. At this point you
have two choices,
(1) Click OK and the file will be sent to the appropriate serial or
parallel port for the ultimate destination - your machine.
(2) Click on Print to File box and the job can be sent to a file for
storing the job instead of sending the job to the machine/plotter. All you
have to do is to declare the path and the file name under which the file
is to be stored.
The standard Generic/Text Only printer driver and its dialog box is
completely bypassed in case of virtual controller (step & direction
driving) and no dialog boxes will show up nor you will be able to save
the file with Print to File capability.
Print
(1) So far the Print command always printed design plate, stationary
template and target symbol around a dot, besides it did not show offset
or fill. Now since print command is also going to engrave for the laser
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engraving machines,
The following changes have been made:
Print command will print only a dot, not target symbol. Stationary
template will not be printed. Design plate will be printed only if 'Cut
design window' is enabled. Offset and fill will be printed. When you
print on a printer, now a dot will be difficult to see, having been
stripped of target symbol.
(2) Now you can specify printer starting position as well as orientation
in item PRINTER_STARTPOS_ROTATION in section GlobalValues
of .INI file. This is useful for laser engraving. Value 0 means bottomleft, 1 means top-left, 2 means bottom-left rotated at 90, 3 means topleft rotated at 90. Values 2 and 3 are not likely to be needed, as 'Setup'
in Print dialog allows you to choose between Portrait and Landscape
orientations. You may recollect, this dialog comes up only if you have
ShowPrintDialog=1 in your .INI file. If you wrongly configure
between top-left and bottom-left, you can print upside down mirror
image, except for fonts which will not flip.
Exit (Ctrl+Q)
Selecting Exit will close the program and remove it from the RAM
memory.
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Chapter 7:

Edit Menu
The edit menu contains basic Windows programs edit features such as
cut, copy, paste, etc. To access edit commands and more, click on
“Edit” or use ALT + E key combination and then click on the
appropriate command.

EDIT MENU (Alt+E)

Undo (Ctrl+Z)
Allows you to undo last action taken on the screen. Most of the actions
can be undone. However, it is best to explore as more editing features
added all the time to make the software intuitive.
Cut (Ctrl+X)
The Cut command will cut or remove selected text or contours and will
paste them to the Windows clipboard. After cutting one text or contour
the next text or contour cut will overwrite the Windows clipboard.
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Copy (Ctrl+C)
The copy command will copy to Windows clipboard without removing
selected text or contours from the screen. After copying one text or
contour the next text or contour copied will overwrite the Windows
clipboard.
Paste (Ctrl+V)
Any shape may be cut or copied to the clipboard and pasted into the
current document. The copy will be pasted into the exact location of the
original. It will be selected when it is pasted in, so you can immediately
move the copy to a new location.
Clear (Ctrl+D)
The Clear command will delete selected text or contours/shapes from
the screen without appending to the Windows clipboard.
Important Tip: To avoid having the copy appear directly on top of the
original, move the original after selecting Copy and before selecting
Paste. You can also copy a shape from one document and paste it into
another. You need to close the original document after making the copy,
and then open the document where you want to paste it. The copy will
remain on the clipboard even after the original file is closed.
Select All (Ctrl+A)
Selects all the text or contours on the active screen. The alternate way
to select would be to click on the arrow tool in the tool palette, bring
the arrow on the screen, hold down the mouse button, and drag across
the screen. Any and all shapes that are completely covered by the drag
operation will be selected.
Reverse Path
The reverse Path command is used when you need to change from one
side of a contour to the other that you wish to apply an offset or fill.
(See examples on the next pages)
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If these shapes were filled as is...

this is the result.

If Reverse Path is used on the
center rectangle...

this is the result.

Select the object or the shape for which you need to reverse the
path. Then go to edit menu and select “Reverse Path”. Notice the
dots around any shape that can be either inside or outside of the
shape. This is very important for fill command.
The edit commands in case of a text job as opposed to graphic job may
behave slightly differently. Please, experiment to familiarize yourself
with various functions. Next page has an example of a letter how it can
be filled.
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This job filled.....

But use Reverse Path
on the lettering.....

gives you this.

and get this.

In case of text letters like A, B, D, O, P, Q, R, a, b, d, e, g, o, p and q are
very good examples for proper fill command to be used. After converting text into path make sure that path directions are proper to fill them
properly.
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Chapter 8:

Tools Menu/Tools Palette
The Tools Menu simply recreates the Tool Palette. If you prefer, you
may select any of the tools for use through the menu selections, or the
combination of keys, and remove the tool palette from the screen by
selecting the “Tool Palette” choice. This will hide the Tool Palette and
uncheck the menu choice. You may bring the Tool Palette back by reselecting the Tool Palette choice in the Tool Menu. To access these
commands and more, click on “Tools” or use ALT + T key combination and then click on the appropriate command. Please, note that either
the top application bar with the words Rout is dark or the top of the
Tool Palette with words Tools is dark. Click anywhere inside Tool
Palette for it to be selected and become active and hence the Tools bar
to be dark. Similarly, click anywhere on the main screen for the main
screen and all of the pull down menus to be selected and become active
and hence the Rout top bar to be dark.

TOOLS MENU (Alt+T)
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Tool Palette (Ctrl+Shift+T)

Whenever MaxMotion is launched a screen similar to the one above
will appear showing the tool palette..
MaxMotion provides you with a Tool Palette for making changes to
your drawing. Initially the arrow, which represents the Selector, is the
current tool. You may change the tool at any time by clicking in the
area which holds the tool icon. The tools are described below.

Select (Ctrl+Shift+G)
The Arrow Tool selects part or all of the job as graphic objects. When
you place the arrow, which represents the selector, inside of a shape,
and click the mouse button, you are selecting that shape. Blue dots
appear near the outline of a selected shape. The selected shapes can be
moved on the screen by holding down the mouse and dragging it
around.
Multiple shapes selection can be accomplished by,
■ Holding down the shift key while clicking inside different shapes.
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■ Holding down the left mouse button while dragging a box encompassing the contours to be selected.
You can select a group of objects by first clicking the mouse outside of
any of the objects and then holding down the mouse button while
dragging the mouse. A gray rectangle will appear showing you the
selection area. Any shape, which falls within the rectangle, when the
mouse button is released, will be selected. The entire shape needs to be
within the rectangle; if only part of the shape is within the rectangle, it
will not be selected.
While the shapes are being moved, the dimensions box of the tool
palette will be continuously updated to show the distance that the shape
or shapes have been moved from the starting location.

Frame (Ctrl+Shift+B)
When you select the frame tool and bring the cursor over to the main
screen area, the cursor changes to a cross hair. Go to a desired area of
the screen, click and hold down the left mouse button. As you drag the
mouse, the tool will draw a rectangle on the screen bound by the initial
and final mouse positions.

Measure (Ctrl+Shift+R)
When you select the ruler icon, the numbers shown in the tool palette
show the distance between two measurement points. The first point
can be set anywhere on the screen by clicking and holding the mouse
button. The second point is the present location of the cursor which
changes as the mouse is dragged. The measurements will be shown as
long as the mouse button is held.

Text Tool/Enter Text (Ctrl+Shift+J)
The Text Tool presents you with a text cursor and prepares MaxMotion
for text entry.
■ Text Tool is the preferred way to select and edit text as text.
MaxMotion now saves text as text and converts to paths automatically
upon sending the job to the engraving or routing table. This is a
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convenient way to save jobs and modify them in future with ease.
■ The available space next to the Text Tool in the Tool Palette displays
the selected font and its size in inches or millimeters.
■ Please, note the difference in the Select cursor and the Text cursor.
The Text Tool is designed to simplify the job creation for engraving,
vinyl cutting, and some of the routing application. However, pains have
been taken to make the Tool behave just like a Text cursor in a general
purpose word processing package.

Nudging
It was always possible in MaxMotion to select a shape or shift + select
a bunch of shapes and drag them with the pointer tool to anywhere you
want on the plate or outside the plate. (It is important to note that any
shape outside the plate will not be processed when the job is sent to the
machine. Even if only a part of a shape is outside the plate, the whole
shape will not be processed when the job is sent to the machine.)
It was always possible in MaxMotion to select a line of text or shift +
select a bunch of lines and drag them with the pointer tool to anywhere
you want on the plate or outside the plate with the help of the pointer
tool.
Now, it is possible to select shapes or text and move them (Nudge
them) in the horizontal or vertical direction at a precise distance. Note
the addition of nudge value in the Tool Palette. Use the four arrow keys
(not the accounting keypad) to nudge the selected part of a job in the
direction of your choice. It will move the selected part of a job to the
declared distance for every click on the arrow key.
The nudging distance for every click can be changed and adjusted in
the Default Settings of the Settings pull down menu.

MaxMotion for Machines

Chapter 8-121

Dimensions
The next three lines of the tool palette provide information about the
size and locations of shapes in the drawing. Initially, and any time there
are no objects selected in the drawing, the numbers shown represent the
overall height and overall width of the entire drawing. The drawing
may show up in different magnification ratios, but the dimensions
shown always represent the full scale dimensions of the drawing.
Any time you make a selection of one or more shapes, the dimensions
shown represent only the outside dimensions of this selected shape or
shapes. This is a convenient way to find out the height of a line of text
in a multi-line layout: you can select the line you are interested in and
read the dimensions in the tool palette to find out if the text is scaled to
the proper height.
When the selector icon is being used to move a shape, the numbers in
the tool palette indicate the distance that the shape or shapes have
moved from the initial position.

Magnify (Ctrl+Shift+M)
Selecting the magnifying glass icon allows you to zoom in or out of the
drawing as it appears on the screen. This has no effect at all on the
actual size of the drawing. To change the actual size of the drawing
you must use the “Scale Shapes...” menu option in the “Graphics”
menu.
When you initially open a drawing file or plot file, MaxMotion will
automatically reduce the drawing to fit the screen of your computer. If
the drawing is shown at less than full size, and you want to enlarge the
view, click the mouse with the magnifying glass anywhere in the
viewing window and the screen view will double in size. To go back to
the reduced view, hold down the shift key. The plus sign within the
magnifying glass frame will change to a minus sign, and clicking the
mouse with the shift button held will now reduce the screen image to
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one-half the present size. There is even a faster way to reduce the view.
Use the second (right) button of the two button mouse and click to
reduce the view.
Important Tip: Holding the Control key while enlarging any reduced
view will enlarge the screen to a full scale view in one step, even if the
screen was showing the drawing at 1/8 x or smaller scale. Similarly,
holding down the Control key while reducing any enlarged view will
reduce the screen to a full scale view in one step.

Offset Tool (Ctrl+Shift+U)
The Offset tool is used to compensate for the cutter diameter.
MaxMotion will calculate necessary offset values based on the selection of the routing tool. By offsetting the contours of the job you will be
able to maintain their exact sizes after the job is cut. To use the tool,
select the contours you wish to offset, then under the settings menu
select offset. Choose the cutter diameter and the mouse pointer will
turn to a saw. Click the saw inside any one of the selected contours. The
screen will give you a visual feed back as the operation is taking place.
(To offset a letter such as an “O”, which is made up of two circles, you
must select both circles, either individually, or by dragging a selection.)
The original line of the shape is represented by a black line. The newly
created offset line is represented by a red line next to the black line.
The red offset line can be turned on or off by clicking in the square box
to the right of the saw in the tool palette.

If more than one shape is selected when the offset tool is used, offset
will be created to all the selected shapes. If you wish to remove the
offset from any shape, hold down the Shift key with the offset tool
selected. Clicking within any shape with offset will now erase that
offset and the offsets of any other selected shapes.
It is sometimes possible that an offset will be created on the wrong side
of a shape. This will happen when the original PostScript drawing file
has drawn the shapes “inside-out.” Some drawing programs have an
option to correct this; you may be able to choose “Reverse Path
Direction” for example, before saving the file in the drawing applica-
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tion.
If you have opened a drawing which has “inside-out” shapes,
MaxMotion can also correct them. Simply, select the shape/contour that
has wrong direction. (You will see the blue dots when you select a
shape. The offset of the shape will take place on the side of the dots.)
Now, pull down the Edit menu and select Reverse Path. The path will
be corrected and will be indicated by the shifting of the blue dots.

Fill Tool (Ctrl+Shift+F)
The fill tool is used to create route paths for your routing tool to follow.
To use the tool first select the contours you wish to fill, then under the
settings menu select Fill. Choose the cutter diameter and the mouse
pointer will turn to a paint brush. Click the paint brush inside any one
of the selected contours. The screen will give you a visual feed back as
the operation is taking place.
The original line of the shape is represented by a black line. The newly
created fill lines are represented by red lines going back and forth. The
fill can be horizontal or vertical. One or the other will show alternately
and it can be selected the same way for filling the objects.

Vertical Fill
The fill operations have been unique, accurate, and extremely useful to
the users. We have added another option to the fill routines. In addition
to the horizontal fill, a vertical fill routine is added. The end user
interface is intuitive and extremely easy to understand. Observe the
Tool Palette as you launch the application. The saw is the offset tool
and the paint brush is the fill tool. To the right of the paint brush tool,
note a box with red lines in it. The default red lines are horizontal.
Simply click inside the box with red lines and it will change from
horizontal to vertical lines. Whatever the fill pattern you see inside the
box will be the fill pattern used on the next fill command.
An important note: A user can always use a tool of choice to offset any
shape or shapes. When a fill command is issued, MaxMotion deter-
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mines whether a prior offset command was already issued on the
selected shapes. If an offset was already present on the shape,
MaxMotion will respect the offset value, keep it, and simply will go on
to fill the shape with the tool of selection.
On the other hand, if MaxMotion determines that no prior offset
command was issued on the selected shapes, it will apply an offset on
the shape of the same value as fill tool before filling the shape. User is
cautioned to apply small offsets in case of small shapes with narrow
“necks” (an example is a TrueType font like Times Roman) before
filling the shapes.
If more than one shape is selected when the fill tool is used, fill will be
created for all the selected shapes. If you wish to remove the fill from
any shape, hold down the Shift key with the fill tool selected.
Clicking within any shape with fill will now erase fill of any
selected shapes.
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Chapter 9:

Job Design
The job design features will allow you to set job alignment, line
spacing, text alignment, font selection and size in real dimension
(inches or millimeters as opposed to points), usage of standard high
quality fonts (TrueType) without any conversions, automatic spacing of
the lines for the job, importing or inserting of graphics from popular
sources, view paths that the machines may follow, and convert the text
to paths to perform tool offsets and fill operations. To access this menu,
click on “Job Design” or use Alt+J key combination and then click on
appropriate selection.

JOB DESIGN MENU (Alt+J)
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Additionally, MaxMotion will allow you to import text files created in
standard word processors that may either be created by you or your
customers. These text files can become the variable text to create all
types of production with ease and flexibility. Also, these text files can
be imported into a previously created single or a multi-line templates
and sent to the machine without retyping the text.
Let us understand the details of each of the Job Design menu selections:

Font (F2)

Click select Font and a font dialog box shows up on the screen.
MaxMotion is available with a set of fonts including a number of fonts
specifically designed for the engraving industry. These are specially
designed single line and multi-line fonts that engrave in the single
stroke manner for speed and clarity. These fonts are genuine TrueType
fonts, one of the industry standards and native to Microsoft Windows
architecture.
MaxMotion will search through the Windows set up and provide you a
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list of TrueType and PostScript fonts that are available in the system.
MaxMotion is compatible with thousands of desktop publishing fonts
available on the market easily and inexpensively. MaxMotion will use
these fonts in its original design form without any conversion at all.
When you select any of the font from the list and if MaxMotion was
unable to find proper font information, it will warn you to select
another font.
The default value of the height of the capital letter can be set. Change it
to suit your requirement. The size and the kind of font can be changed
as often as necessary. Even every letter in the same line can be different, if required. If there is any one font that you use more often, you are
welcome to set that font as the default font for your jobs.

Auto Condense/expand modes work as follows:
In font dialog, you can set condense/expand mode from amongst (a)
Single Line, (b) Similar Lines, or (c) All Lines.
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The default is Similar Lines. Similar lines are the ones having the same
font, the same font-style, and the same height.
You can also set the width percent (default 100%) of the characters,
which the line will follow, except for the fit justified line.
Due to auto condensing or any other reason if the actual condensation
is different from this set width percent, this condense percent is also
displayed next to the width percent.
If the condense mode is Similar lines, each line in a set of similar lines
has the same width factor.
Likewise, in All Lines mode, all the lines will have the same width
factor.
If you are editing a line, it is equivalent to having selected it.
If no selection is made, this will be general environment setting for
future lines added either by clicking on the plate or with the auto
layout.
However, if the mode is similar lines and the new line is similar to
some existing one, the new line will inherit the width factor from this
existing line and not from general setting.
In any case, if you create a new line by pressing Enter while editing the
bottom-most line, the new line gets width percent along with all the
settings from the previous line.
When the mode is All lines, the width percent in each line as well as the
environment is identical for all the lines.
If the condense/expand mode is changed from the lower to the
higher mode, i.e.
From Single to Similar
From Single to All
From Similar to All
(a) The width factors of the lines are set from the selected line or
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lines or
(b) The width factors of the lines are set from the line the
MaxMotion finds first (usually the first line) in case no line is
selected.
All the lines in case of All Lines selection or similar lines in case of
Similar Lines selection will have the same percent condense or expansion percent. If one line condenses or expands due to addition or
deletion of a character or due to a change in the width factor, appropriate lines will change similarly.
Identical capabilities of width and condense percent are set up in the
Edit Layout dialog box for the user’s convenience.

The feature to control the character spacing works in the following
manner:
In the font dialog box you can edit ‘Extra Space’. 0% means normal
space designed for the font by the font manufacturer, a 100% means
gap equaling an average character space and so on. If text is selected
while entering font dialog, ‘extra space’ will be for the selected text,
otherwise this will be general setting for the new lines. Once a line is
begun, it is not affected by the change in the general setting, each line
can have its own setting. When a setting is changed, it is good for new
text entry only and will not affect the existing text on the screen.
Clicking ‘Select as Default’ button will save this in the .INI file (item
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EXTRA_CHAR_SPACE in section ‘Global Values’) and a new layout
starts with this settings. “Revert to Default’ reads from .INI and writes
in the box. Edit Layout Dialog also enables to set ‘Extra Space’ of a
line.
If entire line is highlighted while doing Ctrl + up (or down) arrow, the
extra space of the line is automatically updated accordingly and is
reflected in dialog boxes. Subsequent characters appended to this line
will respect this setting. When file saved with this version onwards is
opened again, it will remember general as well as individual lines
‘Extra Space’ settings.
Now a text line can be stretched visually just by dragging it, in addition
to changing it from font and edit layout dialogs. If left or right edge of
the selection box around a flat text is dragged, the text stretches along
with it. Font dialog and edit layout dialog reflect this with change in
width percent accordingly. If the line is fit aligned or restricted by
margin or due to other similar lines, it will not stretch.
The feature to create a line at an angle works in the following
manner:

When a line is selected, font dialog shows line angle. This can be
changed to turn the line at an angle. The same can also be done from
edit layout dialog. Font dialog only turns around reference (according
to alignment), without worrying about margin or baseline, but the edit
layout dialog moves the turned text to maintain the specified margin
and baseline. Edges of the selection box of angled text cannot be
dragged to either enlarge or contract the box containing the angled text.
However, the complete box can be moved anywhere on the plate or
outside the plate. Neither an angled text can be turned into arc, nor an
arc can be rotated at an angle.
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The feature to create an arc works in the following manner:

Click and select a text line. Now if you take the cursor near any edge
of the blue selection box, it turns into sizing cursor having doublearrow pointing in opposite directions. Press the left mouse button and
drag the top edge up or the bottom edge down and release the mouse
button to turn the line into an arc. Dragging left or right edge further
modifies the arc. You can drag the arc till it turns a full circle. Once
you drag top edge of a line and make it a rising arc, you cannot drag
bottom edge until you flatten it, and vise a versa.

Arc (line) with fit alignment will fit in available space within the box.
Arc with any other alignment will center in the box, leaving extra space
if any, equally on both sides. With arc having center or fit alignment,
dragging either from left and right edge, automatically moves the other
edge equally in opposite direction to keep its center unmoved. Left
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edge of left aligned arc and right edge or right aligned arc cannot be
dragged.
When an arc is flattened, its width may change to accommodate normal
width or condense percent of flat line.
To help visualizing the arc while dragging, we show constantly
changing red outline of arc within the blue box, until you release the
mouse button, when we replace it with the text. We guarantee this red
arc to be accurate only either if the condense mode is single line or if
there is no other similar line on the layout that affects width factor of
this line or if it has fit alignment. Otherwise the placement and the
trajectory of the arc will be correct, but its length may turn out to be
somewhat different, affected by the condense factors of other lines on
the layout.
Semicircle is a special case, that may be often required, but not being
an end condition, it may be difficult to judge when you reach it while
dragging. For this we provide a small snap while dragging when the
box can hold semicircle. Actually it is a little more than a strict
geometrical semicircle, such that an average character at each end is
horizontal. If you are slowly dragging, you will notice the snap.
Arc makes a lot of demand on system resources. An arc having 15
letters is equivalent to 15 straight lines, as each letter at different angle
means a different font. Windows takes some time creating a font,
Which is why more characters an arc contains, longer it will take
for it to be formed once you stop dragging it or make any changes to it.
For the same reason, Auto layout and edit layout of a layout having arcs
would take longer to complete. Apparently windows has an upper limit
to the number of fonts it can simultaneously hold, so if you keep
creating many big arcs in a layout, eventually windows will fail. After
that you may see all the characters written at the same angle, though
view path would show them properly.
The feature to edit arc or an angled line works in the following
manner:
In text edit mode, if you click on an arc or angled line or anywhere in
the box, an edit text dialog will come up with the content of arc or
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angled line copied to it. After editing click OK or just press Enter to
copy it back to the arc or angled line. Such text can also be edited in
edit layout dialog, which is identical for arc but with a difference for
angled text. When an angled text is edited from edit text dialog, the text
is rewritten with respect to its reference point, thus its side margin as
well as base line may change. Edit layout dialog, however, will
relocate the text according to the margin and baseline specified.
Arcs and angular lines will maintain the same condense percent of font
as with other similar lines as per setting. If you do not want this, you
can either turn condense mode to single line or have font size
marginally different from the rest along with similar lines mode.
We have made sure that a line engulfed by a bigger line (or arc) is
always shown on top and thus easily selected when clicked. To ensure
this after moving lines around, press F4 + Enter to sort the lines again
in proper order.
Auto layout looks at the boxes around line or arc for calculations of line
spacing. If an arc is not stretching till corners, it will seem to have more
gap from next line. If you have placed other smaller line within the arc,
do not Re-layout with F3 + Enter, it will separate them out. Use F4 +
Enter instead using the Edit Layout capability to re-layout the design
without losing your personal preferences.
Auto Layout (F3)
This section will probably be the most used part of the software. Once
you set up the parameters for your machine, you will not be visiting set
up parts of the software except every now and then. However, Auto
Layout feature will be used all the time. Auto Layout is built with many
powerful features that should simplify your job design. Once you
familiarize with the usage, you should be able to design your job within
minutes. When you combine the features of Auto Layout with the
capabilities of saving and retrieving job files and templates, you will be
flying through your customer’s requirements.
The best part is that the job takes shape right in front of your eyes
because of the graphic nature of the Microsoft Windows environment.
There is no guess work and you change it immediately, if you do not
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like it.

Pull down the Job Design menu and click select Auto Layout.
Select the following:
1. Select the plate size by selecting the height and width of the plate.
This can be changed at any time during the process of job design.
2. The user may have an idea of approximate or exact number of lines
that they need to compose the job. Enter the number in the number of
lines box. This number can be changed at any time during the process
of the job design.
3. The default selection of the line heights is in inches or millimeters.
Select the height of each of the lines individually or enter the value of
the height for the first line and click Set All Sizes, if you want all the
lines to be the same height. If you are creating a layout with a number
of lines with the same height but it is different from the default value,
either you need to enter the same value as many times as the number of
lines or you can go to font dialogue, change current size and then, come
back to Auto Layout. Changing current font size will not change the
existing lines. This can be time consuming and annoying. Press the
‘Set All Size’ button and sizes of all the lines will change to the one
shown presently in the size box.
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The alternate selection is in percentages. You can apply relative
percentages for each of the lines and the Autolayout will figure out the
heights of the lines after the user enters all the rest of the information in
the Auto layout box.
4. Select the line alignment. The choices are Left or Center alignment.
These are self explanatory. The Fit is the full left and right justified
lines. The characters will be stretched to fill the line. The Right
justification is a bit unique. When you select Right justification, the text
will be written from right to left. This is convenient for languages like
Hebrew or Arabic. If you wanted right justified English text, enter the
text under either left or center justification and then change the
justification to right.
5. The user can define all the four - top, bottom, left, and right
margins. We offer a cleverly designed feature here. If the user wanted
a one line job, there is no need to enter top and bottom margins to
center the job in the plate. MaxMotion will automatically center the
job from top to bottom based on the height of the capital letters.
6. Line space distribution can be even or factored. The even space
distribution means as follows:
Note the total height of the plate. Subtract the top and bottom margins.
Subtract all the line heights. Divide the remaining space evenly for the
required line spaces.
The factored space distribution means as follows:
Note the total height of the plate. Subtract the top and bottom margins.
Subtract all the line heights. Sum the previous line and the next line
heights and divide it by 2. This number is a relative factor for the space
between the two lines. Similarly, calculate relative factors for all the
other spaces. Now, divide the total available space based on the relative
factor to arrive at the factored spacing between the lines.
7. The engravable area in percentage serves a very important and a
clever function. It is a value that can be changed if the auto layout is
used with the percentage option for the line height. In fact, MaxMotion
is waiting for the value of the engravable area from the operator to
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calculate the actual line heights. However, this value is a grayed out
when actual values in inches or millimeters are used to define the line
heights. Note that even if the engravable area value cannot be changed
by the operator in this case, it changes constantly as the job design
decisions are taking place. It will give a continuous feed back regarding
the usage of the engravable area. If the number goes over 60 percent
while a job is being designed, it will give an indication that the plate
might be too busy and the job design may not be attractive.

Click CREATE after you have selected all the options. MaxMotion
will calculate all the values and create a layout on the screen. At this
point, MaxMotion is ready for your text entry as well as any graphic
insertions for preparing the job.
However, if you just want to change plate size, margin, default justification etc. without creating/reformatting lines, you could do this by
setting lines = 0. Sometimes this is not obvious to user, so next to
‘Create’ we have added ‘Set’ button to do precisely this.
Once the text is entered and the graphics are inserted, the following
changes can be done easily:
1. Add a line at the end of the message or anywhere else in the message. Open the Auto Layout dialog box and click CREATE again to
relayout the job. Everything will be recalculated.
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2. Move line positions at will and create a new order. Open the Auto
Layout dialog box and click CREATE again to relayout the job.
Everything will be recalculated.
3. Drag any part of the job anywhere on the plate for a free form
design, if wanted.
4. Convert to paths, offset, and fill any logo, graphic, or TrueType
fonts.
5. Use Edit Layout to relayout the job line by line.
6. There is one clever design for the single line, small jobs. Anytime
you select a one line in the Auto Layout, the line will be centered
automatically as long as the top and bottom offset values are identical.
7. Use the software in the free layout mode without actually
creating auto layout lines. Simply enter the number of lines as 0 and
click create. You will be in the free layout mode. Click the text tool
inside the design plate and start entering text line by line.
8. Create arcs and slant lines.
The following function keys are assigned to speed up the work for a
power user. Please, note and become familiar with the keys:
F1 - Help
F2 - Font
F3 - Auto Layout
F4 - Edit Layout
F5 - Launch a selected Text Editor and copy the contents of the
MaxMotion screen in it
F6 - Read Text file back to MaxMotion screen, once Saved in the editor
F7 - Insert Graphics
F8 - View Paths (a toggle)
F9 - Convert to Paths
F10 - Import List
F11 - Matrix Settings
F12 - Batch / Matrix Output
Ctrl+R - Edit Material
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Edit Layout (F4)

Edit Layout is one place where you can design your job without pulling
down different commands and menus. Many users are perfectly
comfortable with the traditional engraving software that has been
dominant and mostly available under Microsoft DOS operating system.
We are providing you a capability to be able to work in the similar
fashion here under Edit Layout and edit the job created by either Auto
Layout or free form..
The traditional engraving software expected you to have a good idea of
what the job should look like in your mind. This was necessary because
DOS was not very user friendly and it was difficult to show graphic
under DOS programs. Even if the graphic was displayed, it took a long
time to render the job on the screen. Generally, user worked with the
size of the line in terms of height, limited fonts, baseline position and
alignment.
We have captured the essence of these design concepts in the Edit
Layout for the user to feel comfortable right away and start producing
with the tried and true familiar approach.
Once the user is comfortable, he will venture into the graphical
capability of the MaxMotion software aided by Microsoft Windows
architecture and attempt to create more interesting and potentially
lucrative jobs.
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The initial attempt to design the job in Auto Layout is on the screen.

Now, select Edit Layout and a dialog box will pop up on the screen.
Click on the FIRST and the first line will show up in the line box
“Line 1”. At this point, you can do the following operations,
A.
B.
C.
D.
E.

Change the font used in the line
Change the height of the characters in the line
Change the alignment (left, center, right, or fit)
Change the margins for the selected alignment in real dimensions
Change the actual characters contained in the line (For example,
select the text “Line 1” and overwrite “MaxMotion” and as soon as
you click on the Update button, the line will change.)
F. Select the distance of the baseline of the line from the top of the
plate.
G. Change Line angle
H. Change Character Spacing
I. Change Line Width
After making any and all of the above selections, simply click on the
Update button for the changes to become effective immediately on the
screen. All of the changes will not be effective until the Update button
is clicked. First, Previous, Next, and Last will allow you to move to any
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of the lines on the screen and if there is any text in that line, it will
show up in the text box of the Edit Lines... dialog box. Close will close
the dialog box.
Any line converted to paths or any line containing graphics will be
blank in the Edit menu.
Important Tip: If you want to move line or lines precisely in the
vertical only or horizontal only direction when the design plate is on
the screen, click and grab line or lines, keep the mouse pressed
while holding down the shift key. Now, if you move the mouse,
MaxMotion will sense your initial move and lock that direction
(horizontal or vertical). Now, you may move your mouse randomly but
the lines will move in the locked direction only. This allows you to
preserve your other axis position while you move it in the intended
direction.

Text Editor (F5)
MaxMotion works interactively with a selected text editor for various
functions. Microsoft Windows is made available with a simple text
editor called NotePad. NotePad is extremely simple to use.
MaxMotion also can be set up to work with a specialty editor called
NoteTabPro. Please, check with Solustan sales representative for the
price and the availability of NoteTabPro.
While MaxMotion is open and in the foreground, it will invoke the
editor simply by clicking the function key F5. Once the editor is
launched and is in the foreground, it will inherit the text that was on the
plate on MaxMotion. If there are blank lines in MaxMotion, that is
what you will see in the editor screen.
The text can be edited in the editor. The editor will create a temporary
file named MAX.TXT with the text from the MaxMotion screen.
NotePad can only edit the text. However, the NoteTabPro can edit the
text, check spelling, change case of a character, word, or entire text, can
count the number of characters including the space characters as well as
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other operations. Consult the Appendix D in the manual as well as
online HELP available with the editor NoteTabPro. Consult the
Microsoft documents for functional description of the NotePad provided with the Microsoft Windows operating system.
The possibilities of taking advantage of the linking of the standard
editor along with the MaxMotion application are only limited by the
imagination of the user. A brief list of the possibilities are:
Easy entry of the text
Importing text entered by the customer
Quick spell checking
Character count
List generation
Quick taking of order on the phone
Quick use of templates to compose the job

Read Text File (F6)
If there was a file named MAX.TXT was created and if it is residing in
the same folder where the MaxMotion application is residing, the
MAX.TXT file can be imported into the MaxMotion design screen. The
procedure to import the MAX.TXT file is as follows:
MaxMotion application should be open and in the foreground.
MaxMotion design screen shall be open and in the foreground.
Either a template may be open or simply a blank screen.
Simply click function key F6 and the contents of the MAX.TXT file
will be imported into MaxMotion.
(It is important to note that if a file was created or altered in one of the
editors, it is important to save the file as MAX.TXT before quitting the
editor. If the changes were not saved, it will not show up upon importing the file into MaxMotion. Also, it is important to note that the
clicking of the function key F6 shall be exercised and will work
properly when the MaxMotion application is in the foreground.)
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Convert To Braille (Ctrl+B)
Braille alphabet was designed for the blind people to be able to read
with their fingers. The original specification was created with a
combination of dots for each of the characters in the English alphabet
and the numbers. This was called Grade I Braille. Subsequently, the
specification was revised and is called Grade II Braille. One way to
think of the newer specification is like a short hand version of the
original specification. Many of the commonly occurring combination of
letters were assigned different combination of dots (some of the simple
examples are ‘ing’, ‘en’, ‘the’, ‘ch’, ‘sh’, ‘and’, etc.).

The Convert To Braille command will convert standard English phrases
and words to comply with Grade II Braille specification. Instead using
another third party software, the user can complete the conversion right
within the MaxMotion software. An exception dictionary is provided
for the words that do not fall into standard rules of the conversion.
Insert Graphics (F7)
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There are three ways to bring the graphics, logos, and clip arts into
MaxMotion for engraving.
(1) One is to go into File menu and select Open. If a file is saved
previously in the MaxMotion native format and if it includes graphics,
the action brings in graphics as graphics.
(2) If the graphic was created in other programs like Corel on PC or
Illustrator on Macintosh and if it is available in PostScript or DXF
formats, it will be imported in its original size, it will be centered to the
plate, and each shape in the graphic will be an individual unit and to
move them together, you need to select them all carefully. This graphics
can be scaled. You can apply tool offsets as well as fill routines.
(3) However, Insert Graphics is third way to bring in the clip arts that
can be aligned with text and composed. The inserted graphic is treated
as one complete unit or one complete line. You can grab the clip art
with the arrow tool and move it as one complete unit.
Note the important distinction between import and insert graphics.
Imported graphic will always be positioned at the center of the plate
and will keep its original dimensions. Inserted graphic will be positioned at the intended line and will be scaled to the selected line height.
View Paths (F8)
View paths allows you to unfill the text characters and observe the
paths that the machine will follow without converting the text to the
paths. This flexibility allows you to view paths but at the same time
preserve the job as text so that it can be saved and later on can be edited
easily where the functions such as font change, size, alignment, and
kerning can be applied.

Text

View
Paths
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In order to view paths, pull down the Job Design menu and select View
Paths. All the text will be unfilled and outlines will be shown.
If ‘View Paths’ is on, the new blank lines created by auto layout are not
visible, since the empty line box is not visible in this mode. However,
if auto layout creates new lines, it is ensured that the empty line boxes
are visible, by switching ‘View Paths’ off.

Convert to Paths (F9)
A job created with text and graphics can be stored as you see on the
screen and can be sent to the engraving machine at will. For simple
jobs or jobs involving special single or multi-line engraving fonts there
is no need to convert the text or graphics to paths. MaxMotion will do
that in the background while sending job to the machine. Just viewing
the paths as described above may be sufficient for your needs.
However, if you are using any fancy TrueType or PostScript fonts and
you need to apply tool offsets and fill the characters or graphics with a
particular tool size in order to remove the top material or a two ply
material, you need to convert to paths. To use this command, select all
or some of the text boxes in your layout, then choose Convert to Paths
under the job design menu. These outlines can now be offset and filled
with proper size tools.
Once the text is converted to paths, it is not text anymore. You cannot
edit the paths as text. You cannot change fonts, size, alignment, or
kerning. It simply becomes shapes and curves.
However, now you can flip, rotate, and scale proportionally or nonproportionally as any other graphic object.
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Import List (F10)

This is an important part of the job design. It can be used in the
following different ways,
(1) Your customer submits a list in the form of a word processing file
and asks you to engrave them to create name tags.
(2) Each of the name tags has a few same lines such as name of the
company, company logo and a few lines that change from tag to tag
such as name, title, etc.
(3) You want to enter text for different jobs and check for spelling in
your favorite word processor.
(4) You want serial numbers in a particular sequence and you have
created them in a text file.
(5) You want to use the serial number file that we have provided with
MaxMotion.
In all of the above cases, make sure that you have created or saved as
simple text files. You can save these files anywhere within Windows
structure or you may want to save under a file created specifically for a
customer or you may want to save under MaxMotion subdirectory.
Once the file is saved it is available for the Import List Management.
Explore the flexibility of this feature and you will find that you can use
it in many different ways. Here is one of the ways,
Let us assume that you have a four line job with the first and third lines
are the variable line where information to be engraved is changing. The
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lines 2 and 4 are fixed. The screen looks as follows:

Prepare the job just the way you want it with proper font, size, and
placing on the plate. Now, shift select lines one and three. MaxMotion
knows that the selected lines are the variable text. Select Import List...
from Job Design menu. List management dialog box will pop up on the
screen. Notice that you can move the box around so that it does not
obstruct your view of the job.

Click on the Get Name button and the Files dialog box shows up. Find
your file in the standard Windows fashion. Select it and click OK. Now,
you will see the file name in the file box with its proper path. If you
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click Open button at this point, MaxMotion will launch standard
Windows accessory called Note Pad or the editor NoteTabPro and will
show the selected text file. You can make changes and corrections at
this point, if desired. Once you are satisfied that is the file you are
interested in, pull down the File menu and Exit the editor in use.

If you click the New button, MaxMotion will open the same Note Pad
accessory or the editor NoteTabPro with a blank page. You can create a
text list at this point for your engraving job and save it for later use.
Every line of the text shall end with a carriage return (depressing Enter
or Return key will do the trick). MaxMotion uses carriage return
character to define the end of a line. As soon as you click on First,
MaxMotion will look into the selected file, find the first line and paste
it in place of Line One and find second line and paste it in place of Line
Three. The font, size, and justification will be preserved. If everything
looks OK, this job is ready to go to the engraving machine.
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The Next button will replace the current Line One and Line Three with
the next two lines on the list. The Previous button will bring in the
previous two lines.
The variable text lines can be one or many in a job and it depends upon
the selection of lines as well as the sequence in which you select the
lines.
The Close button will close the Import List dialog box.

Matrix Settings (F11)
Once you import a list of the variable parameters, you may want to
create either a batch output or matrix output. The concept goes something like this:
A number of jobs are to be prepared for a customer. All the jobs are
similar in size and looks. A part of the job is the same in every case
such as, logo and name of the company. However, the other part of the
job is variable such as, names and titles of office holders.
In the batch mode, the individual physical plate sizes are cut and
prepared ahead of time. In this case, the size of the plate and the size of
the material should be declared as the same. As a result, the software
will process one plate at a time and wait for the operator to click the
SEND key in the Batch/Matrix output mode or depress the RETURN
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key on the keyboard. The operator will replace the engraved stock with
the fresh plate in the same place on the table and will proceed to the
next batch job simply by clicking the SEND key or by depressing the
RETURN key.
In the Matrix mode, the material size declared to MaxMotion will be
larger than the plate size. MaxMotion will calculate the most efficient
way to get maximum yield from the material size. If more than one
piece of material is required to complete the total number of plates,
MaxMotion will engrave one complete material with proper scoring
and will wait for the operator to replace the engraved material with new
material. When the operator clicks the SEND key again, MaxMotion
will proceed to finish the rest of the job.
Here is the procedure to follow:
1. Either open a previously saved template proper for the job or create
an appropriate job with plate size and design. (Refer to the IMPORT
LIST description in this chapter.)
2. Select IMPORT LIST and select a list that you wish to engrave in
the batch/matrix form.
3. Check the list by opening the file, if necessary.
4. Verify the number of variable lines that are required. Click and
select only the variable lines. The variable lines will be bound by blue
rectangle boxes. The remaining lines will stay constant throughout the
batch/matrix job.
5. Click on the FIRST in the IMPORT LIST dialog box. The title of the
dialog box is LIST MANAGEMENT. You will observe that the
variable lines will be replaced with the first set of lines from the ASCII
list.
6. Go to the JOB DESIGN pull down menu and select Matrix Settings.
Matrix Preference Settings dialog box will show up.
7. Make all the necessary selections.
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■ Material size will be same as plate size for batch output.
■ Material size will be larger than plate size for matrix output.
■ Decide whether you want to engrave in the column or row format.
■ MaxMotion will automatically condense the line that exceeds the
available width. The operator selects whether the characters are
condensed proportionally (heights and width both) or are condensed
along the width while keeping the same height. The operator will
choose the left and right margins allowed for the plate.
■ Elaborate scoring capabilities are provided. The operator may choose
no scoring to partial scoring to complete scoring. Partial scoring will be
done in the four corners only for the desired length.
■ Scoring depth can be different than the engraving of the job and can
be called out separately.
MaxMotion will first complete the job of engraving, including all the
plates for the material. It will pause at this point for tool change,
adjustment, and depth adjustment, if necessary. Operator will click the
SEND key again for scoring operation to start.
In Batch/Matrix output, Esc also halts the operation after PAUSE, the
only difference being Esc goes to the beginning of the unfinished job
before stopping.
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■ Save the Matrix Preference Settings.
Batch/Matrix Output (F12)
8. Go to the JOB DESIGN pull down menu and select Batch/Matrix
Output. Batch/Matrix Output dialog box will show up.

9. All the previously selected parameters show up. If it is a Batch
operation, click select the box material size same as the Plate and you
are ready to set one plate job at a time. The only other choice need to be
made is the starting point of the job.
10. Click SEND or depress RETURN key after replacing the engraved
plate with a new plate in the same place on the table. The current plate
count will be updated by the MaxMotion every time. Scoring operation
will not be necessary in the batch mode.
11. Do not click select the box material size same as plate size, if it is a
Matrix operation. Select the starting point of the job and MaxMotion
will engrave as many plates as it can fit on the given size of the
material. It will pause for the scoring operation. At the end of scoring
the material, MaxMotion will pause again and will be ready for further
operation on the new material, if there are still plates to be engraved to
complete the job. It will position the pointer of the job to the next
variable job. The operator will only require to click the SEND key
when ready.
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Serialization Setup
Serialization function is very useful and very flexible. Please, read this
detailed description carefully, along with running this feature in the
application, the two combined should answers most of the questions.
This is how serialization is organized: You can have multiple lines of
serialization. Each line can have multiple fields. Each of these fields
can be of different type, from amongst: Constant, Numeric, Letters,
Alphanumeric, Date, Time and Shift. This way you can define an
incrementing number and date on a same line, separated by a constant
field containing a couple of spaces.
Following is the understanding of each field:
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CONSTANT field:
The text defined here remains unchanged throughout serialization.
NUMERIC field:
Contains integer value. The left of the number can be padded with
LETTERS field:
Made up of letters, either capital A through Z or lower case a through z
and back to A or a.
ALPHANUMERIC field:
Made up of numbers and letters, zero through 9, continues with A
through Z, and then back to zero.
Letters and Alphanumeric fields follow the same rules while
incrementing, in a similar fashion like decimal values. Only when the
last character changes from Z to A or 0, the character before increments
and so on. If any character, not recognized by these fields, is included,
it will be treated as a constant part and incrementing will be passed on
to the next legal character. This will allow you to have space, comma,
brackets and other such characters as constant part of these fields.
Numeric, Letters and Alphanumeric, all incrementing fields, let you set
initial as well as increment value. You can also specify how often to
increment, in other words, once incremented, the value remains same
for next so many output frames. You can define one of these fields
determining termination and supply terminal value. Serialization will
terminate when the value of this field moves beyond the terminal value.
You can have at the most one terminating field, defining second one
automatically undefines first one.
DATE field:
Reads system date at the time of output and places it in specified
format. You can have more than one date fields having different
formats in a single line.
Date Format can be one of the following:
DD/MM/YYYY, MM/DD/YYYY, MM/YYYY, DD/MM/YY,
MM/DD/YY, MM/YY, DD/MM/Y, MM/DD/Y, MM/Y.
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Date Separator can be chosen from amongst Slash, Dash, Space, or
Period.
One of the following Month Formats can be selected:
Digits: Two digit month, e.g. 01
Short Spelling: First three letters of month, e.g. JAN
Long Spelling: Complete spelling of month, e.g. JANUARY
TIME Field:
Reads time from system clock at the output time and places it in
specified format. Time Format can be either HH:MM or HH:MM:SS.
You can also specify either 24 hours or 12 hours Time Cycle. 12 hours
Cycle will append AM or PM to time.
SHIFT Field:
Writes code of the shift running at the time of output. Nothing is to be
specified here. Shift code and timings are expected to have been set
amongst general settings.
Now let us see how to do the serialization settings. Click 'Serialization
Setup' in Job Design menu.
On the dialog box, by clicking button 'Shift Code & Others', you can do
one time general setting for the installation. You supply # of shifts at
that production unit, starting time and output code for each shift. A
Shift field outputs this code, if the current time is between starting time
of the same shift and that of the next shift. Also by checking 'Save Log'
you get each serial output saved to file Serial.log in same directory as
EXE. At the time of next serial output, the set of output lines are
appended to the same log file. This would help them keep record of the
manufactured items that have passed through that point, also it helps us
debugging without actually driving machine. These are usually one
time settings, normally you do not need to keep changing them, and are
not affected by resetting serialization.
Clicking 'Change Password' button on main dialog enables you to set
new password. Next time you will be allowed to enter 'Serialization
Setup' only if you supply this correct password. If you set the password
blank, no password is asked for entry to dialog. Normally the serialization setting will be done once by supervisor, and the operator will keep
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sending automated output. The password ensures that the operator does
not manipulate Serialization Setup to output unauthorized marking inbetween. If he has a genuine problem like one frame not output
properly and wanting to repeat the same frame, he will have to call the
supervisor to set things right from Serialization Setup. The log file
mentioned above will be witness to this repeat output and can be
verified with the supervisor later.
To setup serialization, on the main dialog, you supply total lines and
select current line. Next you specify total fields in this line and select
current field. As you choose Type of the field, you are enabled to
supply relevant information for that Field Type, as explained above.
This way you set up each field of each line. You can 'Insert' a field at
current field selection. Also you can 'Delete' (Remove) as well as
'Reset' current field. Similarly you can 'Insert', 'Delete' or 'Reset' a line.
You can start defining new serialization by doing 'Reset Serial'.
Once you save the setup, and then again open serialization dialog, you
will notice that Numeric, Letters and Alphanumeric fields display
Current Value of the field, stating for how many frames it will remain
same. If no output has been sent after defining serialization, the
Current value will be same as Initial value, otherwise after every frame
of output, it will have incremented according to the field definition.
You can 'Move Back' the serialization (all its fields) by specified # of
frames. This means you move in the reverse direction of definition, in
other words, decrement instead of incrementing the field value. If one
of the frames, while outputting is messed up and you want to repeat it,
this is not possible in the normal course, since the automated serialization would have moved on to next frame. The way out is, 'Move Back'
(default) one frame from within the dialog. The Current Values of the
incrementing fields will confirm this by reverting to last frame values.
You can move forward if you wish, by 'Moving Back' negative # of
frames, though I do not foresee any practical use of this.
Even after serial output has started and current values of fields have
began incrementing, you can modify the field and the subsequent
output will be done accordingly. Only exception is the Initial Value.
Once you see the Current Value displayed, the Initial value is not
referred at all, so changing it will not make any difference. If you want
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to start with a new Initial value midway, you must 'Reset' that field first
and then define it again.
During serialized output, each serial line is constructed by placing
values of its fields side by side. Each of these serial lines overwrite
layout lines, in the order top to bottom. These layout lines receiving
serial values can be straight line, inclined line or arc. If there are more
serial lines than layout lines, the extra serial lines are ignored. If there
are fewer serial lines than layout lines, the layout lines towards the
bottom remain unchanged. This matching of serial lines and layout
lines is done only at the output time. While defining the serialization,
the serial lines have nothing to do with the lines present on the job
layout.
Serialized output is managed through Batch/Matrix output dialog. On
upper right corner of dialog, you select 'Serialized' Text Type.
MaxMark has Material Size 'Same as Plate' by default. Normally you
would want 'Same as Plate' for marking, but you can have multiple
plate matrix if you wish. As you click 'Send', it will output and
increment the serial values. The operator is required only to keep
pressing 'Send' as soon as ready. If the serial terminates, the dialog
disappears. Attempt to output either terminated or undefined serial,
will display error message.
MaxMark does not have Final Screen available for Serialized Machine
output. It can output serialization only through Batch/Matrix. This is
to prevent the operator from doing unauthorized marking. If he has
messed up one frame of output, he will have to call the supervisor, to
get one frame retracted through Serialization Setup dialog, requiring
password.

Refresh Screen (Ctrl+E)
MaxMotion uses the power of Windows extensively in order to design
a very friendly application. Many floating menus, Windows NotePad
come and go off the screen as the user exercises various features. Many
times the screen may not be refreshed properly to show the content
completely. The designers of the MaxMotion application can update the
screen continuously to avoid such incomplete looking screens. How-
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ever, these things happen only rarely and continuous updating of the
screen is very disconcerting to the eyes. This is why we provide a
Refresh Screen command under the Job Design pull down menu. Either
you can click on this command with the help of your mouse or you can
use your keyboard command to update the screen. It is equally simple
to use the keyboard.
Hold down the Ctrl key while depressing “e” key and the screen
will be refreshed.
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GENERAL RULES OF TEXT ENTRY:
The text entry features are designed to be as close to a general purpose
word processor and also as close to Microsoft Windows generally
accepted norms. If you are familiar with Windows operations, you will
spend little time becoming familiar with MaxMotion’s text entry
features.
What is so special is that we have blended the easy to use features of
Windows and the most desirable functions that an engraver is looking
for. This helps the user to create the job quickly while taking advantage
of the graphic features of Windows.
The text entry part is designed cleverly. A line of text entered previously can be edited for possible corrections and additions. Select any
text on the screen at any time with text tool or click inside any text line.
The text cursor will automatically align itself to the nearest text
character. Now, you can use the four arrow keys on your keyboard or
mouse to move the text cursor to the appropriate place for editing. The
editing may involve inserting or deleting text, inserting or deleting
spaces, changing fonts, sizes, etc.
Delete key will delete a character following a cursor position. Back
Space key will delete a character preceding a cursor position. Home
key will bring the cursor to the beginning of the present line while End
key will bring the key to the end of the present line.
Please, take the following special care to insert a line. Let us say that
you have four lines entered on the screen. Now, you want to insert a
line between the first and the second line. Place your cursor anywhere
on the first line. Be careful not to create a new line (indicated by a box
on top of the existing line of characters). If you clicked properly, the
cursor will appear aligned to the nearest character in the first line. Now,
depress the Shift key and while holding it down, depress the Enter or
Return key. This action will insert a new line while moving lines 2, 3,
and 4 further down on the plate. If you do not hold down the Shift key,
you will simply move to the next line on the plate.
MaxMotion uses standard TruType and PostScript fonts but gives you
the capability to select the height in inches or millimeters as opposed to
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points and picas that they use in publishing and printing business.
MaxMotion provides you specialty engraving fonts such that it makes
no difference to you whether you are using one of the single line
engraving fonts or a TruType font that you acquired from a reputable
font foundry. You do not load the fonts separately for MaxMotion. All
the loaded fonts are the property of Windows architecture and all the
fonts are available to any other Windows program as well as
MaxMotion.
Normal text entry is black characters. Selected text or graphic boxes are
blue. Tool offsets and fills are red. Select and engrave feature is quite
unique. If you want to select only a part of any job to be engraved,
simply select that part of the job and you will see that the final screen
will show the entire job in two different colors. The rest of the job will
be black while the selected part will be blue.
The text can be selected as one of the two different ways. One is with
the arrow pointer and you will be able to select the whole line with one
click anywhere inside the line. The selected line will be bound by a
blue line. The other way to select the text is with text cursor. The
selected characters will be shown as inverted blocks, black space with
white character. You should be careful and keep your text cursor close
to the character or on top of the character in order to select the intended
characters. Bring the cursor close to character, click the cursor and hold
it down while dragging it. You will see the characters being selected.
There are two ways to change font characteristics. The fonts and size
can be changed just prior to entering the text by making necessary
changes or select the entered text with text tool and then make the
necessary changes.
If you depress Enter or Return key at the end of a text line, MaxMotion
will automatically create a new line showing a box on the screen. The
position and font value of the new line will depend upon the selections
made in the Auto Layout dialog box. The box on the screen indicating a
creation of a new line will vanish when you enter the text. The box will
be left there if the line was created simply for the spacing purposes.
The box is never sent out to the engraving machine. MaxMotion will
respect and calculate with all the lines created by the user.
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If you prefer to create a free form design, you have total freedom to
move any object anywhere on the plate you desire until your creative
talent is satisfied.
KERNING:
MaxMotion offers wonderful kerning capability. We like to call it
kerning pairs and continuous kerning. If the available fonts (TrueType
and PostScript) are built with kerning pairs and most high quality fonts
are, we will automatically use the pairs to improve the looks and
position of the text. For example, A and W side by side will not look far
apart. We provide you a total control over the character spacing with
the greatest of ease. This will allow you to fit your text in a designated
area or line space. Let us take two examples.
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(1) You have a word MaxMotion on the screen and you want to
increase or decrease the space between the two characters x and M.
Simply place the text cursor between the two intended characters. Now,
hold down the CTRL key while using the up arrow or the down arrow
keys. The up arrow key will increase the spacing and the down arrow
key will reduce the spacing. This action will take place interactively
and continuously if you continue to hold the arrow key down while the
other two keys are depressed.

(2) You have a word MaxMotion on the screen and you want to
increase or decrease the space between all the characters at the same
time. Simply select the whole word with a text cursor. Now, hold down
the CTRL key while using the up arrow or the down arrow keys. The
up arrow key will increase the spacing and the down arrow key will
reduce the spacing. This action will take place interactively and
continuously if you continue to hold the arrow key down while the
other two keys are depressed. The concept is the same for a word or a
complete line.
(3) Stationary Template feature is extremely useful. You select any
shape and click ‘Change View-only’ in Graphics pull down menu. This
will turn it into view-only template, shown in green. Now you will not
be able to normally select it and therefore move or delete it by mistake.
It will not be sent to output, but will be shown on the output dialog
screen or print out.
There may be times when you do want to select and engrave this viewonly shape. You can do this by depressing Ctrl key while clicking on or
inside it. For multiple selection, you press Ctrl + Shift, and/or box
selection with rectangle too should be accompanied by Ctrl. ‘Change
View-only’ is a toggle switch, and will turn a selected template back to
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a normal shape. If you have some shapes and some templates selected
while invoking this command, view-only status of each will reverse
simultaneously.
A simple use of this feature is to create a number of templates with
desirable borders. These borders will not bother the user while laying
out a plate design. It will be stationery and will not move. The border
can be turned into active part of a job just before sending the job for
engraving.
(4) All the information regarding the job design and Auto Layout is
saved in the file including margins, fonts, size of lines, spacing,
condense factor, etc. This is an ideal situation for creating and saving
templates to simplify job creations. These are the templates such as
regularly used 2 line, 3 line, 4 line jobs with standard selections of fonts
and with the most popular sizes of the plate designs. You can use your
imagination to simplify your tasks.
(5) MaxMotion offers another entity, dot, that can be used for drilling
purpose. In frame (rectangle selection in the Tools menu) mode, click
and release the mouse button without dragging. If your hand is not
steady enough, press Shift key while clicking to avoid dragging. This
will make a dot. Since this single point is difficult to see, we create a
circle around it with a cross hair cursor. This circle is not an entity, and
remains of same size at any zoom value. When sent to output, the dot
should drill hole at its location, but its outer circle does not go to
output, though on output screen as well as on print out, you will see
proportionate circle accompanying the dot.
You can select a dot by clicking within the Bull’s eye. However, for
box selection, the circle is disregarded, only the dot is considered.
A single open line could be selected by clicking near it. This nearness
was arbitrarily hardcoded as 45 pixels. It has been reduced it to the
bull’s eye radius. This nearness selection is extended to any shape
having width or height zero.
CAD programs can create dot patterns, the DXF files generated by
them, are read by MaxMotion. For drilling of PCB boards, an example
of a kind of an application, the circuit diagrams may have already been

MaxMotion for Machines

Chapter 9-163

made in a CAD program. The MaxMotion’s DXF filter is upgraded to
ensure that POINT entity and zero length LINE from AutoCAD is read
as Dots in MaxMotion. Similarly zero length line from Corel Draw is
imported through .AI, as a Dot too.
(6) Now you can use an external text editor, NoteTabPro to edit (and
do other fancy things) the layout. The name and path of this editor can
be specified in item ‘TextEditorPath’ in section ‘GlobalValues’ of .INI
file. If the editor is in Windows or program directory or any other
directory in windows search-path, only editor name will suffice,
otherwise full path must be specified. Within the path, program
directory can be indicated by $MaxMotion$, e.g.
‘TextEditorPath=$MaxMotion$\editor\NoteTab.EXE’.
By clicking ‘Text Editor’ (F5) in Job Design pull down menu, this
editor is invoked showing all the job text. Make required changes and
save it (within the editor). Now get back to MaxMotion and then click
‘Read Textfile’ (F6). The contents of this saved file are copied back to
the layout, changing contents of line but not height or font selections.
If the text-file had more lines than the layout, the additional ones are
appended at the end. If it had fewer lines, the extra lines at the bottom
of the layout are deleted. A blank return in editor is matched with a
blank line on layout.
This is how it works. When you click ‘Text Editor’, the lines on job
layout are copied to a text file MAX.TXT in program directory, and the
editor opens this file. You should have entry
‘EditTextFileName=MAX.TXT’ in ‘GlobalValues’ section of .INI file,
which can be changed to specify a different name for this text file.
When you ‘Read Textfile’, MAX.TXT is read into the layout. The user
can himself writes MAX.TXT and ‘Read Textfile’ in a template to
generate a layout (omitting ‘Text Editor’ command, which would have
over-written MAX.TXT). The read mechanism is smart enough to
recognize line-break consisting of either CR + LF or just CR or just LF,
this covers Macintosh generated text files too. Once the editor is
running, MaxMotion does not have any control over it, so it has to be
terminated finally by the user.
(7) Now you can store textual comments along with the layout.
Clicking ‘Write Comments’ in File pull down menu brings up the same
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external editor that above ‘Text Editor’ feature uses. You write
comments and save it (within the editor), next time when you click
‘Write Comments’ while in the same layout, the same comments will
appear.
This is how it works. You have a template comment file
Comment.TXT in program directory, which is a normal text file and the
user can customize it for his own needs. You should have entry
‘BlankCommentFile=Comment.TXT’ in ‘GlobalValues’ section of .INI
file, which can be changed to specify a different name for this template
file.
When you first time click ‘Write Comments’ in a layout
<ABCD>.MAX, this template file is copied to <ABCD>.CMT in same
directory and the editor opens it. Thus next time the file is identified by
common primary name and opened automatically from the corresponding layout. When you ‘Save as’ a layout, along with .MAX, .CMT is
also copied to new name, if present. Similarly when an ‘Untitled’
layout is saved for the first time, a temporary file storing its comments,
is also copied to the same new name with .CMT extension.
(8) English to Grade 2 Braille conversion is implemented in
MaxMotion. Just select one or more lines on layout and click ‘Convert
to Braille’ in Job Design pull down menu. This will convert the line to
braille and will also change its font to default braille font. The braille
font name should be specified in item ‘BrailleFontName’ in section
‘GlobalValues’ of .INI file. If this is not found or it is a blank entry, the
font of the line will not change and you will have to go in font dialog or
edit dialog to change font of this line to one of the braille fonts.
The feature does not recognize following punctuation and composition
signs: accent sign, italic sign, termination sign, asterisk, ellipsis and
single quotation mark. (Character ‘*’ is taken as multiplication sign.)
Any unrecognized character is ignored.
This option is available for purchase. It includes Grade 2 Braille
conversion as part of the MaxMotion, templates, and two different
Braille fonts.
Whenever you notice a feature that is working under a demo version of

MaxMotion for Machines

Chapter 9-165

the software. (Remove the software dongle from your system and
launch the MaxMotion software. You will find that the software is in
the demo mode and will allow the user to explore all the options. Some
features are included with the basic price of the system. Others are
required to be purchased. Please, contact Solustan for further clarification.
(9) While in Edit mode, up and down arrow can take you to previous
or next line. If the lines are moved around, the up and down arrow may
move the cursor unpredictably. The job requires sorting of the lines
again. The lines will be sorted any time you open Auto Layout or Edit
Layout dialog box. Either a combination of F3 + ‘ENTER’ or F4 +
‘ENTER’ will resort the new order of lines. Remember that F3 +
‘ENTER’ combination may do other formatting which may or may not
be a problem.
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Chapter 10:

Materials Menu
The Material Menu contains different type of materials, each set up
with its own default values for your routing file. These values can be
changed and customized to meet different requirements. To access this
menu, click on “Material” or use ALT + M key combination and then
click on the appropriate selection.

MATERIALS MENU (Alt+M)

Edit Material (Ctrl+R)
When selected the edit material box will appear for the selected
material in the pull down menu against which a check mark appears.
Here is where you can customize by changing the default values for
that material.
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Every time a job is brought to the Machine or Plot screen, the values set
in the materials menu for the selected material will show up in the final
Machine/Plot screen. These defaults can also be changed in the final
screen. However, the changes in the final screen will be temporary and
will be applicable only for that job. Changes applied in the material
menu and saved will be permanent.
Material Name
Shows currently selected material name. Under the material menu the
check mark next to the material name shows the currently selected
material.
Tool Speed
Both the engrave/rout speed as well as the Z feed speed can be set
here separately. Tool speed is the overall speed at which the engraving/
routing takes place. Z feed speed is the speed at which the cutter tool
comes down and enters the material. You will notice that the Z feed
speed for metals is much slower than for plastics. This will save you
from breaking cutters from entering metals too fast.
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Move speed is also set here. Move speed is the speed at which the tool
is traversing up in the air (not in the material) to get to the next
destination.
Z Feed Up is the speed at which Z axis (the cutter tool) goes back up.
The jog speed is the speed at which the machine will jog when you
move it from control pad.
The in/min. Max Initial is the starting speed that can be achieved by the
combination of the stepper motors and matching amplifiers without
applying any acceleration.
Cutter Info
Depth, Lift, and Dwell parameters can be set here. Depth is the
deepness of routing or engraving from the reference surface. Lift is the
amount the cutter tool lifts between shapes from the reference surface.
Dwell:
The above is true when you have a motor in the Z axis. There are many
machines MaxMotion controls that have air pressure for the Z axis as
opposed to a motorized Z-axis. In this case, the cutter depth and the lift
values will be ignored. Also, the Z feed and the Z feed up values will
also be ignored. The Dwell value under cutter shall be set up to allow
the air pressure to build up sufficiently and move the cutter down on
the material before moving the tool in X and Y directions.
Multiple Pass:
The multiple pass capability is offered to reach a desired depth in more
than one pass. Observe that there is an additional box in the Materials
menu. The box is labeled Maximum Depth per pass. The box is situated
under the Depth box. A maximum desirable depth can be called out in
the Depth box. There is no change in that feature. However, you have
two choices in the Max Depth Per Pass box. If you declare 0 (zero) as
the value in this box, the software will try to drive the table and the Z
axis to achieve the total depth in a single pass. If a value less than the
total desired depth value is declared in the Max Depth per Pass box, the
software will try the depth per pass for each of the passes until it
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reaches the maximum depth called out in the depth box. The last pass
may have a depth value less than the maximum depth per pass.
If, for example, the total depth required is 0.013 and if the depth per
pass is declared to be 0.005, the software will execute three passes
(multiple passes) of depths 0.005, 0.005, and 0.003 to get to the desired
depth. These values can be declared separately for each of the
materials. The DepthPerPass=0 is a special case, where entire depth
will be cut in a single pass.
The final or the machining screen is also organized to show the total
number of passes required to complete the job as well as the number of
the current pass at work. Additionally, the operator can decide to pause
at the end of each pass.
Batch/Matrix operations ignore the DepthPerPass command. It will
always cut the full depth in a single pass.
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Chapter 11:

Settings Menu
The Settings Menu contains the commands for creating offsets and fills
for your routing files. To access these commands and more, click on
“Settings” or use ALT + S key combination and then click on the
appropriate command.

SETTINGS MENU (Alt+S)
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Offset
The Offset command is used to compensate for the cutter diameter. By
offsetting your contours you will maintain their exact size after it is cut.
To use the tool, first select the contours you wish to offset, then under
the settings menu select offset. Choose the cutter diameter. As you
click on the value of the tool diameter, watch the arrow tool change
to a saw tool. MaxMotion anticipates your next move and changes
the tool to be ready to offset. Now, all you need to do is to click with
the saw tool inside any one of the selected shapes and all the
selected shapes will be offset. The application provides you a visual
feedback while the contours are being worked on. You may visually
turn off the offset by clicking on the box to the right of the offset tool in
the tool box.
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Fill or Pocketing
The fill command is used to create the route paths for your cutter tool.
It is primarily used for engraving. To use the tool, first select the
contours you wish to fill, then under the settings menu select fill.
Choose the cutter diameter. As you click on the value of the tool
diameter, watch the arrow tool change to a paint brush tool.
MaxMotion anticipates your next move and changes the tool to be
ready to fill. Now, all you need to do is to click with the paint brush
tool inside any one of the selected shapes and all the selected shapes
will be filled. The application provides you a visual feedback while the
contours are being worked on. You may visually turn off the fill by
clicking on the box to the right of the fill tool in the tool box.
If you need to apply offset and fill, offset shall be applied first and then
fill shall be applied.
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Default Settings
Default settings allow you to set up many of the settings that you may
need to set up only once and may not need to change too often.
You can set up the unit of dimensions as inches, centimeters, or
millimeters.
You can set up the unit of time as seconds or minutes.
You can set up the unit of tool size as inches, or millimeters.
You can set up the default tool size for offset, fill (or pocketing), and
for the “other” tool size.
Many times operators like to call out the same tool size for the sake of
speed and simplicity of routing operation. However, you can request a
larger diameter tool for fill paths to clean out the shape from inside
while a regular diameter tool for finishing outline edges. You end up
changing the tool but you may gain speed and accuracy. The default
settings are simply recommendations. Actual cutter size should be
determined by the size of your design elements.
It was always possible in MaxMotion to select a shape or shift + select
a bunch of shapes and drag them with the pointer tool to anywhere you
want on the plate or outside the plate. (It is important to note that any
shape outside the plate will not be processed when the job is sent to the
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machine. Even if only a part of a shape is outside the plate, the whole
shape will not be processed when the job is sent to the machine.)
It was always possible in MaxMotion to select a line of text or shift +
select a bunch of lines and drag them with the pointer tool to anywhere
you want on the plate or outside the plate with the help of the pointer
tool.
Now, it is possible to select shapes or text and move them (Nudge
them) in the horizontal or vertical direction at a precise distance. Note
the addition of nudge value in the Tool Palette. Use the four arrow keys
(not the accounting keypad) to nudge the selected part of a job in the
direction of your choice. It will move the selected part of a job to the
declared distance for every click on the arrow key.
The nudging distance for every click can be changed and adjusted in
the Default Settings of the Settings pull down menu.
Design Plate Size
Plate size can be easily changed in Auto Layout under job design menu.
However, you can change it from here too.
Bitmap Settings
This is an optional item for MaxMotion software. It is not recommended to use with Windows 3.1. It works well with Windows 95 and
higher. Keep in mind that it does take a lot of memory to use this
feature. The Bitmap Setting Dialog box displays the number of pixels
and lines (horizontal and vertical dots), as well as their resolution in
dots/inch and the image size. Users can edit the resolution and the
image width and height will change accordingly. Some bitmaps come
without specifying their resolution. We assume them to have 96 dots/
inch by default. Bits/Pixel (type of bitmap) is displayed for information.
‘Max Depth’ is the depth at which black pixel will be engraved. The
depth for other colors will be between this max depth and the surface.
This gradation of depth for different colors will take place only if ‘3D
output of Bitmap’ is checked, otherwise bitmap is turned into mono-
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chrome during the output. The depth of bitmap can also be changed
from ‘Change Depth’ dialog under Graphics Menu.

‘3D Output of Bitmap’ is not to be confused with ‘3D Output’ on the
final machine screen as well as Batch/Matrix dialog. 2D output with 2D
bitmap will flatten everything including the bitmap at the general depth
set in the material dialog. While 3D output with 2D bitmap means, in
otherwise 3D output, the bitmap is engraved flat, but having its own
maximum depth. User never wants general 2D output with 3D bitmap.
To engrave 3D bitmap you must have ‘3D Output of Bitmap’ checked
as well as ‘3D Output’ checked on the final screen.
A large and dense bitmap can slow down regeneration of the screen,
which can be annoying, if you are working on the layout. To avoid this,
you can uncheck ‘Display Bitmap Image’. Now, instead of the bitmap,

MaxMotion for Machines

Chapter 11-177

a cyan colored filled rectangle will be drawn in its position, for a quick
redraw.
Settings for ‘Output scanline density:
Here you can either specify lines/inch or choose ‘Same as bitmap’
resolution or decide to use fill tool. Using fill tool means the distance
between consecutive scanlines will be the same as default fill tool size,
at the time of output. For best results you should have either scanline
density same as bitmap vertical density, or scanline density in multiple
of bitmap density, or bitmap density in multiple of scanline density.
‘Bitmap Settings’ dialog box contains three sets of settings:
(1) DPI resolutions and Max depth belong to the selected bitmap.
(2) 3D Output of Bitmap and Display Bitmap Image are global
settings of environment, affecting all the bitmaps.
(3) Output scanline density is saved to current plotter, as the ‘tool’
each plotter can use, could be different, e.g. difference between laser
and conventional machine.
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Chapter 12:

Graphics Menu
To access these commands and more, click on “Graphics” or use ALT
+ G key combination and then click on the appropriate command.

GRAPHICS MENU (Alt+G)

Rulers and Grids
Normally, MaxMotion is shipped with both grids and rulers turned on.
You can turn off rulers and grids to the screen by clicking on these
selections and removing the check marks next to the grid and rulers in
the Graphics menu. The numbers will also change as you use magnifying glass. As you zoom in and out on the screen, the grid dots will stay
in the same position. The graphic or job will be enlarged or contracted
and the numbers will change on the rulers. MaxMotion will always
position the job with its upper left corner at the (0,0) position of the
rulers.
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The choices under the Graphics Menu allow you to change the arrangement of the shapes in the plot file.

Flip and Rotate
Selecting either “Flip” or “Rotate” reveals a sub-menu or a fly out
menu from which you make your flipping or rotating choice. Flip and
Rotate works on individual selections as well as on the drawing as a
whole. When there is no active selection on the screen, the Flip and
Rotate commands will work as if the entire drawing is selected. But if
you make a selection of a single shape or a group of shapes, the
flipping or rotating will take place on the selections only. The shapes
will be flipped or rotated about the center of the selection group. The F
or the R letter in the fly out menu tell you pictorially how the manipulation will take place.

MaxMotion for Machines

Chapter 12-181

Change Depth
A limited editing capability is provided. Select any shape and select
‘Change Depth’ in the graphics pull down menu. You are presented
with two choices, ‘Set Depth’ and ‘Move Deeper’. You will see the
same depth value that is selected in the depth value of the selected
material in the Materials menu. If the shape has points at different
depths or more than one shapes are selected, the depth value of the first
point of the first shape is shown.

By changing the value at ‘Set Depth’, the depth of all the points of the
selected shape(s) can will be set. The value entered at ‘Move Deeper’,
however, bodily moves the entire shape(s) down (up if the value is
negative) by that amount. Even if the shape was imported previously as
a 3D DXF or 3D G-code or 3D HPGL type with points at varying
depths, it should be clear that changing ‘Set Depth’ will flatten it at
the new depth, not so with ‘Move Deeper’.
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Scale Shapes (Ctrl+L)

The scale dialog box allows many options for resizing the files.
If you know that the job must be a certain width, type the dimensions
into the width dimensions box, and the height will be automatically
adjusted to preserve the original proportions of the job.
Similarly, if you know that the job must be a certain height, type the
dimensions into the height dimensions box, and the width will be
automatically adjusted to preserve the original proportions of the job.
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If it is necessary to adjust both the width and the height of the job, you
may adjust them independently by unchecking the Proportional check
box. You can then enter the dimensions you desire into each box
without affecting the other. You may also scale the entire job by a fixed
percent value. If you want the change in size to be relative to the
current overall dimensions of the job you should enter the new percentage into the box labeled “of current.” If you want to resize the drawing
to a percentage based on the overall dimensions of the plot file when
the file was first opened, then enter the new percentage into the box
labeled “of original.”
If any shapes are selected when the “Scale...” menu choice is made, an
additional scaling option becomes active - The”All By Selection”
mode. The dimensions of any shape or group of shapes currently
selected is also displayed. You may now change the dimensions
of the selection, using the same techniques described above for scaling
the entire drawing, and the dimensions of the drawing will change
proportionally.

You can also limit your scaling to a “Selection Only” by choosing this
scale option, and then follow the same procedures as above.
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Join Shapes (Ctrl+J)
This command can be used to connect lines that are close but not
connected typically in the DXF files. Usually, EPS files have complete
shapes. However, it is not always so in the case of DXF files. Such
open shapes are likely to cause the following problems:
(1) There will be unnecessary tool lifts during the engraving process.
(2) The tool offset and the fill command will not be able to be applied
properly.
The process to join shapes is as follows:
Select the first line by bringing the arrow cursor close to the line and
clicking on it. Blue dots will show up for the selected line. Hold down
the shift key for multiple selection and click select the adjacent line that
you would like to join with the previous line. You should see two
different lines selected with blue dots. At this point, go to graphics pull
down menu and select join shapes. The two separate lines will become
one.
Tool Path Rendition
Often, users would like to know the sequence in which the engraving or
cutting is going to take place before sending the job to the machine.
Many CAD/CAM programs offer such facility. MaxMotion offers
similar capability.
While the job is on the screen, select Tool Path Rendition in the
Graphics pull down menu. The application will select the default tool
diameter unless a different tool offset is already applied to the shape
and the tool path will be rendered in different color for observation.
The default rendition speed is 10 inches per second. The speed can be
changed by changing the variable in the INI file called Rendition
Speed=10.
Practice and observe the rendering of the tool path by applying different tool diameter offsets to the shapes.
Cut Design Window
A normal and quite often accepted practice of an engraver is to set a
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plate size for the job. This plate size is for reference only within the
context of the MaxMotion software. It is for visual feed back. Normally, the engraver is only interested in sending the job to the machine
where a plate with a proper size is already set on the table. The plate
size boundary on the computer screen is shown with a gray shadow.
However, sometimes there is a need for the user to cut out the size of
the plate from a larger size material. MaxMotion has the capability to
make the plate boundary an active part of the job for the output as
opposed to it being simply a reference outline.
The process is called cutting the design window. Design a job as usual.
Go to Graphics menu and select ‘Cut Design Window’ and watch the
gray shadow disappear from around the design plate. The plate boundary will be sent for engraving purposes along with the rest of the job.
A hint: If you want to use a different tool for the boundary cutting
operation such as beveler, send the job first without selecting the Cut
Design Window command. Once the job is complete, change the tool to
a desired tool. Change the depth of cut in the materials menu, if
necessary. Apply the Cut Design Window tool. Next, select only the
plate boundary. Send the job to the machine. Only the selected part of a
complete job will be executed. Your job will have a beveled edge.

Change View Only
Change View Only command will allow the user to create its own
stationery templates or use Solustan provided stationery templates.
The stationery part of the template shows up in green color. The
stationery part cannot be moved, scaled, or deleted. The stationery part
of the template will not be sent to a machine for engraving.
Here is how a standard active black line or shape can be converted
to stationery lines:
Select the lines or shapes by clicking or shift clicking them. The blue
dots will signify selection of lines or shapes. Go to the ‘Graphics’ pull
down menu and click select ‘Change View Only’. The black lines
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will change to green lines and will become stationery.
Here is how a stationery line or shape can be converted to active black
lines in order for them to be moved, scaled, deleted, or sent to a
machine:
Hold down the Control key while selecting the green stationery lines or
shapes. The blue dots will signify selection of lines or shapes. Go to the
‘Graphics’ pull down menu and click select ‘Change View Only’. The
stationery lines will change to black active lines for intended operations.
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Chapter 13:

Software Compatibility
Software Compatibility with Maxmotion
The power of MaxMotion comes from the fact that it works with many
of the popular applications already on the market. It is assumed that the
user has the knowledge of the applications. Either he already possesses
or he plans to acquire them to design layouts for his engraving/routing
jobs. Following are a few pointers for each of the applications that will
simplify exporting the files from the various applications to the
importing of the same into MaxMotion.
Corel Draw
Corel Draw! version 3.0, through 7.0 work with MaxMotion. Use all
the capabilities and clip arts to create the job. Only a few steps to
remember are,
■ Use the fill tool. When you click on the fill tool (the last one in the
tool bar that looks like a graduation hat), a number of choices pop up.
Select the one with the big cross (X) and click on it. This action
removes the fill and leaves only outlines of the selected objects.
■ Use the Outline tool (the one above the fill tool in the tool bar with
an icon of a pen). When you click on the outline tool, a number of
choices pop up. Select the thinnest line, (the one that shows thinnest
lines with arrows from the top and the bottom). This action selects the
thinnest lines (0.003 inch) for the outlines.
If the information bar is activated at the top, you should observe a big,
white square box at the far right with a black X in it as well as defining
outline to be 0.003 inches.
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■ Finally, export the file as Adobe Illustrator *.AI or *.EPS format.
This file is now ready to be interpreted by MaxMotion. Just before
exporting the file, Corel shows a dialog box for selection. Select
Illustrator 1.1 format and curves as choices.
Adobe Illustrator
Compose the job with graphics and text set up with fonts, if required.
Select the text part of the job, pull down the TYPE menu and create
Outlines (last command in the TYPE menu). If your customer saves the
file this way and sends you the job, you can engrave the job even if you
do not have the fonts that he used to create the job.
Aldus Freehand
Compose the job with graphics and text set up with fonts, if required.
Select the text part of the job with the arrow tool, pull down the TYPE
menu and select convert to path command. This gives you the outlines
of the fonts. Then select ELEMENT menu and select Element Info. The
box that gives you the element info might have Odd/Even fill checked
out, deselect that box. Then select each text block and under the
ELEMENT menu select split elements. This should separate each letter
as a separate element. Now, pull down the file menu and export the file
as EPS file and MaxMotion will read the file properly.
Freehand works with PostScript Type 1 fonts as well as TrueType fonts.
If your customer saves the file this way and sends you the job, you can
cut the job even if you do not have the fonts that he used to create the
job.
Deneba Canvas
Compose the job with graphics and text set up with fonts, if required.
Select the text part of the job with the arrow tool, pull down the TEXT
menu and select create Bezier (hollow) command. This gives you the
outlines of the fonts. If you designed any shapes with various Canvas
tools, pull down the Object menu and the command Convert to Bezier
Curves. Canvas works with PostScript Type 1 fonts as well as TrueType
fonts. If your customer saves the file as Illustrator 88 and sends you the
job, you can cut the job even if you do not have the fonts that he used
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to create the job.
Micrografx Designer
Works pretty much the same way as Corel Draw!
AutoCAD and AutoCAD LT
MaxMotion software excepts files exported by AutoCAD programs in
the DXF format just the way it excepts PostScript files.
Arts & Letters
Works pretty much the same way as Corel Draw!
Macintosh files
The Macintosh operating system 7.0 and higher allow creation of high
density PC floppy formats. The Macintosh computer can also read PC
formatted floppies. You can prepare your job on Macintosh computer
using applications like Adobe Illustrator or others and save the files as
Illustrator 88, 1.1, or 3.0 on a PC formatted floppy. Bring the file over
to your PC with MaxMotion. The MaxMotion will read this file as is
and will allow you to scale it, fill it, and output it to your choice of
machine.
Adobe Streamline
Adobe Streamline 4.0 for Scanning and vectorizing of logos and
graphics. The version 4.0 of Streamline is one of the nicest programs
to come along in its category. Most of the scanners today are available
with TWAIN compliant filter. Once you load the TWAIN filter into
your Windows system, Streamline 4.0 is able to scan directly from the
scanner. The scanned bit map file can be edited in Streamline 4.0. Once
edited, the file can be converted to vectors or outlines. The vectors can
also be edited in Streamline 4.0, if necessary.
The file is now ready to be saved as Illustrator. *.AI or *.EPS file.
Again, this file can be read directly into MaxMotion and it is ready
to be engraved.
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Chapter 14:

Braille Font
Solustan provides two different fonts for the Braille
requirements. Once you have created Grade II Braille copy, bring it into
MaxMotion. You have a choice to apply one of the two Braille fonts
ABRAILLE and BBRAILLE fonts.
(1) ABRAILLE fonts
These fonts have a properly defined box and the Braille dots. Select the
font and select the size to be 0.430 inches. At this size the dot sizes, the
inter dot size, and the cell size should meet the ADA specification
requirements.
Typically, the user might be using a 0.030 or 0.035 diameter ADA tool.
Select the job and apply the offset tool to create the offset for your tool
size.
Next, with the same tool size, apply fill.
Select proper depth, speed, feed, etc. before starting the job.
(2) BBRAILLE fonts
These fonts have a properly defined box, oversize Braille dots, and the
routing patterns for the fill for a 0.035 size tool. Select the font and
select the size to be 0.430 inches. At this size the dot sizes, the inter dot
size, and the cell size should meet the ADA specification requirements.
If you are using a 0.035 tool, you do not need to apply and create any
offsets or fills.
Simply, select proper depth, speed, feed, etc. before starting the job
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Convert To Braille
Braille alphabet was designed for the blind people to be able to read
with their fingers. The original specification was created with a
combination of dots for each of the characters in the English alphabet
and the numbers. This was called Grade I Braille. Subsequently, the
specification was revised and is called Grade II Braille. One way to
think of the newer specification is like a short hand version of the
original specification. Many of the commonly occurring combination of
letters were assigned different combination of dots (some of the simple
examples are ‘ing’, ‘en’, ‘the’, ‘ch’, ‘sh’, ‘and’, etc.).

The Convert To Braille command will simply convert standard English
phrases and words to comply with Grade II Braille specification.
Instead using another third party software, the user can complete the
conversion right within the MaxMotion software. An exception
dictionary is provided for the words that do not fall into standard rules
of the conversion.
Contact Solustan for additional explanation, if required.
.
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Chapter 15:

Max Fonts
FONTS
Although, any TrueType font can be engraved under the MaxMotion
application, Solustan provides traditional engraving fonts. All the
engraving fonts are not only designed as TrueType fonts but they are
also designed such that engraving bit does not lift up to finish any
alphabet character once it starts. We call them Non Lift Fonts. It will
engrave faster and smoother.
Multi Line fonts are designed and Optimized to work with 0.5 inch or
higher sizes. All fonts are provided in the Zip file format. These are self
extracting zip files. Fonts provided with MaxMotion software has a file
name MaxFonts.EXE The optional font package has the file name
FontPak.EXE
In order to use these fonts properly, please follow the installation
instructions. Installations for Windows 3.X, 95, and 98.
(1) Quit all the applications in Windows before starting to install the
new fonts.
(2) Remove all existing PostScript engraving fonts, if you are still
using the PostScript engraving fonts Solustan use to provide. Follow
the instructions from the Adobe ATM Software for removing the fonts.
(3) Insert the fonts floppy into your floppy drive “A” or “B”.
(4) Open the Windows Explorer. (Open File Manager in case of
Windows 3.X.)
(5) Find the floppy drive from the top left area. Click on the floppy
drive icon and you will see the MaxFonts.exe or FontPak.exe files on
the right side.
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(6) Now double click on the MaxFonts.EXE or FontPak.EXE. You will
see a box With PKSFK on the left top corner. Double click on the
Extract button which is at the bottom left. This will automatically
install fonts in the windows fonts folder. Then go to the start button and
select control panel. Open the fonts folder from the control panel.
Now you should be able to see all your fonts installed here. All
engraving fonts provided by Solustan has name that begins with an
‘A’ so they should appear on the top of the list.
(7) Please, restart your computer in order to see these fonts in
MaxMotion application.
Your font installation is complete and you can use these fonts with
MaxMotion.
If you bought fonts individually follow the direction below for
Installation. Installations for Windows 95 and 98.
Fonts have a name of font .TTF
(1) Quit all the applications in Windows before starting to install
the new fonts.
(2) Follow standard windows font installation procedure.
Go to Control Panel and open Font folder.
Then select Install new font from the file menu.
Then select A: drive and select this font provided on the floppy.
Now click Install.
Your font installation is complete and you can use these fonts with
MaxMotion.
(1) List of fonts provided with the MaxMotion software
(2) Fonts available in Optional FontPak
(3) Keyboard layouts for special fonts
Two types of Braille fonts are also included with the software when the
Braille option is ordered. Chapter 14 will explain that in more detail.
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ACentury

ABahaus

AVictori

AFuture

AEras

ABlockEuro

A3Roman

ABlock

A3RomanCap

AContempo

A2Roman

AKaufman

ASwiss

AEnglish

ASkribe

ASymbol

A2Skribe

AFifth Ave

AScript

AGothic

A2Script

AGothCon

Solustan, Inc.
165 Chestnut St., Suite 200
Needham, MA 02492

Tel. 781-449-7666
Fax 800-666-8789/781-449-7759
www.solustan.com
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Optional FontPak
A4Swiss (4 Line Swiss)

A6Swiss (6 Line Swiss)

A6Optem (6 Line Optem)

A10Optem (10 Line Optem)

A4Roman (4 Line Roman)

A10Roman (10 Line Roman)

A6Gould (6 Line Gould)

AMicro

ATBlock

ATScript

ASlant

ACircle

AOrnamet (20)

FontPak with all 16 fonts is available for $495.00
Individual fonts are available for $96.00/each

AInterlock

A2Symbol (94)

AOcasion (63)
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AInterlock

(f)

(e)

(d)

(m)

(l)

(k)

(j)

(i)

(t)

(s)

(r)

(q)

(p)

(o)

(h)

(b)

(c)

(n)

(g)

(a)

Ornamental Font (AOrnamet) Keyboard Layout
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MaxArt:
MaxMotion allows you to create ‘Stationery Files’. These files are
saved in the form of ‘TEMPLATES or *.tpl files. When you open one
of these files, you will see a design on the screen that is stationery.
These designs will not move on the screen while you design the rest of
the job. These designs will show up distinctly in Green color. These
designs will not be sent to the engraving table along with the rest of the
job. It is more of a reference for the user.
You can create your own such stationery templates. Simply, import the
graphic, scale it if necessary, and place it properly. Next, select the part
that you would like to convert to a stationery piece. Pull down the
Graphic menu in the MaxMotion application and select ‘Change ViewOnly’. The selected part will turn green to signify that it has become
stationery or reference part of a design. Now, you cannot select, move,
scale, or send it to the engraving table.
If you do want to make it Non-Stationery, scale it and send it to
engrave, simply hold down the Ctrl key while selecting. The blue dots
will show up. Pull down the Graphic menu in the MaxMotion application and select ‘Change View-Only’ again. This action will reverse the
process and the graphic will become active part of a design.
Following is the printed output of the stationery designs. You can go to
Solustan’s web site and download this file in order to be able to use it
with MaxMotion Engraving software.
1. Go to www.solustan.com
2. Go to the download section and fill out the short form
3. Click submit
4. Select MaxArt.EXE file (This is a self extracting zip file)
5. Download the file to your hard disk drive
6. Once it is on your hard disk drive, double click on the file.
7. It will self extract to your MaxEng folder and will become part of
your engraving software.
8. You will be able to access all of these *.tpl files as template files.
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Chapter 16:

SmartPlate™
SmartPlate™ function
SmartPlate is available as an option to the MaxMotion software.
SmartPlate function is an example of a clear advantage of the concept
of Virtual Controller. Nobody in the motion control business offers
SmartPlate type feature with the proprietary controllers that are offered.
The controller functions are built into the MaxMotion software. As a
result, MaxMotion knows the whereabouts of the position of the
machine, if and when required.
SmartPlate allows the user to define an area where the user wants to
perform engraving work without any measurements whatsoever.
Where can you use this capability:
(1) You have set up a machine at a mall for the Christmas season.
Customers come by to get engraving done on the presents and you want
to get it done quickly to satisfy customers and increase your revenue.
(2) You have odd shaped material like the shape of the State of
California that you need to engrave on.
(3) You need to engrave on a number of zippo lighters but you do not
want to build a jig.
(4) You were given very high quality multi color screen printed awards
that were expensive. You were asked to insert the different name and
the date in the same location on the award. Obviously, you would like
to make sure that the engraving takes place in the right location on the
awards and it does not take tremendous amount of time.
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You can imagine many such scenario. Now, let us see how simple it is
to use the feature.
Position the material wherever you want on the machine. Define a
rectangular area within which you want the engraving to be done
regardless of the shape of the material.
Next, pull up the Control Pad and lock the mouse by clicking on it a
few times.
Move the machine to one of the corners of the rectangle within
which you want the engraving to be done. Depress “S” key for
starting the SmartPlate operation. Move the machine again with
the help of the Control Pad to the diagonally opposite corner of the
defined rectangle. Depress “E” key to end the operation. The
machine will move immediately to the starting position of the
rectangle and the plate size on the screen will change to the just
defined size. Now, all you have to do is to design your job and keep it
within the rectangle. As soon as you give a command to engrave the
job, the engraving will take place in the proper and intended area on the
material.
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Appendix A

Using Scanned Images

An important and a profitable part of a engraving/routing business is to
scan logos and other artwork for the customers, scale the artwork and
ultimately create high quality work with engraving/routing. MaxMotion
can certainly help you achieve the above goal with the greatest of ease.
Actually, the whole process is very simple and proven. The availability
of scanners and related software is mind boggling. A user can easily
pick a combination of system components to work with his PC/
Windows computer and to fit within his budget and he can be productive almost immediately. Following are choices to think about:
(1) Scanners are available as small, low cost hand-held scanners, black
& white flat bed scanners with typical maximum scanning size of 8.5 X
14 inches, color flat bed scanners as well as reasonably priced slide
scanners. The typical resolution of hand-held and flat bed scanners are
300 DPI (dots per inch) to 600 DPI, and with low end slide scanners
reaching up to 1800 DPI.
Scanners are sold with a utility software that allows capturing of
scanned images and storing as some of the standard PC/Windows file
structures. Most of the scanners are also available with a proper
physical interface with the PC/Windows computer such as parallel,
serial, SCSI, or USB interfaces. All of these make it easy to interface
the scanner to the PC/Windows. Do not forget that you may need
additional RAM memory in your computer to hold large scanned
images.
(2) Now, that the scanner is connected to the system, the user is ready
to take a drawing of a logo and machine the logo, for example. Scanners scan the artwork and digitize the image. The original artwork
might be on paper. The scanned image is a number of dots or pixels.
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These are the individual dots on the screen of the computer that are
either on or off. These dots help create an approximation of the original
image. The scanner will create a high resolution image at either 300 or
600 dots per inch for storage while there will be a separate lower
resolution image for the computer screen. Typically, the computer
screen is 72 to 96 dots per inch.
If the option is available, scan the object as a gray scale object as
opposed to black and white object.
(3) The images captured with the help of the scanners are known as
bitmap images. Some trial & error testing is necessary if the scanner is
used for the first time. The combination of the quality of the original
image coupled with proper scanner setting is likely to produce the best
results. These bitmaps need to be converted to outlines defined as lines,
arcs and curves. The routing tool bits can follow these curves to create
necessary shapes. The process of converting bitmaps to outlines is
known as “vectorizing”. There are several software packages available
on the market to solve this very problem. A product called “Streamline”
from Adobe is one such product to do the job.
(4) When Streamline converts a bitmap to an outline, this outline can
directly be used by MaxMotion to prepare the job for engraving/
routing. A little practice with the software such as Streamline and the
available settings in the software will produce the cleanest possible
outlines that may require the least amount of editing. However, it is
possible that this outline may need further cleaning up of the file. The
latest version of Streamline 4.0 allows editing and cleaning up of
vectors.
(5) It is worthwhile to explore the following features in Streamline 4.0.
You can create excellent files for engraving or routing by tweaking just
a few conversion options:
■ Select maximum edge smoothing
■ Increase noise suppression if you scanned a paper that was dirty.
■ Increase the tolerance to a full 5.0, the loose most.
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■ Read the software manual, it is excellent.

Appendix A-211

212

MaxMotion for Machines

MaxMotion for Machines

Appendix B-213

Appendix B

Common Questions
This appendix provides answers to questions which many new users
ask about Solustan’s MaxMotion software.

(1) Do I need to buy special fonts to work with MaxMotion?
No. MaxMotion works with standard PostScript Type 1 and TrueType
fonts. MaxMotion converts these fonts into vectors (arcs and lines) and
are sent to the plotter. Also, MaxMotion scales this information to any
size without losing the smoothness of the curves. A utility called Adobe
Type Manager is required if PostScript Type 1 fonts are to be interpreted. Additionally, MaxMotion works with the files created by most
of the major successful drawing programs. Most of these programs
convert fonts into Bezier curves or outlines that can be interpreted by
MaxMotion.
(2) Can I accept files from my customer on a floppy and create an
engraved solution ?
Yes, if the files have been saved in Postscript or DXF form, with the
fonts converted to outlines. Please, consult chapter on Software
Compatibility for additional information.
(3) We set up the software and connected our machine. However,
nothing happens when we try to machine an example file. What
can we do?
Check the following:
■ Proper connections and cables.
■ Proper set up for your machine.
■ Selection of port (serial or parallel) in the Windows set up.
■ Selection of proper driver in the Windows set up.
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■ Proper selection of the machine in MaxMotion.
■ Set up of communication parameters including handshaking arrangements.
■ Check again the elaborate setup for steps & directions commands.
(4) Which PC models MaxMotion work with?
Any PC type computer that can handle Windows 3.X, 95, or 98
environment. A PC with Intel Pentium 133 MHz type processor or
faster is desirable as well as 16 MB RAM memory is very useful. The
processing power requirement of a PC is more severe when it is used as
the virtual controller as well as for the arc creation.
(5) Will MaxMotion work with other versions of Windows operating systems that Microsoft Manufactures for various languages of
the world?
Yes.

(6) How does Material menu help me?
The capability allows you to set up defaults values for your everyday
business purposes. This reduces chance for errors by operators. Read
further the chapter on Material Menu in this manual.
(7) Once I give a command to SEND the job, my PC is operable for
me to work on my next job. Do I stand to lose any of my work if I
start a new job while the PC is working with the engraving/ routing
machine on my previous job?
No, the application takes advantage of the Windows spooler. If the
spooler is turned on, the job will be spooled before sending out to the
engraving/routing machine. If you know that your machine has a large
buffer to store the job, and many of them do, then do not use the
Windows spooler. It will be faster to send the job over to the machine
within seconds and go on to the next job.
However, it is important to know that if you are using MaxMotion
Virtual Controller to replace a controller, essentially, your PC is the
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controller. You will not be able to use PC for other things while it is
processing a job.
(8) What if I want to stop a job in the middle of the engraving/
routing machine processing the job?
It depends upon a particular engraving/routing machine. Different
manufacturers suggest different actions. Please refer to the owner’s
manual for the engraving/routing machine.
Use Pause command in case of MaxMotion Virtual Controller software.
(9) I created a character “O”, outlined it, selected the character and
tried to fill. The character was completely filled up instead of
working just between the two parts of “O”. Why?
Once you create the outlines, every shape becomes an individual shape.
The outside circle of “O” does not own the inside circle. If you select
only the outside circle, it will fill the whole shape. If you drag the
mouse around the character and select both the shapes (blue dots will
show up on both the shapes), MaxMotion will subtract inside shape
from the outside and you will get desired result.
Another possibility is that for some reason both the shapes, inside and
outside, have the same path directions. Enlarge the shape with magnifying glass, if necessary, and watch the position of the blue dots. The blue
dots should be on the inside of the outside circle and should be on the
outside of the inside circle. If any of these are not correct, select that
shape only and apply Reverse Path command from the Edit menu.

(10) Can I see the final design of my job just before sending it to the
routing machine?
Yes, you will see it on the main screen as well as in the MACHINE
dialog box.
(11) Many of my contractual jobs require precision in terms of the
height of the characters or objects as well as the length of the
message. How can I assure such precision with MaxMotion?

216

MaxMotion for Machines

Our “Scale by example” will meet your needs. Also, the scale on the
tool palette can help you determine the exact dimension of your object.
(12) Many of my customers keep coming back for more of the same
designs that I did some time ago. How can I save the files of my
final design in order to be able to reproduce the exact copy?
Just select “Save as” from the File menu, and the machine/plot file will
be saved for future use. You will be asked to name the file. These files
should have *.Max extension name.
(13) I am a power user. I like to speed up the operation by using
keyboard short cuts instead of pulling down the menus and clicking
with mouse. Have you organized MaxMotion with command keys?
Most definitely. Observe the menus by pulling them down or using
ALT key along with the underlined character (F for File, etc.) to get
access to the commands under that menu. You will notice that whenever appropriate, commands are accessible with Control key combination. Once you pull down the menu, you can close the menu either by
hitting ALT key alone or by hitting ESC key.
(14) I am a power user. I have enough memory and a fast computer
to run two programs simultaneously. I want to keep both
MaxMotion and Corel Draw active. Can I do that?
Yes. If you have a larger size screen, you can split screen and have both
the programs on the screen sharing the space. You can move back and
forth between the applications. If you have a smaller screen or you
prefer to have the screen available for one application at a time, load
one software (e. g. MaxMotion) from the Program Manager. Use ALT +
TAB key combination to go back to Program Manager. Now, load the
second software program (e. g. Corel Draw). You can easily switch
between the two programs by simply using ALT + TAB key combination.
As long as the amount of memory in your computer permits loading of
more than one application, Windows 95 and 98 make it even easy for
you to switch between the applications with ease.
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(15) My customer is working with a Macintosh computer. Can I
accept jobs created on a Mac and engrave/rout on my PC with
MaxMotion?
Absolutely, yes. Ask your customer to design the job in Adobe Illustrator or Aldus Freehand or Deneba Canvas or Broderbund TypeStyler or
Claris Draw. Ask the customer to convert the job to Bezier curves or
outlines. Next, the customer should transfer the file to a PC formatted
floppy disk with the help of standard Mac/PC exchange utility.
MaxMotion will open the file without any modifications. Scale and
prepare the file and send it to the machine.
(16) Cannot open a graphic file that was scanned and vectorized.
What am I doing wrong?
There are a number of things to consider.
(1) MaxMotion is set up with the maximum shapes in a file to be no
more than 4,000. This is a reasonable number for a typical graphic file
and the RAM memory size generally available in a typical PC/Windows computer. The setting is in the INI file provided with the application. If the file is suspected to have more than 4,000 individual shapes,
the number of Maximum Shapes in the INI file can be changed to a
suitable number.
(2) The best vectorized EPS files are the ones with the minimum
number of nodes that are required to define the shape of a graphic. Too
many nodes will slow down the engraving process. Older versions of
Corel Trace program and some of the third party conversion processes
yield shapes with a simply too many nodes. Microsoft Windows screen
management limits the number of nodes allowed per shape. Make sure
and demand a good quality with minimum nodes in a vectorized EPS
file.
(3) Use programs like Adobe Streamline version 4.0 or higher with
settings suggested in this manual. It is one of the best but a very
reasonably priced program we have found in the market.
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(17) My machine is moving in wrong direction when I use Control
Pad to move the table around. How do I correct it?
First of all, turn off the power to the MaxAmp module. Move all the
axis away from the limit switches, if the machine has the limit
switches. Turn the power back on to the MaxAmp module.
Use the control Pad to move the individual axis and make a note if any
one or more of the axis are moving in the wrong direction.
Go to File pull down menu and select Machine Setup.
Make sure that the proper machine is selected.
Click on the Machine Setup section I.
Note that direction setup is available for each of the axis.
The radio buttons High and Low can be toggled.
Toggle the radio button only for the axis where the machine was
moving in the wrong direction.
Save the changes and click OK to close the Machine setup area.
Use Control Pad again to confirm the correct directions in each of the
axis.
Caution: You should not exercise the limit switches to go home until
you make sure that the directions of movement are proper for all the
axis.
(18) I installed the HPGL version of MaxMotion to control my
machine through my HPGL compatible controller. It does not work
yet. Any suggestions?
The most common problem if it does not work right after the first
install is possibly the setting or the installation of the Generic/TEXT
driver available with the Microsoft Windows.
Read the chapter on the installation again. If necessary, call us for help.
(19) What do I need to do to change from NoteTabPro to the
NotePad (provided by Microsoft with Windows operating system)
as the default editor?
■ Open the INI file under Microsoft WordPad.
■ Move your cursor down a few pages until you see the part that looks
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just like the file below.
■ Note a semi-colon in front of the line TextEditorPath=C:\Windows\Notepad.EXE
■ Note that there is no semi-colon in front of the line TextEditorPath=C:\progra~1\NoteTa~1\NotePro.EXE
The line with no semi-colon in front is the default editor.
■ Remove the semi-colon in front of the line with NotePad as the text
editor.
■ Add the semi-colon in front of the line with NotePro as the text
editor.
■ Save the file.
Now, you have switched from NoteTabPro to NotePad as the
default editor.
Example of the partial INI file:
;--------<some settings>
PAUSE_CAPABLE=1
WinUniDrive=0110000800
ShowPrintDialog=0
ShowMachineSetup=1
;TextEditorPath=C:\Windows\Notepad.EXE
TextEditorPath=C:\progra~1\NoteTa~1\NotePro.EXE
;TextEditorPath=C:\Maxeng\SerialGen.EXE
ScannerPath=C:\Adobe\stream~1.0\stream~1.exe
EditTextFileName=MAX.TXT
BlankCommentFile=Comment.TXT
ExceptionFileName=EXCEPTN.DCT
BrailleFontName=BBraille
BrailleSpaceChar=233
MaximumShapes=6000
Printer_Startpos_Rotation=1
Extra_Char_Space=0
Output3D=0
TestStopName=MP_SEL_8
RenditionSpeed=10
ShowToolSpeed=0
ShowCounterPerInch=0
PSSmoothness=75
TTRecursionLevel=3
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(20) How can I change the resolution of PostScript files
and TrueType fonts?
The settings are available in the file called MaxMotion.ini and is
positioned in the same folder where the main application program
MaxMotion.exe resides. Use any editor like WordPad to open the file
MaxMotion.ini. About three pages down from the top, you will see a
part in the file that resembles as below:
Example of the partial INI file:
RenditionSpeed=10
ShowToolSpeed=0
ShowCounterPerInch=0
PSSmoothness=75
TTRecursionLevel=3
PSTTDeltaInch=0.001
DXFDeltaInch=0.0001
DXFUnitFactor=1
NudgeDistance=0.0500
HelpBrowserPath=
HelpFileName=
Note that PSSmoothness has default value of 75. The higher the value,
the smoother the curve will be. This applies to all the imported
PostScript files.
ALso note the TTRecursionLevel with a default value of 3. The higher
the value, the smoother the curve will be of the TrueType fonts. If your
value is 2, change it to 3. If it is already 3 and you do not like the
resolution of the output of the fonts, increase it to 4 and up until you are
satisfied. Always remember, the higher the number you selected, the
longer it is going to take to process the information.
Try to find an acceptable balance between quality and speed. You can
always go out and buy an extremely fast PC with lots of RAM memory
and then you can go for the best quality possible.

(21) What is the most appropriate home position for my machine
out of six available positions?

MaxMotion for Machines

Appendix B-221

It depends upon the kind of machine you have.
1. If you have a machine with limit switches and it tends to take you to
top left at the beginning and the end of a job, you want to use Top Left
as your starting position. A good example is most of the Meistergram
machines.
2. If you have a machine with a vise that opens both the top and the
bottom side simultaneously (For example New Hermes 3000 vise
machine), it would be most advantageous to select Center as your
starting position. The reason is that the center never moves from its
position no matter what the size of the plate that you are working on.
3. If you have a machine with a vise that opens only on the bottom side
(For example New Hermes 810 or Dahlgren Wizzard machine), it
would be most advantageous to select Top Center as your starting
position. The reason is that the Top center never moves from its
position no matter what the size of the plate that you are working on.
(22) I need to move the tool away from the starting position while
retrieving a job done or while placing a new plate for another job.
How can I do that without losing my starting position? How can I
speed up my engraving process?
Make sure and read carefully manual Chapter 1, Machine Setup,
Section III.
Let us take an example of New Hermes 810 machine. This machine
does not have limit switches in X and Y axis. However, it has a ruler
type stop at the top center.
Select Top Center as your starting position.
Observe the additional settings of Start Offsets. These offsets will come
into action at the starting of a job. Let us assume that you want to park
the tool at 2 inches to the right on X axis and 0.5 inches above the stop
ruler in the Y axis. This action will move the tool away from you in the
X axis and to the left for you in the Y axis. Since X axis parking
position is to the right, it will have to be declared as negative value
while Y will be a positive value. You will declare -2.0 in the X axis box
of the start offsets and 0.5 in the Y axis box.
Measure and find that spot on the table that is 2 inches to the right of
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the top center on the X axis and 0.5 inches away from the working area
on the Y axis.
When you start a new job with a new plate size and proper positioning
of the plate, the software will add the offset values to create a reference
value of top center and will engrave the job on the plate. At the end of
the job, it will not go to Top Center but it will directly retire to the
parking position and will get out of your way.
Please, understand the definitions of starting position, parking position,
start offsets. Practice by applying offsets and watch the results using
waste material and using a broken tool or no tool to minimize your
damage while you get the hang of it.
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Appendix C

Configuration of Parallel Port

Standard configuration of Parallel Port of PC
for MaxMotion Multi-Axis Indexer
Parallel port on the back of a PC has a 25 pin female connector. Most
computers may have only one parallel port. However, a PC can be
configured with as many as 3 parallel ports. You can use any one of
them to connect to the XYZ table. Following is the pin configuration:
DB-25 pin outs

Signals

1 ————————————
2 ————————————
3 ————————————
4 ————————————
5 ————————————
6 ————————————
7 ————————————
8 ————————————
9 ————————————
switches
10 ———————————
11 ———————————
12 ———————————
13 ———————————
14 ———————————
15 ———————————
16 ———————————
17 ———————————
18 - 25 ——————— ——

Right output switch
X - Step
X - Direction
Y - Step
Y - Direction
Z - Step
Z - Direction
+5 V. DC for opto-isolators
+5 V. DC-Possible for limit
Limit switch - Z axis
Future Use
Limit switch - X axis
Limit switch - Y axis
Left output switch
future use
Spindle motor enable
Amplifiers/Drivers enable
Ground lines

This will be a standard configuration. Custom configurations are
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available. It is important to note that the limit switch feed back shall be
TTL levels only. This means that the high output level shall not exceed
5 V. DC or it may damage your parallel port card.
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Appendix D

NoteTab Pro
Simple guidelines to install the NoteTab Pro editor, the American
English dictionary, the necessary changes both in the editor as well as
the appropriate MaxMotion application initialization files (Maxeng.ini,
MaxHPGL.ini, or MaxCAM.ini).
Warning 1: NoteTab Pro editor works only in Windows 95 and 98. It
does not work with any of the Windows 3.X versions.
Warning 2: You should have the MaxMotion version 4.87 or higher
installed for the NoteTab Pro to work with the MaxMotion.
NoteTab Pro software is provided on two separate floppies.
Floppy One contains the editor and this readfirst.doc file.
Floppy two contains American dictionary and thesaurus.
The guidelines here assumes that the MaxMotion software resides on
your hard disk drive labeled “C”. If it is other than C:, make the
necessary changes.
You should also install the NoteTab Pro editor on the same “C” drive.
Close all the applications in your computer and make sure that no
applications are running while you install this software.
ACTION NUMBER ONE:
Insert the Disk No. 1 in your floppy drive. Go to the Start button, select
programs, and open Windows Explorer. Select the 3.5 in. floppy drive
and note that there are two files - NTP452.exe and readfirst.doc. The
readfirst.doc is the text file of the document you are reading.
NTP452.exe is a self installed, zipped file for the editor. Double click
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on the NTP452.exe file to start the automatic installation process. If it
is not necessary, do not change the name of the folder, where it is
saved, and the name of the application. Once the installation process is
complete and as you click the Finish button, the editor will be
launched. The editor will ask - Associate text files and NoteTab specific
documents to NoteTab Pro? Click the “YES” button. The editor
displays tips every time you launch the program unless you choose to
turn it off.
It will be a good idea to read the two files provided with the program.
These files are - Read Me and What’s new. It will be time well spent.
ACTION NUMBER TWO:
Next, insert Disk No. 2 in your floppy drive. Go to the Start button,
select programs, and open Windows Explorer. Select the 3.5 in. floppy
drive and note that there is one file - dicts450.exe. dicts450.exe is a self
installed, zipped file for the spell checker and the thesaurus for the
editor. Double click on the dicts450.exe file to start the automatic
installation process. Once the installation process is complete, click the
Finish button. Each of the dictionary and the thesaurus will be installed
in its proper place.
ACTION NUMBER THREE:
One simple change is required in the MaxMotion application in order
for the MaxMotion application to use the NoteTab Pro editor in place
of the NotePad editor supplied by Microsoft as part of Windows 95 or
98.
If the NoteTab Pro is not open at this point, go to Start button, select
programs, select NoteTab Pro folder, and click on the NoteTab Pro
application. Go to File Open dialog box, navigate to the MaxEng
folder, look for the *.ini files, and open Maxeng.ini or MaxCAM.ini or
MaxHPGL.ini file.
You will see Plotter names at the beginning of the file. Scroll down the
file and notice Material Entries, Dimension of the design plates, Port
selection for step and direction, and finally a title <Some Settings>.
You should see a set of lines similar to the following file. Note that we
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call out two different editors - NotePad and NotePro. The command
with the semicolon in the front becomes just a comment and not a
command. The example below is the setting for the NoteTab Pro editor.
Edit the file for proper setting. Make sure and save the *.ini file. (You
can copy and paste any part of the file from here to the ini file.)
;————<some settings>
PAUSE_CAPABLE=1
WinUniDrive=0110000800
ShowPrintDialog=0
ShowMachineSetup=1
;TextEditorPath=C:\Windows\Notepad.EXE
TextEditorPath=C:\progra~1\NoteTa~1\NotePro.EXE
EditTextFileName=MAX.TXT
BlankCommentFile=Comment.TXT
ExceptionFileName=EXCEPTN.DCT
BrailleFontName=Arial
MaximumShapes=4000
ACTION NUMBER FOUR:
While the editor NoteTab Pro is open, set the following items:
(1) Go to View pull down menu and select Spell Checker Options...
Click Add to Main dictionary and select American.Dct. The spell
checking and the Thesaurus actions can be taken from the Tools pull
down menu. The Function keys F11 and F12 will do the same thing.
(2) Go to View pull down menu and select Options... Click on the
Toolbar tab. You will see a large number of choices for the Show in
Toolbar. Go down about half way and check a box in front of Invert
Case. This action will insert case invert capability right from the
Toolbar. Watch the addition of an icon in the Toolbar that shows a
lower case a and a capital A with arrows going back and forth. You can
select any part of the text in your document and clicking that icon will
invert the case of the selected text. You can perform the same action by
selecting Text Case in the Modify pull down menu.
(3) Go down further in the Tools pull down menu and select Text
Statistics... This will give you the number of characters in your job.
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It will now be easier to perform these functions simply by clicking on
the icons in the tool bar while the text is on the screen.
You should learn to take advantage of the above few things right away
in the new editor. The basic procedure will be as follows:
ACTION NUMBER FIVE:
Launch MaxMotion.
Click with the text tool inside the plate.
Enter a word “ENGRAVE”.
Click the function key F5 or select Text Editor in Job Design. The
NoteTab Pro will be launched on top of the MaxMotion. Also, you will
see that NoteTab Pro opened a file named Max.txt and you will see the
same message in the NoteTab Pro that you typed in the MaxMotion. Go
to the Tools menu and select Spelling... The editor will show the
correct spelling “ENGRAVE” right away. Select the right spelling,
click change, and click close. You can also try out text statistics and
thesaurus functions.
IMPORTANT: Remember to save the Max.txt file while you are in
the NoteTab Pro editor. Select Save in the File menu or a combination of Ctrl + S keys. It is the saved file Max.txt that MaxMotion will
look at when you try to import the file back into MaxMotion. If you did
not SAVE the file, you will not be able to update the MaxMotion screen
with your changes in the editor.
Next, bring the MaxMotion application in the foreground. Once
MaxMotion is in foreground, click function key F6 or select Read
TextFile in the Job Design. The MaxMotion screen will be updated
with the saved text in the Max.txt file.
Explore other functions of the NoteTab Pro editor.
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Appendix E

Hardware Installations
HARDWARE INSTALLATION INSTRUCTIONS
E1. Installation instructions for MaxAmp Driver box
We thank you for purchasing our revolutionary no controller solution
that is gaining popularity throughout the marketplace. You are going to
enjoy the following advantages:
(1) Completely open architecture where you depend upon nobody to
maintain your machine.
(2) Future upgrades will simply mean installing new software without
any hardware changes.
(3) Future purchase would simply mean buying a used or a new X,Y,Z
table at an attractive rate and increasing your capacity.
Important: The following upgrade procedure should be followed and
performed only by experienced and trained individuals who understands these machines. It is important to follow safety procedures
necessary for any such upgrade work. You should not attempt to carry
out these upgrade procedures, if you do not possess proper knowledge
of such systems and the required safety procedures. The safety knowledge may require understanding of the electric hazards, hazards posed
by sharp tools used to work on harder materials, mechanical complexity, etc. The safety knowledge may require use of gloves, goggles, hard
hat, and other protection devices. Solustan is not responsible for any
damages because of the installation of our upgrade kit.
INSTALLATION
A.
The MaxAmp unit is designed to work with different tables
and different motors. Yours should be available with proper
matching amplifiers for the motors on your table and
appropriate connectors for connecting both to the computer as
well as to the table.
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Your PC shall be equipped with at least two parallel (printer)
ports. The software ID key provided with the kit will be
connected to one of the parallel ports. If a printer is desired as
part of the system, the ID key shall be connected between the
printer port and the printer. The machine shall be connected to
the second parallel (printer) port.
C.
Place the MaxAmp unit near the engraving table.
D.
Make sure that the surface is flat on which the MaxAmp unit
is sitting. It is necessary to have at least 3 inch clearance
behind and in front of the MaxAmp unit for the cooling. The
fan pulls the cool air in from the front and the hot air exits
from the back.
E.
The kit comes with 6 different cables. Depending upon the PC
keyboard connector (regular AT style connector or PS/2 type
connector), either 5 or 6 cables will be required.
1. Disconnect the keyboard cable from the back of the computer.
2. Note the male connector on the keyboard cable.
3. Find the same connector on the Universal Keyboard Adapter
(S-UNVKY).
4. Plug the male connector into the PC
5. Plug the keyboard cable back into the exposed female connector on
the adapter.
6. You are left with two extra connectors on the S-UNVKY adapter
7. If one of the extra connectors fit the 10 ft. extension cable, connect
it.
8. If not, insert the smallest cable we have provided to match to the
extension cable.
9. The other end of the extension cable will connect to the connector
on the MaxAmp unit marked ‘KEYBD’.
10. A 10 ft. long cable with 25 pin connectors on both ends will connect
the second printer port to the connector on the MaxAmp unit
marked ‘computer’.
11. The special interface cable for your machine will connect the
machine to the connector on the MaxAmp unit marked ‘machine’.
12. 110 or 220 VAC power cord will connect to the connector on the
MaxAmp unit marked ‘power-in’. It is strongly advised that the
MaxAmp unit and perhaps your PC are connected to the AC power
through a surge protection device. Such devices are easily available
at popular computer stores and similar outlets on the internet.
13. The switched AC outlet is available to connect your machine’s AC
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spindle motor. Please, contact us if your machine has a DC
spindle motor.
Remember to invoke the MaxMotion application before
turning on the MaxAmp unit. It is possible that the spindle
motor may turn on when you turn on the power to the
MaxAmp unit and if the MaxMotion software is not on. This
sudden turning on of the spindle motor may startle you.
Make sure and do not block the area around the MaxAmp
module. Blocking the airflow could cause over heating of the
unit and could contribute to the heat related failure inside the
MaxAmp module.
Connect the MaxAmp box to AC outlet that has a ground pin.
Two pin outlet is not recommended.
We have designed the logic so that the stepper motors will be
driven with reduced power anytime they are not executing a
job or the operator is not jogging the table. This will keep the
motors from building up heat. Also, the amplifiers will run
cool. The motors will always be engaged and will keep proper
position of the table.
It is always a good practice to connect all the cables and turn
on the PC computer before turning on the amplifier. The
MaxAmp units are equipped with a power on red light.
Additionally, the cooling fan should always be on when the
power is applied to the unit.
Be sure to read the manual and ask us for our latest
information as well as our “How To...” notes to learn the use
of MaxMotion quickly and easily.
The following MaxAmp boxes have been made available
so far:
New Hermes 810 - 3 proper amplifiers and one relay for
spindle motor for original 810 motors
New Hermes 3000 - 3 proper amplifiers and one relay for
spindle motor for original 3000 motors
New Hermes 1219 and Vanguard II - 3 proper amplifiers
and one relay for spindle motor for original motors
New Hermes 4000, 5000, and 6000 - 3 proper amplifiers
and one relay for spindle motor for original motors
Newing Hall tables with TLC controllers - 2 proper
amplifiers and 3 relays are provided. The amplifiers are
designed for Superior Electric M063-FD06, 2.9 amp motors.
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H-Square 1912 table - 3 proper amplifiers and one relay
for spindle motor for original motors
Meistergram 912, 1912 - 3 proper amplifiers and one relay
for spindle motor for original motors
Meistergram 1518, 2618 - 3 proper amplifiers and one
relay for spindle motor for original motors
Dahlgren System One - 2 proper amplifiers and one relay
are provided.
Dahlgren System Two - 2 proper amplifiers and one relay
are provided.
Dahlgren System 100 - 500Z - 3 proper amplifiers and one
relay are provided.
Dahlgren System 100 - 500 - 2 proper amplifiers and one
relay are provided.
Dahlgren Wizzard, III, XL, Mark 12 - 3 proper amplifiers
and one relay are provided.
Dahlgren Wizzard PC - Only an A/B switch box is required
to make it work.
Xenetech machine with standard interface - 3 proper
amplifiers and one relay are provided.
It is important to note that the electronics is sensitive to static
charge. It is a safe and a good idea to discharge static
electricity, ground the controller and ground yourself before
you touch and work on any electronic components. Static
electricity can ruin electronics.
IT IS ABSOLUTELY ESSENTIAL THAT YOU HAVE A 3
PIN AC OUTLET WITH A TRUE GROUND PIN. THE
FOLLOWING HAS TO BE CONNECTED TO THE
GROUND LINE FOR PROPER OPERATION:
1. THE PC COMPUTER
2. THE MAXAMP UNIT
3. THE MACHINE
4. THE STEP MOTORS IN ADDITION TO THE MACHINE
IF THE STEP MOTORS ARE INSULATED FROM THE
METAL OF THE MACHINE TO REDUCE THE
MECHANICAL NOISE.

OFF

ON
POWER-IN

KEYBD.

CYLIND.

FLAT

Power cable

13

1

CONTROLLED
110/220 VAC
OUTLET

25

14

COMPUTER

PS-2 to AT Keyboard Adaptor
This will be needed only if you have PS-2 type of connector with
your computer keyboard cable. Install this between your computer
keyboard cable and then to Universal keyboard adaptor.

1

19

37

Amp

No. of
Relays

Meistergram
MicroSmart

Champion H-Square 1219
Champion H-Square 2818
Dahlgren Wizzards
Dahlgren System 100-500
Dahlgren System I/II
New Hermes 810
New Hermes Vanguard II/1219
New Hermes 3000/4000
New Hermes 5000/XT/6000
Newing Hall TLC

DC P.S.
For:

Driver Type

No. of
Drivers

Serial NO:

MaxAmp by Solustan, Inc.

MACHINE

Machine
Cable

Your Machine

by Solustan, Inc.

MaxAmp Driver Box

Spindle motor
Cable
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Back Side of the
MaxAmp Driver Box

Universal Keyboard adaptor
Plug this in the back of your computer where normally you
plug in your computer keyboard cable. Then plug the keyboard
cable in the back of this Universal keyboard adaptor.
10ft. PS-2 KeyBoard cable should plug in the remaining 6pin section
of this Universal keyboard adaptor. Other end of this 10ft. PS-2 cable
will plug in the back of the MaxAmp driver box.

Your Computer
Keyboard Cable

PS-2 10ft
KeyBoard
Cable

Parallel Port
Cable

Universal
KB Adaptor

Back Side
of Your
Computer

Cable connections for your MaxAmp Driver box, Your Computer and Your Machine
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E2. Installation instructions for MaxMotion to Dahlgren System
One using A/B switch unit concept.
STEP ONE
A.
Make sure you have at least two printer ports in your Windows
computer.
B.
Make sure that your PC meets the minimum requirements
defined in the System Requirements chapter.
C.
Connect the MaxMotion ID key to your existing parallel port
in your computer. If you have a printer connected to the
parallel port, disconnect the printer cable, connect the ID key,
tighten the screws, and reconnect the printer cable to the other
side of the ID key.
D.
Notice the various flat cables coming out of the A/B switch
box. There are three cables coming out from the back of the A/
B box from positions - A, B, and Input/Output. The longest
cable from the B position connects to the Solustan provided
parallel port that you installed in step A.
E.
Open the Dahlgren System One controller box from the top by
removing a few screws. Note that the controller box is divided
into three areas. One is the power supply with transformer and
big capacitors. The second area is the brain of the controller
with a card cage and a number of printed circuit boards. And
the third area is the driver board that connects to the motors on
the engraving table.
F.
Note that a flat cable connects from the furthest PC board in
the card cage to the driver board. The cable is guided through
the opening on the bottom side of the metal divider between
the card cage and the driver board. Disconnect the interface
cable from both the ends.
G.
Guide the flat cable from the A position of the A/B box to the
PC board in the card cage. Connect the cable in the same place
where you just disconnected the existing interface cable. The
26 pin connector is keyed and can be connected only one way..
H.
Guide the flat cable from the Input/Output position of the A/B
box to the driver board of the controller. Connect the cable in
the same place where you just disconnected the existing
interface cable. The 26 pin connector is keyed and can be
connected only one way.
J.
Make sure that your A/B box is switched into A or Default
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position. At this point, you should be able to operate the
System One in the same way you have always been with
Super Pro software.
Switch the A/B box to B or MaxMotion position and you will
be able to drive the Dahlgren table from MaxMotion in
Windows with all of its features. MaxMotion bypasses all of
the intelligence of the controller and goes directly to the driver
board of the controller.
In future, if the controller fails, you have a choice of not to
repair it and simply order an amplifier box from us for a price
that may be less than repairing the controller.
Now is the time to explore the capabilities of MaxMotion
software. Read the manual carefully to take advantage of the
features galore.

CAUTIONS:
A. There are no limit switches exist on Dahlgren System One series of
machines.
B. You should use our 10 key keypad implementation to jog the tool to
the starting point of a job. Next, you should NOT use the SURFACE
command to set the Z axis. Simply use Z down key to actuate your
selected solenoids. You may have selected either left or right or both
solenoids.

E3. Installation instructions for MaxAmp Driver box to Dahlgren
System II
STEP ONE
A.
Make sure you have at least two printer ports in your Windows
computer.
B.
Make sure that your PC meets the minimum requirements
defined in the System Requirements chapter.
C.
Connect the MaxMotion ID key to your existing parallel port
in your computer. If you have a printer connected to the
parallel port, disconnect the printer cable, connect the ID key,
tighten the screws, and reconnect the printer cable to the other
side of the ID key.
D.
Make sure and connect the MaxAmp unit per installation
instructions in procedure E1.
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The unique interface cable from the MaxAmp unit to the
System II table will have a 25 pin connector at the end of the
cable. This will connect directly to the matching interface
connector in the back of the engraving machine.
You do not need to attach any spindle motor cable to the
spindle motor outlet provided on the MaxAmp(tm) amplifier
box. The spindle motor will be controlled to turn on and off
automatically with the job. The spindle motor interface is
through the main 25 pin connector and as a result, a separate
cable is not necessary.

CAUTIONS
A. The limit switch wiring is connected for X and Y axis and it is to be
used for going home. You can simply utilize the Home key in the
control pad and the spindle will move to the Home position.
B. You should use our 10 key keypad implementation to jog the tool to
the starting point of a job. SURFACE command is not necessary for
this machine because the Z-axis is controlled by a solenoid and it is not
motorized. Load your tools in a normal manner that you are used to.
The software knows the starting and ending positions and it will
automatically come back to starting position upon sending the next job.
C. We have designed the logic so that the stepper motors are running
at a reduced current when they are not executing a job or the operator is
not jogging the table. This will keep the motors running cool and will
not allow build up of heat. Also, the amplifiers will run cool.
D. Be sure to read the manual and ask us for our latest information as
well as our “How To...” notes to learn the use of MaxMotion quickly
and easily.

E4. Installation instructions for MaxMotion to Newing Hall TLC
Machine using the MaxAmp module and eliminating the TLC
controller.
A.
B.
C.

Make sure you have at least two printer ports in your Windows
computer.
Make sure that your PC meets the minimum requirements
defined in the System Requirements chapter.
Connect the MaxMotion ID key to your existing parallel port
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in your computer. If you have a printer connected to the
parallel port, disconnect the printer cable, connect the ID key,
tighten the screws, and reconnect the printer cable to the other
side of the ID key.
Make sure and connect the MaxAmp unit per installation
instructions in procedure E1.
The unique interface cable from the MaxAmp unit to the
Newing Hall table will have a 25 pin connector at the end of
the cable. This will connect directly to the matching interface
connector in the back of the engraving machine.
Connect the 25 pin interface connector into the back of your
engraving table.
Turn the power on to the system in the proper manner. If you
try to turn the screw on the table to move either axis, you
should feel the resistance.
Since you are working with MaxAmp module, do not select
either old or new EC controllers in the selection of the
engraving machine for the output. You should select MaxAmp
Newing as the output device. This tells the software that you
are driving the Newing Hall engraving machine with our
driver module.

CAUTIONS
A. There are no limit switches exist on Newing Hall 100 to 400 series
of machines.
B. You should use our 10 key Controlpad implementation to jog the
tool to the starting point of a job. Next, you should NOT use the
SURFACE command to set the Z axis. Simply use Z down key to
actuate your selected solenoids. You may have selected either left or
right or both solenoids.

E5. Installation instructions for MaxAmp Driver box to Hermes
810
STEP ONE
A.
Make sure you have at least two printer ports in your Windows
computer.
B.
Make sure that your PC meets the minimum requirements
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defined in the System Requirements chapter.
Connect the MaxMotion ID key to your existing parallel port
in your computer. If you have a printer connected to the
parallel port, disconnect the printer cable, connect the ID key,
tighten the screws, and reconnect the printer cable to the other
side of the ID key.
Make sure and connect the MaxAmp unit per installation
instructions in procedure E1.

STEP TWO
A.
Notice four white Molex connectors with X, Y, and Z written
on three of them that are coming out of the amplifier box.
These will go into the NH810 machine. The fourth Molex
connector is smaller and it provides power to the spindle
motor of the machine. The last one is a tiny 4 pin connector.
Only two of the four pins are used. This is the connection for
the limit switch for the Z axis.
B.
Orient yourself such that you are facing the front of the
NH810 machine.
C.
The monitor and the electronics is situated to the left of the
machine but attached to the machine.
D.
Remove the monitor. Remove all the electronics and its power
supply.
E
Note that there are cables coming from the machine side and
they are the only remaining parts once the electronics is
removed. Note the five connectors:
1. Three identical connectors for the X, Y, and Z axis.
2. The same cable that has the Z axis connector also has the
tiny 4 pin connector for the limit switch for the Z axis.
3. Finally, the 3 pin Molex connector for the spindle motor.
F.
Connect the appropriate connectors from the MaxAmp unit to
the connectors on the machine. The only mistake one could
possibly make is to switch X and Y axis. If that is the case, just
switch the connectors.
CAUTIONS
A. The Z-axis limit switch wiring is connected for your 810 table.
B. You should use our 10 key Controlpad implementation to jog the
tool to the starting point of a job. Next, you should use the SURFACE
command to set the Z axis. If you are repeating similar jobs with the
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same plate dimensions and positioning the new plates in the same
place, you need not bring the tool back by jogging. The software knows
the starting and ending positions and it will automatically come back to
starting position upon sending the next job.
C. Be sure to read the manual and ask us for our latest information as
well as our “How To...” notes to learn the use of MaxMotion quickly
and easily.

E6. Installation instructions for MaxAmp Driver box to Hermes
1219/Meistergram 1912
STEP ONE
A.
Make sure you have at least two printer ports in your Windows
computer.
B.
Make sure that your PC meets the minimum requirements
defined in the System Requirements chapter.
C.
Connect the MaxMotion ID key to your existing parallel port
in your computer. If you have a printer connected to the
parallel port, disconnect the printer cable, connect the ID key,
tighten the screws, and reconnect the printer cable to the other
side of the ID key.
D.
Make sure and connect the MaxAmp unit per installation
instructions in procedure E1.
STEP TWO
A.
Notice a 25 pin female connector that is coming out of the
amplifier module for the machine cable You may need to
disconnect the existing interface connector from the 1219
controller.
B.
Attach the spindle motor cable to the spindle motor outlet
provided on the amplifier box. The spindle motor will be
controlled to turn on and off automatically with the job. Do
not turn on the spindle motor if the job requires diamond drag
by either deselecting the spindle motor in the MaxMotion
configuration setup or with the control button on the table.
CAUTIONS
A. The limit switch wiring is connected and it is to be used for going
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home. You can simply utilize the Home key in the control pad and the
spindle will move to the Home position.
B. You should use our 10 key Controlpad implementation to jog the
tool to the starting point of a job. Next, you should use the SURFACE
command to set the Z axis. If you are repeating similar jobs with the
same plate dimensions and positioning the new plates in the same
place, you need not bring the tool back by jogging. The software knows
the starting and ending positions and it will automatically come back to
starting position upon sending
C. Be sure to read the manual and ask us for our latest information as
well as our “How To...” notes to learn the use of MaxMotion quickly
and easily.

E7. Installation instructions for MaxAmp Driver box/Hermes 3000
STEP ONE
A.
Make sure you have at least two printer ports in your Windows
computer.
B.
Make sure that your PC meets the minimum requirements
defined in the System Requirements chapter.
C.
Connect the MaxMotion ID key to your existing parallel port
in your computer. If you have a printer connected to the
parallel port, disconnect the printer cable, connect the ID key,
tighten the screws, and reconnect the printer cable to the other
side of the ID key.
D.
Make sure and connect the MaxAmp unit per installation
instructions in procedure E1.
STEP TWO
A.
Notice three white Molex connectors with X, Y, and Z written
on them that are coming out of the amplifier module. These
will go into the NH3000 machine.
B.
Orient yourself such that you are facing the back of the
NH3000 machine.
C.
Disconnect power supply.
D.
Also, disconnect interface to the existing front end by
disconnecting the 34 pin black connector.
E.
Note that there are two plate covers one on the left and the

MaxMotion for Machines

F.

G.

H.

J.

K.

Appendix E-241

other on the right side of the back of the machine.
The one on the left houses the spindle motor while the one on
the right houses the Y axis motor and the motor cable
assemblies.
Unscrew the four screws of the right plate. Remove the plate.
Notice the step motor at the top and the three cable harnesses
with white Molex connectors for the three motors. There
might be X, Y, and Z written on the Molex connectors for the
three stepping motors.
Disconnect the three sets of Molex connectors. Connect the
three female Molex connectors from MaxAmp amplifier
module to the three male connectors properly for X. Y, and for
Z axis.
Do not pull the connectors apart by pulling on the cables. Grab
the male and the female connectors and pry them loose. You
can route the motor wire assemblies either from the bottom of
the table so that the plate can go back in place as before or
simply from the opening of the plate and not put the plate back
in place.
Attach any standard computer power cord to the spindle motor
cable so that it can be plugged into the spindle motor outlet
provided on the amplifier box. The spindle motor will be
connected to the amplifier module and is controlled to turn on
and off automatically with the job. Do not turn on the spindle
motor if the job requires diamond drag by deselecting the
spindle motor in the MaxMotion configuration setup.

CAUTIONS
A. The limit switch wiring is connected and it is to be used for going
home. You can simply utilize the Home key in the control pad and the
spindle will move to the Home position.
B. You should use our 10 key Controlpad implementation to jog the
tool to the starting point of a job. Next, you should use the SURFACE
command to set the Z axis. If you are repeating similar jobs with the
same plate dimensions and positioning the new plates in the same
place, you need not bring the tool back by jogging. The software knows
the starting and ending positions and it will automatically come back to
starting position upon sending the next job.
C. Be sure to read the manual and ask us for our latest information as
well as our “How To...” notes to learn the use of MaxMotion
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quickly and easily.

E8. Installation instructions for MaxMotion to NewHermes 5000
machine with an A/B switch box
STEP ONE
A.
Install the parallel interface card in the PC/Windows computer.
Make sure it is sitting on the connector properly. The interface
card is prepared with the address number of 278. This means it
will not conflict with any previously installed printer ports in
your computer and as long as you have one or two parallel
ports in your computer, it will automatically take the next
position ( If you only have LPT1, our interface card will
become LPT2. If you have LPT1 and LPT2, it will become
LPT3.)
B.
Connect the proper ends (identified) of the provided cables to
the parallel port and the back of the New Hermes 5000 table.
The cable coming out of position B of the A/B switch will
connect to the Solustan supplied parallel port in your PC/
Windows computer.
C.
Disconnect the cable from your current New Hermes
controller system to the table at the back of the table. Take this
cable coming from the New Hermes controller with a male 25
pin connector and connect it to the position A of the A/B
switch.
D.
The cable coming out from the Input/Output position of the A/
B switch shall be connected to the female 25 pin connector in
the back of the table. (You just disconnected a cable from this
connector in step C.
E.
Attach the ID key to your existing parallel port that you might
be using for your printer. (Do not attach the engraving table
and the ID key to the same parallel port.)
F.
Refer to the software manual and install the software.
CAUTIONS
A. The limit switch wiring is connected. You may want to set up
the software with limit switches not present. Once you get the software
talking to the table, you may want to introduce the limit switches to the
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MaxMotion. However, the limit switches for the Z axis are disconnected for the time being. Raise the Z axis to a proper level before
homing the table.
B. You should use our 10 key Controlpad implementation to jog the
tool to the starting point of a job. Next, you should use the SURFACE
command to set the Z axis

E9. Installation instructions for MaxMotion to Dahlgren Wizzard,
Wizzard II, Wizzard III, Wizzard XL machines using MaxAmp
drive module
STEP ONE
A.
Make sure you have at least two printer ports in your PC/
Windows computer.
B.
Make sure that your PC meets the minimum requirements
defined in the System Requirements chapter.
C.
Connect the MaxMotion ID key to one of the existing parallel
ports in your computer. If you have a printer connected to the
parallel port, disconnect the printer cable at the computer end,
connect the ID key to the parallel port first, tighten the screws
on the ID key, and reconnect the printer cable to the open side
of the ID key.
D.
Make sure and connect the MaxAmp module per installation
instructions in procedure E1.
E.
The unique interface cable from the MaxAmp module to the
Wizzard machine has four connectors. The three identical
connectors are for the three axis X, Y, and Z. The cables are
marked. The fourth connector is for limit switch connection.
F.
There is a separate cable provided for the connection of 110
VAC spindle motor to the switched spindle outlet on the back
of the MaxAmp module.
STEP TWO
A.
Turn the Wizzard machine upside down and remove eight
crews along the edge of the machine. Turn the machine back
and remove the top cover.
B.
Note four screws inside the metal holding pan for the table.
These screws are responsible for holding the table in place.
Remove the screws.
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Carefully, tilt the table sideways in order to see the underneath
of the table. Note the controller electronics with a separate
driver card in later models and one single board design in the
earlier models.
Note that there are four different connectors (so far we have
noticed red color small connectors) coming down from
underneath the table and connecting on to the driver part of the
board.
Three identical connectors are for the X, Y, and the Z axis step
motors. Usually, there are labels on the cables. Disconnect the
connectors from the driver board. Also, note a 8 pin connector
for the limit switches. Disconnect it too.
Note a larger 3 pin connector in the back of the table going
from the spindle motor to the power distribution board in the
back. Disconnect this connector. You should be able to lift and
set aside the table at this point.
You have two choices at this point. Remove all the electronics
that you see in the unit. This includes the small 4 inch monitor,
logic board, driver board if separate, power supply, power
distribution unit, keyboard, etc. If you wish, you can sell it all
as spare parts for others. The other choice is to leave every
thing alone inside the unit.
Note that the cable harness under the table is held in place by
plastic ties. Remove some of the ties to stretch and extend the
cables to the back of the unit and extending outside the unit.
Match and connect the connectors from the table to the
interface cable provided by Solustan.
X axis to X axis, Y axis to Y axis, Z axis to Z axis, limit
switch to limit switch connectors. The male and the female
connectors have locking lips to hold the two parts together.
Make sure and connect them properly.
Connect the matching 3 pin connector to the spindle motor
connector on the table and the other end of the power cable to
the switched outlet in the back of the MaxAmp module.
Here is an important connection to observe: It is important to
connect the metal of the table to the ground wire from the
MaxAmp module. The ground wire is a green wire, part of the
interface cable, with a metal lug. Note a big green wire
attached to the table in the back. The ground wire can be
connected right there.
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If you find that the step motors are attached to the table with a
rubberized gasket between the table and the step motor to
reduce the noise, it is advisable to ground the motors. A green
additional ground cable is provided with the kit. Please, loosen
one of the four screws on each of the motors as well as the
screw holding the ground wire in the back of the table. Take
our green wire with a bunch of metal lugs and connect the two
closest ones to the two motors on the right. Run the wires to
the third motor in the back, another lug to the skin of the table
and bring out the last part of the cable to the outside and in the
back of the table. Connect this ground wire to the ground wire
on the interface cable. This helps you to prevent the build up
of static electricity.
It will be easier to guide the cables through one of the holes in
the back of the shell if all the electronics is removed. If not,
find a way to guide the cables through a convenient gap.
Run the machine before closing the machine back. In case you
find that the Control Pad seems to be moving wrong axis, it is
possible that connectors were switched by mistake.
Note that the setting shows that only the X and the Y axis limit
switches are activated. The Z axis is not present. That is
because there is no limit switch for the Z axis in this machine.
This also means that you should study and learn to set the Z
axis offset and lift properly for smooth functioning..

CAUTIONS
A. The limit switch wiring is connected for X and Y axis and it is to be
used for going home. You can simply utilize the Home key in the
control pad and the spindle will move to the Home position.
B. You should use our 10 key keypad implementation to jog the tool to
the starting point of a job. SURFACE command is not necessary for
this machine because the Z-axis is controlled by a solenoid and it is not
motorized. Load your tools in a normal manner that you are used to.
The software knows the starting and ending positions and it will
automatically come back to starting position upon sending the next job.
C. We have designed the logic so that the stepper motors are running
at a reduced current when they are not executing a job or the operator is
not jogging the table. This will keep the motors running cool and will
not allow build up of heat. Also, the amplifiers will run cool.
D. Be sure to read the manual and ask us for our latest information as
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well as our “How To...” notes to learn the use of MaxMotion quickly
and easily.

E10. Installation instructions for MaxMotion to Dahlgren Wizzard
PC machines using A/B Switch box.
STEP ONE
A.
Make sure you have at least one printer ports in your PC/
Windows computer.
B.
Make sure that your PC meets the minimum requirements
defined in the System Requirements chapter.
C.
Connect the MaxMotion ID key to one of the existing parallel
ports in your computer. If you have a printer connected to the
parallel port, disconnect the printer cable at the computer end,
connect the ID key to the parallel port first, tighten the screws
on the ID key, and reconnect the printer cable to the open side
of the ID key.
D.
Install the High current card in the card slot in the back of
your computer.
E.
Guide the flat cable from the B position of the A/B box to the
high current card in the back of your Computer.
STEP TWO
A.
Turn the Wizzard PC machine upside down and remove eight
screws along the edge of the machine. Turn the machine back
and remove the top cover.
B.
Note four screws inside the metal holding pan for the table.
These screws are responsible for holding the table in place.
Remove the screws.
C.
Disconnect the 15 pin connector from the rear of the PC board
on top of the monitor. Then carefully lift the table and rest it
on its side in the back of the machine. You will connect this
back when you are done with the full installation.
D.
Note a black metal plate when you remove the table. The
metal plate has a number of holes through which you can see a
PC board underneath. Also, note a number of cables connected
to the PC board through the holes.
E.
Additionally, note four rubberized screw holders. The
engraving table actually rests on these holders. Unscrew all
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four holders and remove them.
You will be able to juggle and move the metal plate and the
PC board assembly. Lift the assembly slightly toward the side
of the little monitor. You will find a metal connector to the
side of the PC board with a mating connector attached to it.
These are 44 pin connectors, one female and one male.
You connected the position B of the A/B switch box back in
the Step One procedure. Note that there are two cable
assemblies coming out of position A and position Input/
Output. Take the cable assembly coming out of the Input/
Output position. It has two connectors at the other end. One is
a 44 pin connector and will connect to the cable that was
disconnected in step F.
The second connector of the Input/Output cable assembly will
replace the connector on the PC board below the metal plate,
(Note a small flat cable connecting one of the small
connectors on the PC board to the small connector on the PC
board on top of the monitor.) the other end of which is on the
PC board on top of the monitor.
Now, take a look at the two connectors coming out of the
cable assembly from position A of the A/B Switch box. The 44
pin connector will connect to the side of the PC board under
neath the metal plate. The other small connector will connect
to the mating connector o the PC board on top of the monitor.
Guide all the cable assemblies properly. Disconnect the two 25
pin connectors from positions A and Input/Output on the A/B
Switch box. Guide them out of the Wizzard unit in one of the
following two ways:
1. Locate the cooling fan cover in the back of the wizzard
machine toward the side of the monitor. Remove screws and
guide the cable out through the cavity. Replace the screws.
Connect the cables back to the A/B switch box in its respective
positions.
Attach the A/B switch box to the side of wizzard machine with
the help of velcro.
Assemble the wizzard machine back.
Always remember to turn the wizzard machine off while
switching the A/B switch box position.
Make sure that the wizzard and the PC/Windows computers
are grounded properly.
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CAUTIONS
A. The limit switch wiring is connected for X and Y axis and it is to be
used for going home. You can simply utilize the Home key in the
control pad and the spindle will move to the Home position.
B. Be sure to read the manual and ask us for our latest information as
well as our “How To...” notes to learn the use of MaxMotion quickly
and easily.
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